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Cinema Tools is a powerful database that tracks Final Cut Pro edits for conforming film,
digital intermediate, and 24p video projects.

This preface covers the following:

• About Cinema Tools (p. 7)

• About the Cinema Tools Documentation (p. 8)

• Additional Resources (p. 8)

About Cinema Tools
In today’s post-production environment, it’s common for editors and filmmakers to find
themselves faced with a confounding array of formats, frame rates, and workflows
encompassing a single project. Projects are often shot, edited, and output using completely
different formats at each step.

For editors and filmmakers who specifically want to shoot and finish on film or use a
digital intermediate workflow, Cinema Tools becomes an essential part of the
post-production process when editing with Final Cut Pro. For example, when working
with film you need to be able to track the relationship between the original film frames
and their video counterparts. Cinema Tools includes a sophisticated database feature
that tracks this relationship regardless of the video standard you use, ensuring that the
film can be conformed to match your Final Cut Pro edits.

Cinema Tools also provides the ability to convert captured video clips to
24-frame-per-second (fps) video. For NTSC, this includes a Reverse Telecine feature that
removes the extra frames added during the 3:2 pull-down process commonly used when
transferring film to video or when downconverting 24p video.

Cinema Tools, in combination with Final Cut Pro, provides tools designed to make editing
film digitally, using digital intermediate processes involving Color, and working with 24p
video easier and more cost effective, providing functionality previously found only on
high-end or very specialized editing systems.
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The integration between Cinema Tools and Final Cut Pro makes it possible to perform
the most common Cinema Tools tasks directly from Final Cut Pro—Cinema Tools performs
the tasks automatically in the background.

About the Cinema Tools Documentation
Cinema Tools comes with the Cinema Tools 4 User Manual (this document), which provides
detailed information about the application. This comprehensive document describes the
Cinema Tools interface, commands, and menus and gives step-by-step instructions for
creating Cinema Tools databases and for accomplishing specific tasks. It is written for
users of all levels of experience. This manual documents not only all aspects of using the
Cinema Tools application, but also all related functions within Final Cut Pro.

Note: This manual is not intended to be a complete guide to the art of filmmaking. Much
of the film-specific information presented here is very general in nature and is supplied
to provide a context for the terminology used when describing Cinema Tools functions.

Additional Resources
Along with the documentation that comes with Cinema Tools, there are a variety of other
resources you can use to find out more about Cinema Tools.

Cinema Tools Website
For general information and updates, as well as the latest news on Cinema Tools, go to:

• http://www.apple.com/finalcutstudio/finalcutpro/cinematools.html

Apple Service and Support Websites
For software updates and answers to the most frequently asked questions for all Apple
products, go to the general Apple Support webpage. You’ll also have access to product
specifications, reference documentation, and Apple and third-party product technical
articles.

• http://www.apple.com/support

For software updates, documentation, discussion forums, and answers to the most
frequently asked questions for Cinema Tools, go to:

• http://www.apple.com/support/cinematools

For discussion forums for all Apple products from around the world, where you can search
for an answer, post your question, or answer other users’ questions, go to:

• http://discussions.apple.com
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Cinema Tools combined with Final Cut Pro gives unprecedented power to film, digital
intermediate, and 24p video editors.

This chapter covers the following:

• Editing Film Digitally (p. 9)

• Why 24p Video? (p. 12)

• Working with 24p Sources (p. 13)

• Offline and Online Editing (p. 13)

• Creating the Cinema Tools Database (p. 14)

• Capturing the Source Clips with Final Cut Pro (p. 16)

• Preparing the Clips for Editing (p. 19)

• Creating Cut Lists and Other Lists with Cinema Tools (p. 20)

• How Much Can Be Done from Final Cut Pro? (p. 21)

Editing Film Digitally
Computer technology is changing the film-creation process. Most feature-length films
are now edited digitally, using sophisticated and expensive nonlinear editors designed
for that specific purpose. Until recently, this sort of tool has not been available to
filmmakers on a limited budget.

Cinema Tools provides Final Cut Pro with the functionality of systems costing many times
more at a price that all filmmakers can afford. If you are shooting with 35mm or 16mm
film and want to edit digitally and finish on film, Cinema Tools allows you to edit video
transfers from your film using Final Cut Pro and then generate an accurate cut list that
can be used to finish the film.

Even if you do not intend to conform the original camera negative, as in a digital
intermediate workflow, Cinema Tools provides a variety of tools for capturing and
processing your film’s video. See About the Digital Intermediate Process for more
information.
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How Does Cinema Tools Help You Edit Your Film?
For many, film still provides the optimum medium for capturing images. And, if your goal
is a theatrical release or a showing at a film festival, you may need to provide the final
movie on film. Using Final Cut Pro with Cinema Tools does not change the process of
exposing the film in the camera or projecting the final movie in a theater—it’s the part
in between that takes advantage of the advances in technology.

Editing film has traditionally involved the cutting and splicing together of a film workprint,
a process that is time-consuming and tends to discourage experimenting with alternative
scene versions. Transferring the film to video makes it possible to use a nonlinear editor
(NLE) to edit your project. The flexible nature of an NLE makes it easy to put together
each scene and gives you the ability to try different edits. The final edited video is generally
not used—the edit decisions you make are the real goal. They provide the information
needed to cut and splice (conform) the original camera negative into the final movie.
The challenge is in matching the timecode of the video edits with the key numbers of
the film negative so that a negative cutter can accurately create a film-based version of
the edit.

This is where Cinema Tools comes in. Cinema Tools tracks the relationship between the
original camera negative and the video transfer. Once you have finished editing with
Final Cut Pro, you can use Cinema Tools to generate a cut list based on the edits you
made. Armed with this list, a negative cutter can transform the original camera negative
into the final film.

Cut list

Original camera negative

Convert
film to
video

Conform
original camera

negative

Create
release
print

Shoot film

Edit in Final Cut Pro
with Cinema Tools

If your production process involves workprint screenings and modifications, you can also
use Cinema Tools to create change lists that describe what needs to be done to a workprint
to make it match the new version of the sequence edited in Final Cut Pro. See Basic Film
Workflow Steps for more details about this workflow.

What Cinema Tools Does
Cinema Tools tracks all of the elements that go into the making of the final film. It knows
the relationship between the original camera negative, the transferred videotapes, and
the captured video clips on the editing computer. It works with Final Cut Pro to store
information about how the video clips are being used and generates the cut list required
to transform the original camera negative into the final edited movie.
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Cinema Tools also checks for problems that can arise while using Final Cut Pro, the most
common one being duplicate uses of source material: using a shot (or a portion of it)
more than once. Besides creating duplicate lists, you can use Cinema Tools to generate
other lists, such as one dealing with opticals—the placement of transitions, motion effects
(video at other than normal speed), and titles.

Cinema Tools can also work with the production audio, tracking the relationship between
the audio used by Final Cut Pro and the original production audio sources. It is possible
to use the edited audio from Final Cut Pro when creating an Edit Decision List (EDL) and
process (or finish) the audio at a specialized audio post-production facility.

It’s important to understand that you use Final Cut Pro only to make the edit
decisions—the final edited video output is not typically used, since the video it is edited
from generally is compressed and includes burned-in timecode (window burn) and film
information. It is the edit-based cut list that you can generate with Cinema Tools that is
the goal.

About the Digital Intermediate Process
As movies become more sophisticated and the demand for digitally generated special
effects grows, the digital intermediate process, also known as DI, has become increasingly
important to filmmakers. This process often starts with a high-quality scan of the original
film. This scan results in extremely high-quality video, often in the form of digital picture
exchange (DPX) image sequences whose quality rivals or surpasses that of film. This
high-quality video can then be edited, manipulated, and color corrected digitally. The
big difference between this process and the telecine-based film editing process described
previously is that the DI process does not actually conform the original camera
negative—instead, the final digital output is either printed to film or distributed directly.

The term DI is also used to describe the editing, digital manipulation, and color correction
processes used when the source of the video is a high-resolution camera system that
does not use film at all, such as the RED ONE camera.

The video clips created most often during this process are referred to as 2K video image
sequences. An image sequence is actually a folder containing individual image files for
each video frame. Because of the large size of these video clips, they are not generally
edited directly. Instead, lower-resolution versions of the files are created, usually based
on the Apple ProRes 422 codec, and then edited.

Once the edit is finished, the next step is to use Color to apply any needed color correction.
This color correction is applied to the original 2K media. To accomplish this, an Edit
Decision List (EDL) is exported from Final Cut Pro. This EDL is used to match the edits to
the 2K media, allowing Color to conform and color correct the 2K media.
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Cinema Tools databases can be used in this process to match the EDL to the 2K media,
linking the reel names and timecode of each edit to entries in a database created from
a folder of 2K image sequence clips. Using a Cinema Tools database provides powerful
tools to diagnose and resolve any issues that occur, such as nonmatching reel names.

See Basic Digital Intermediate Workflow Steps and Digital Intermediate Workflow Using
a Telecine for details about this workflow.

EDLOffline
video

Final Cut Pro with
Cinema Tools

Edit
sequence

Scan film
to video

Create
release
print

Shoot film

Color

Conform and
color correct

DPX
image

sequences

DPX

Why 24p Video?
The proliferation of high definition (HD) video standards and the desire for worldwide
broadcast distribution have created a demand for a video standard that can be easily
converted to all other standards. Additionally, a standard that translates well to film,
providing an easy, high-quality method of originating and editing on video and finishing
on film, is needed.

24p video provides all this. It uses the same 24 fps rate as film, making it possible to take
advantage of existing conversion schemes to create NTSC and PAL versions of your project.
It uses progressive scanning to create an output well suited to being projected on large
screens and converted to film.

Additionally, 24p video makes it possible to produce high-quality 24 fps telecine transfers
from film. These are very useful when you intend to broadcast the final product in multiple
standards.
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Working with 24p Sources
With the emergence of 24p HD video recorders, there is a growing need for Final Cut Pro
to support several aspects of editing at 24 fps (in some cases, actually 23.98 fps). To this
end, Final Cut Pro and Cinema Tools provide the following:

• The import and export of 24 fps and 23.98 fps EDLs

• The ability to convert NTSC 29.97 fps EDLs to 23.98 fps or 24 fps EDLs

• A Reverse Telecine feature to undo the 3:2 pull-down used when 24 fps film or video
is converted to NTSC’s 29.97 fps

• The ability to remove 2:3:3:2 or 2:3:2:3 pull-down from NTSC media files so you can edit
at 24 fps or 23.98 fps

• The ability to output 23.98 fps video via FireWire at the NTSC standard of 29.97 fps
video

• The ability to match the edits of videotape audio with the original production audio
tapes and generate an audio EDL that can then be used to recapture and finish the
audio if you intend to recapture it elsewhere for final processing

Several of the features mentioned above are included with Final Cut Pro and do not
require Cinema Tools; however, this manual describes all of these features because they
relate to working with 24p, which is of specific interest to many filmmakers. See Frame
Rate Basics for more information about working with the different frame rates.

Offline and Online Editing
If you are working with a high-resolution 24p format, such as uncompressed HD video,
you may need to make lower-resolution copies of your footage to maximize your
computer’s disk space and processing power. In this case, there are four basic steps to
the editing process:

• Production (generating the master video): Transfer film to or natively shoot on
uncompressed 24p HD video.

• Offline edit: Convert footage to NTSC or PAL video (which is generally lower-resolution
than 24p) and edit it.

• Project interchange: Export a Final Cut Pro project or an EDL containing your final edit
decisions.
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• Online edit: Replace low-resolution footage and create a full-resolution master.

24p master
source

Capture
video

Online edit
(24 fps)

Edit
clips 24 fps

EDL
NTSC or
PAL video

24p video

Convert
to 24 fps

Final Cut Pro with Cinema Tools
(offline edit)

Edited 24p
master

See Editing 24p Video with Final Cut Pro for more information.

Creating the Cinema Tools Database
There are a number of issues to take into account when you create your database.

How the Database Works
The database can contain one record or thousands of records, depending on how you
decide to use Cinema Tools. These records are matched to the edits made in Final Cut Pro
so that the cut list can be created. To be valid in a film workflow, a record must have
values for the camera, daily, or lab roll, as well as the edge code (key numbers or ink
numbers). In addition, the record must either have a clip connected to it or have video
reel and video timecode (In point and duration) values.

When you export the cut list after editing the video in Final Cut Pro, Cinema Tools looks
at each edit and tries to find the appropriate record in its database to determine the
corresponding key numbers or ink numbers (edge code). Cinema Tools first looks for a
record connected to the media file used in the edit. If a record is found, Cinema Tools
then locates the file, adds a note to the cut list, and moves on to the next edit.

If no record is found using an edit’s media file, or the file is not located, Cinema Tools
looks at the video reel number to see if any of its records have the same number (“001”
is not the same as “0001”). If so, it then looks to see if the edit’s In and Out points fall
within the range of one of the records. If this condition is also met, the edit is added to
the cut list, and Cinema Tools moves on to the next edit.

If a record cannot be found that uses an edit’s clip pathname or video reel number with
suitable timecode entries, “<missing>” appears in the cut list and a note is added to the
missing elements list. If a record is found but is incomplete (missing the key number, for
example), “<missing>” is placed in those fields and a note is added to the missing elements
list.

See An Introduction to Film Lists and Change Lists and How Cinema Tools Creates Film
Lists for details about this process and the missing elements list.
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A Detailed or Simple Database?
Cinema Tools is designed to allow you to create a record for an entire camera roll, for
each take, or somewhere in between, depending on how you like to work. Each record
can contain:

• Scene, shot, and take numbers with descriptions

• The film’s camera roll number, edge code, and related video timecode and reel number

• The sound roll and timecode

• A clip poster frame showing a representative frame from the clip

• Basic settings such as film and timecode format

The records can be entered manually or imported from a telecine log. You can modify,
delete, and add records to the database as required, even if it is based on the telecine
log. You can also merge databases. For example, if you are working with dailies, you can
create a new database for each session and merge them all together when the shoot is
complete.

The telecine log from scene-and-take transfers, where only specified film takes are
transferred to video, can provide the basic information for the database. You can add
additional records, comments, and other information as needed.

The telecine log from camera-roll transfers typically provides information for a single
record—the edge code and video timecode used at the start of the transfer. Assuming
continuous film key numbers and video timecode throughout the transfer, that single
record is sufficient for Cinema Tools to generate a cut list for that camera roll.

Importing Telecine Logs
You have a choice of importing the telecine log using Cinema Tools or Final Cut Pro. You
can choose either method according to your workflow.

In both cases, you have the option of assigning a camera letter, which is appended to
the take entries, to the import. This is useful in those cases where multiple cameras were
used for each take. See Assigning Camera Letters for more information.

See Importing Database Information from a Telecine Log or ALE File for more information
about importing telecine logs.

• Importing telecine logs using Cinema Tools: To import a telecine log into Cinema Tools,
you must first have a database open. The database can be an existing one that you
want to add new records to, or it can be a new one with no records.

Once the records have been imported, you can export a batch capture list from
Cinema Tools that you can import into Final Cut Pro to automate the clip capture
process.
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• Importing telecine logs using Final Cut Pro: When you import a telecine log using
Final Cut Pro, you choose whether to import it into an existing Cinema Tools database
or whether a new database should be created.

As records are added to the selected Cinema Tools database, each record also creates
an offline clip in the Final Cut Pro Browser so that clips can be batch captured. The
film-related information from the telecine log is automatically added to each clip. You
can show this information in a variety of ways while editing the clips in Final Cut Pro.
See Displaying Film Information in Final Cut Pro for more information.

Manually Entering Database Records
The most common reason to manually enter a record into the database is that there is
no log available from the film-to-video transfer process. Some film-to-video transfer
methods, such as film chains, do not provide logs.

Each record in a database should represent a media file that has continuous timecode
and key numbers. With scene-and-take transfers, each take requires its own record because
film key numbers are skipped when jumping from take to take during the transfer.

With camera-roll transfers, because the film roll and video recorder run continuously from
start to finish, you require only one record for the entire clip, even if you later break it
into smaller clips (that retain the original timecode) and delete the unused portions. This
is because Cinema Tools can use an edit’s video reel number and edit points to calculate
the appropriate key numbers, as long as the video reel and edit point information is part
of a record.

To manually enter database records, you need to know the key number and video
timecode number for a frame of the clip. This is easiest when the transfer has these values
burned in to the video.

See Creating a Cinema Tools Database for details about creating and managing
Cinema Tools databases.

Capturing the Source Clips with Final Cut Pro
How you capture the source clips with Final Cut Pro depends in large part on the actual
media used for the telecine transfer.

• If you have a telecine log file and the clips are provided using a tape-based system: In this
case, you start by importing the telecine log file into either Cinema Tools or Final Cut Pro.
If you import the telecine log file into Cinema Tools, you then export a batch capture
list for Final Cut Pro. If you import the telecine log file into Final Cut Pro, you can use
the batch capture process to capture the clips.
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Note: Capturing video clips from a tape-based device may require third-party hardware.
When using serial device control, make sure to calibrate its capture offset. See the
Final Cut Pro documentation for more information. Also see Setting Up Your Hardware
to Capture Accurate Timecode for more information about capturing your clips.

• If you do not have a telecine log file and the clips are provided using a tape-based system: In
this case, you use the Final Cut Pro Log and Capture window to manually capture each
clip. Once the clips are captured, you can create a Cinema Tools database based on
them using the Synchronize with Cinema Tools command. In some cases, third-party
hardware is required.

• If the clips are provided using a file-based system, such as on a hard disk or DVD-ROM
disc: In this case, most often you also have a telecine log file. You can import the telecine
log file into Final Cut Pro, copy the files to your computer, and connect them to your
Final Cut Pro project.

• If your clips are coming directly from a digital acquisition source, such as camcorders using
solid-state cards: In this case, you use the Log and Transfer window in Final Cut Pro to
ingest the clips. You then use the Synchronize with Cinema Tools command to create
a Cinema Tools database based on the clips.

Recompressing the Captured Files
Regardless of how you captured your video, you may decide to recompress the files to
make them smaller and easier to work with. For example, taking advantage of the correct
codec may allow you to edit on an older portable computer.

About Compression
Compression, in terms of digital video, is a means of squeezing the content into smaller
files that require less hard disk space and potentially less processor power to display.
The tradeoff is lower-quality images.

It’s important to remember that the edited video that results from Final Cut Pro when
used with Cinema Tools is not typically going to be used in an environment where high
quality would be expected. The most common use of the edited video is to give the
negative cutter a visual guide to go along with the cut list. This means that the quality
of the video only needs to be good enough to make your edit decisions and read the
window burn values. However, because your edit decisions are sometimes based on
subtle visual cues, it’s best not to get too carried away with excess compression.

Important: Do not use long-GOP codecs, such as most MPEG-2, XDCAM, H.264, or HDV
codecs. In addition to being difficult to edit, these files cannot take advantage of the
Reverse Telecine feature.
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Capturing Tactics
There are several approaches to capturing your video and audio. Determining which is
right for you depends on a number of factors, including whether you have device control
of the source tape deck and the transfer type used (camera-roll or scene-and-take).

Device Control
A primary consideration when determining how to capture video and audio is whether
Final Cut Pro supports device control for the deck you use. Device control allows you to
capture precisely the video and audio you want in a way that can be exactly repeated, if
necessary. You can even set up a “batch capture” that automates the process, freeing
you to do other tasks.

Capturing without device control presents several challenges. Clips that are captured
manually do not have precise start and end times. If you intend to match start and end
times from a telecine log, you must trim the clips after capturing them. Additionally,
without device control, a clip’s timecode does not match the timecode on the tape.
Final Cut Pro has a provision for changing a clip’s timecode, but in order for that timecode
to match the source tape, you must have a visual reference (a hole-punched or marked
frame) with a known timecode value.

For more information about device control, see the Final Cut Pro documentation.

Camera-Roll Transfers
Camera-roll transfers require you either to capture the entire tape or to manually capture
a clip for each take. As long as the tape uses continuous video timecode and film key
numbers, Cinema Tools requires only a single database record showing the relationship
between the two.

If Final Cut Pro has device control of your source deck, the best method for capturing the
desired takes is to use the Final Cut Pro Log and Capture window and enter the In and
Out points and reel number for each. You can then use batch capture to finish the process.
It’s not necessary to create a database record for each clip, as long as you do not change
the timecode.

Without device control, you must manually capture either the individual takes you want
or the entire tape. You may need to trim a take that you capture manually, and you will
also have to manually set its timecode to match the source tape. An advantage to
capturing the entire tape is that you only have to set the clip’s timecode once (assuming
that the source tape had continuous timecode). The drawback is the amount of disk space
required, although once the tape is captured, you can use Final Cut Pro to create subclips
of the useful takes and then delete the unused material.

See Capturing Source Clips and Connecting Them to the Database for details about
capturing clips.
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Scene-and-Take Transfers
Scene-and-take transfers generally result in records in the Cinema Tools database that
are suitable for performing a batch capture. You can export a capture list from
Cinema Tools and import it into the Final Cut Pro Browser. Final Cut Pro can then perform
a batch capture (assuming it can control the source device), creating clips as directed by
the Cinema Tools list. These clips can then be easily linked to records in the Cinema Tools
database.

Finishing with High-Quality Video
If you intend to provide a high-quality video output when you have finished the project,
there are several issues you might need to consider.

When capturing video for the initial offline edit, you can capture with relatively high
compression and include burned-in timecode and key numbers. The compression makes
it easier for your computer to work with the video and requires less hard disk space,
allowing you to capture more video to use for making your edit decisions.

After you have finished the offline edit, you can use Final Cut Pro to recapture just the
video actually used in the edits, using a high-quality codec and a version of the video
without burned-in timecode and key numbers.

See Working with 24p Video and 24 fps EDLs for more information about this process.
Also see your Final Cut Pro documentation for more information about offline and online
editing workflows.

Preparing the Clips for Editing
Cinema Tools includes two features you can use to help prepare the captured clips for
editing.

Reverse Telecine
The Reverse Telecine feature (for NTSC transfers only) provides a means of removing the
extra fields added during the 3:2 pull-down process of the telecine transfer. You need to
do this when you intend to edit the video at 23.98 fps. See Frame Rate Basics for
information about what a 3:2 pull-down is and why you might want to reverse it. See
Reversing the Telecine Pull-Down for details about using the Reverse Telecine feature.

Note: The Reverse Telecine feature cannot be used with temporally compressed video
such as MPEG-2-format video.

Conform
The Conform feature is useful both to correct errors in video clips and to change the
frame rate (timebase) of a clip. Cinema Tools lets you select the frame rate you want to
conform a clip to.
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In order to understand the Conform feature, you need to know a bit about the nature of
QuickTime video files. Each video frame within a QuickTime file has a duration setting
that defines the length of time that a particular frame is displayed (normal NTSC- or
PAL-based QuickTime video has the same duration assigned to all frames). For example,
the NTSC video rate has a value of 1/30 of a second (actually 1/29.97 of a second) assigned
to each frame. The PAL video rate is 1/25 of a second.

Occasionally, captured video clips have some frames whose durations are set to slightly
different values. Although the differences are not visible when playing the clip, they can
cause problems when Cinema Tools creates the cut list or when you use the Reverse
Telecine feature. In these cases, you can conform the clip to its current frame rate.

There are also times when you may want to change the frame rate of a clip. If you
transferred 24 fps film to video by speeding it up (either to 29.97 fps for NTSC or to 25 fps
for PAL—in each case ensuring a one-to-one relationship between the film and video
frames), the action during playback will be faster than in the original film, and the audio
will need to have its playback speed adjusted to compensate. You can use the Conform
feature to change the clip’s frame rate to 24 fps, making it play back at the original film
rate and stay in sync with the audio. See Using the Conform Feature for details.

Note: Make sure to use the Conform feature on a clip before editing it in Final Cut Pro.
Also make sure the editing timebase in the Final Cut Pro Sequence Preset Editor is set at
the same rate you are conforming to.

See Determining How to Prepare Source Clips for Editing for more information.

Creating Cut Lists and Other Lists with Cinema Tools
There are a number of other useful lists that can be generated at the same time as a cut
list. One film list file can contain any of the following:

• Missing elements list: A list of any required information that could not be found in the
database

• Duplicate list: A list of duplicate usages of the same source material

• Optical list: A list for the effects printer, describing any transitions and motion effects

• Pull list: A list to aid the lab in pulling the required negative rolls

• Scene list: A list of all the scenes used in your program and the shots used in the opticals

You can also export a change list, useful if your production process involves workprint
screenings and modifications. The change list assumes a workprint has been cut to the
specifications of a cut list (or prior change list) and it specifies further changes to make
to the workprint, based on edits you have made to the sequence in Final Cut Pro. See
When Are Change Lists Used in a Film Workflow? for a flow chart of the workprint and
change list process.
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See An Introduction to Film Lists and Change Lists for more details about all the
film-related lists that are available.

How Much Can Be Done from Final Cut Pro?
Because of the high level of integration between Cinema Tools and Final Cut Pro, you
have several options for each stage in your project’s workflow. For example, should you
import the telecine log into Cinema Tools and export a batch capture list for Final Cut Pro,
or should you import the telecine log directly into Final Cut Pro? Your situation and
preferred working methods will often make this decision for you. Among the
Cinema Tools–related functions you can perform directly from Final Cut Pro are:

• Importing telecine log files

• Conforming 25 fps video to 24 fps

• Reversing the telecine pull-down (using the last settings in Cinema Tools)

• Opening a clip in the Cinema Tools Clip window

• Synchronizing a Cinema Tools database to a group of selected clips

• Exporting film lists and change lists
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Following is a diagram showing an ideal workflow that focuses on using Final Cut Pro
methods.

Steps Performed from
Final Cut Pro

How Cinema Tools
Is Involved

Process clips (if needed)
• Reverse telecine

• Conform (25 @ 24)

Synchronize captured clips
with Cinema Tools database

Edit clips

Import a log into the
Final Cut Pro project,

creating the offline clips
for capture

Batch capture clips

Export lists
Cinema Tools

creates the lists

Cinema Tools
does the processing

A new Cinema Tools
database is created

The clips are connected to
the Cinema Tools database

Create a new
Final Cut Pro project

In this workflow, you can focus on using Final Cut Pro, and Cinema Tools performs tasks
in the background as needed. You must use Cinema Tools manually if you want to add
information to the database beyond what the telecine log provided, or if you have a
unique issue with reverse telecine and need to configure its settings.
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Start planning your project early to ensure its success.

This chapter covers the following:

• An Introduction to Film Projects (p. 23)

• Before You Shoot Your Film (p. 24)

• Which Film to Use? (p. 24)

• Transferring Film to Video (p. 25)

• Frame Rate Basics (p. 28)

• Audio Considerations (p. 34)

• Working in Final Cut Pro (p. 38)

An Introduction to Film Projects
Successful film production requires thorough planning well before exposing the first
frame. Besides the normal preparations, additional issues must be considered when you
intend to edit the film digitally. These issues may affect the film you use, how you record
your sound, and other aspects of your production.

This chapter provides basic information about many of the issues you will face:

• Which film to use

• Choices for transferring the film to video

• Frame rate issues between the film, your video standard, and your editing timebase

• Audio issues such as which recorder and timecode to use and how to synchronize the
audio with the video

• Issues with Final Cut Pro such as selecting a sequence timebase and using effects

Note: Much of this information is very general in nature and is not intended to serve as
a complete guide to filmmaking. The digital filmmaking industry changes rapidly, so what
you read here is not necessarily the final word.
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Before You Shoot Your Film
Before you begin your project, make sure to discuss it with all parties involved in the
process:

• Those providing equipment or supplies used during the production

• Those involved in the actual production

• The facility that will develop your film, create workprints, and create the release print

• The video transfer facility

• The editor using Cinema Tools and Final Cut Pro (if it is not you)

• The negative cutter

• The audio post-production facility

These are people who are experts in their fields. They can provide invaluable information
that can make the difference between a smooth, successful project and one that seems
constantly to run into obstacles.

Be Careful How You Save Money
There are a number of times throughout the film production process when you will get
to choose between “doing it right” and “doing it well enough.” Often your budget or a
lack of time drives the decision. Make sure you thoroughly understand your workflow
choices before making decisions that could end up costing you more, both in time and
money, in the long run. Problems based on choices made early in the process—for
example, deciding not to have a telecine log made—could take you by surprise later.

Having professional facilities handle the tasks they specialize in, especially when you
are new to the process, is highly recommended. You may actually save money by
spending a little for tasks that you could do yourself, such as using an audio
post-production facility.

Also, do not underestimate the importance of using the cut list to conform a workprint
before conforming the negative. Although creating and editing a workprint adds costs
to the project, incorrectly conforming the original camera negative will cause irreparable
harm to your film.

Which Film to Use?
One of the first steps in any film production is choosing the film format to use.
Cinema Tools requirements must be taken into account when making this choice.

Cinema Tools supports 4-perf 35mm, 3-perf 35mm, and 16mm-20 film formats. See Film
Basics for details about these formats.
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Your budget will likely determine which format you use. Although it’s generally best to
use the same film format throughout your production, Cinema Tools does not require it.
Each database record has its own film format setting.

Transferring Film to Video
In order to digitally edit your film, you need to transfer it to video so that it can be captured
by the computer. There are a few ways to do this, but an overriding requirement is that
there be a reliable way to match the film’s key numbers to the edited video’s timecode.
This relationship allows Cinema Tools to accurately calculate specific key numbers based
on each edit’s In and Out point timecode values.

You also need to make decisions regarding film and video frame rates used during the
transfer. These affect the editing timebase and impact the accuracy of the cut list that
Cinema Tools generates.

Telecines
By far the most common method of transferring film to video is to use a telecine. Telecines
are devices that scan each film frame onto a charge-coupled device (CCD) to convert the
film frames to video frames. Although a telecine provides an excellent picture, for the
purposes of Cinema Tools the more important benefit is that it results in a locked
relationship between the film and video, with no drifting between them.

Telecines are typically gentler on the film and offer sophisticated color correction and
operational control as compared to film chains, described in Transfer Techniques That
Are Not Recommended. Another advantage is that telecines can create video from the
original camera negative—most other methods require you to create a film positive
(workprint) first. (Although from a budget viewpoint it may be a benefit not to create a
workprint, workprints are generally created anyway since they provide the best way to
see the footage on a large screen and spot any issues that might impact which takes you
use. Even more importantly, they allow you to test the cut list before working on the
negative.)

In addition to providing a high-quality transfer, most modern telecines read the key
numbers from the film and can access the video recorder’s timecode generator, burning
in these numbers on the video output. An additional benefit of the telecine transfer
method is its ability to provide synchronized audio along with the video output. It can
control the audio source and burn in the audio timecode along with the video timecode
and the key numbers.
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But What If You Want a Clean Master?
If you plan to conform the original camera negative, the presence of burned-in timecode
and key numbers on the video clips you edit in Final Cut Pro may not be a problem,
especially if you are working with a highly compressed video format.

The burned-in numbers can be a problem, however, if you intend to use the edited
video for screenings or for broadcast. As valuable as they are to the editor, the burned-in
numbers can be distracting when watching an edited project. There are two common
methods you can use to minimize this problem:

• Letterbox the video during capture using a 2:35 aspect ratio so that there is enough
room below the video to show the numbers.

• Flash the burn-in information on the first frame only. Although not quite as useful as
a continuous burn-in, this does provide the editor with the ability to ensure that the
relationship of the edge code to the timecode is correct.

In most cases, telecines produce a log file that can provide the basis for the Cinema Tools
database. This allows you to automate capturing the video into the computer.

Increasingly, telecine facilities can also capture the video clips for you, providing the clips
on a DVD disc or FireWire drive, along with the telecine log and videotapes.

Transfer Techniques That Are Not Recommended
There are a couple of transfer techniques that are worth mentioning just to point out
why you should not use them.

Film Chains
You should avoid using a film chain if at all possible. Film chains are relatively old
technology, as compared to telecines. A film chain is basically a film projector linked to
a video camera. Film chains typically do not support features such as reading the key
numbers or controlling video recorders, and they cannot create a positive video from a
film negative. You must create a workprint to use a film chain.

Using a film chain is usually less expensive than using a telecine, although the cost of
creating a workprint partly offsets the lower cost. The biggest challenge is being able to
define the relationship between the film’s key numbers and the video timecode. This is
usually accomplished with hole punches (or some other distinct frame marker) at known
film frames.

Important: Older film chains may not synchronize the film projector to the video recorder,
potentially causing the film-to-video relationship to drift.
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Recording a Projected Image with a Camcorder
Because of the greatly increased chances for error and the additional time you have to
spend tracking key numbers, this method of transfer is strongly discouraged and should
not be considered.

Projecting your film and recording the results using a video camcorder is a method that,
although relatively inexpensive, almost guarantees errors in the final negative cutting.
Telecines and film chains are usually able to synchronize the film and video devices,
ensuring a consistent transfer at whatever frame rates you choose. The projector’s and
video camcorder’s frame rates may be close to ideal but will drift apart throughout the
transfer, making it impossible to ensure a reliable relationship between the film’s key
numbers and the video timecode. You will have to spend extra time going over the cut
list to ensure the proper film frames are being used. Additionally, there may be substantial
flicker in the video output, making it difficult to see some frames and determine which
to edit on.

Because the video is not actually used for anything except determining edit points, its
quality doesn’t matter too much. As with film chains, you have to create a workprint to
project. Being able to proof your cut list before the original camera negative is worked
on is very important with this type of transfer.

How Much Should You Transfer?
Deciding how much of your film to transfer to video depends on a number of issues, the
biggest one probably being cost. The amount of time the telecine operator spends on
the transfer determines the cost. Whether it is more efficient to transfer entire rolls of film
(a “camera-roll” transfer), including bad takes and scenes that won’t be used, or to spend
time locating specific takes and transferring only the useful ones (a “scene-and-take”
transfer) needs to be determined before starting.

Camera-Roll Transfers
Cinema Tools uses a database to track the relationship between the film key numbers
and the video and audio timecode numbers. The database is designed to have a record
for each camera take, but this is not required. If you transfer an entire roll of film
continuously to videotape, Cinema Tools needs only one record to establish the
relationship between the key numbers and the video timecode. All edits using any portion
of that single large clip can be accurately matched to the original camera negative’s key
numbers. A drawback to this transfer method is the large file sizes, especially if significant
chunks of footage will not be used.
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Additionally, because of the way it is recorded, audio is difficult to synchronize at the
telecine during a camera-roll transfer. During a production, the sound recorder typically
starts recording before film starts rolling and ends after filming has stopped. You also will
often shoot some film without sound (known as MOS shots). This means you cannot
establish audio sync at the start of the film roll and expect it to be maintained throughout
the roll. Instead, each clip needs to be synced individually. The Cinema Tools database
includes provisions for tracking the original production sound rolls and audio timecode.

Once captured, a single large clip can be broken into smaller ones, allowing you to delete
the excess video. Even with multiple clips, it is possible for Cinema Tools to generate a
complete cut list with only one database record. Another approach is to manually add
additional records for each clip, allowing you to take advantage of the extensive database
capabilities of Cinema Tools. See Creating the Cinema Tools Database for a detailed
discussion of these choices.

Scene-and-Take Transfers
Scene-and-take transfers are a bit more expensive than camera-roll transfers, but they
offer significant advantages:

• Scene-and-take transfers make it easier to synchronize audio during the transfer.

• Because the telecine log contains one record per take, it establishes a solid database
when imported into Cinema Tools.

• With an established database, Cinema Tools can export a batch capture list. With this
list (and appropriate device control), Final Cut Pro can capture and digitize the
appropriate takes with minimum effort on your part.

Maintaining an accurate film log and using a timecode slate can help speed the transfer
process and reduce costs.

Frame Rate Basics
When transferring film to video, you need to take into account the differences in film and
video frame rates. Film is commonly shot at 24 frames per second (fps), although 25 fps
is sometimes used when the final project is to be delivered as PAL video (as opposed to
the more common technique of just speeding up 24 fps film to 25 fps). Video can have
a 29.97 fps rate (NTSC), a 25 fps rate (PAL), or either a 24 fps or 23.98 fps rate (24p),
depending on your video standard.

The frame rate of your video (whether you sync the audio during the telecine transfer or
not) and the frame rate you want to edit at can determine what you need to do to prepare
your clips for editing. You may find it useful to read Determining How to Prepare Source
Clips for Editing before you make any decisions about frame rates.
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Working with NTSC Video
The original frame rate of NTSC video was exactly 30 fps. When color was added, the rate
had to be changed slightly, to the rate of 29.97 fps. The field rate of NTSC video is 59.94
fields per second. NTSC video is often referred to as having a frame rate of 30 fps, and
although the difference is not large, it cannot be ignored when transferring film to video
(because of its impact on audio synchronization, explained in Synchronizing the Audio
with the Video).

Another issue is how to distribute film’s 24 fps among NTSC video’s 29.97 fps.

The most common approach to distributing film’s 24 fps among NTSC video’s 29.97 fps
is to perform a 3:2 pull-down (also known as a 2:3:2:3 pull-down). If you alternate recording
two fields of one film frame and then three fields of the next, the 24 frames in 1 second
of film end up filling the 30 frames in 1 second of video.

Note: The actual NTSC video frame rate is 29.97 fps. The film frame rate is modified to
23.98 fps in order to create the 3:2 pattern.

Before (23.98 fps)

A BA B B CC D D D

A B C D A D A B C D A B C D A B C D A B C DB C

A A B B B C C D D D A A B B B C C D D D A A B B C C D D D A A B BB CC D D D A BA B B CC D DB D

A B C D

A A B B B C C D D D
Field

1
Field

2
Field

1
Field

2
Field

1
Field

2
Field

1
Field

2
Field

1
Field

2

3:2 Pull-Down

After (29.97 fps)

One second

As shown above, the 3:2 pattern (actually a 2:3:2:3 pattern because frame A is recorded
to two fields followed by frame B recorded to three fields) repeats after four film frames.
Virtually all high-end commercials, movies, and non-live television shows use this process
prior to being broadcast.
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Note that there is not a one-to-one correspondence between film frames and video
frames after this pull-down occurs. The duration of a video frame is four-fifths the duration
of a film frame. Because of this discrepancy, if you tried to match a specific number of
whole video frames to some number of whole film frames, the durations would seldom
match perfectly. In order to maintain overall synchronization, there is usually some fraction
of a film frame that must be either added to or subtracted from the duration of the next
edit. This means that in the cut list, Cinema Tools occasionally has to add or subtract a
film frame from the end of a cut in order to maintain synchronization. For this reason, if
you edit 3:2 pull-down video, the Cinema Tools cut list is only accurate to within +/–
1 frame on each edit.

This accuracy issue is easily resolved by using the Reverse Telecine feature (or third-party
hardware or software) to remove the extra fields and restore the film’s original 24 fps rate
before you begin editing digitally, providing a one-to-one relationship between the video
and film frames. Setting the Final Cut Pro editing timebase in the Sequence Preset Editor
to 24 fps (or 23.98 fps—see Synchronizing the Audio with the Video) allows you to edit
the video and generate a very accurate cut list. See Determining How to Prepare Source
Clips for Editing for more information about issues related to these options.

What’s an A Frame?
You will see and hear references to “A” frames whenever you are involved with 3:2
pull-down video. As the previous illustration shows, the A frame is the only one that
has all its fields contained within one video frame. The others (B, C, and D frames) all
appear in two video frames. Because the A frame is the start of the video five-frame
pattern, it is highly desirable to have one as the first frame in all video clips. It’s common
practice to have A frames at non-drop frame timecode numbers ending in “5” and “0.”

See About A Frames for more information.

Working with PAL Video
The PAL video frame rate is exactly 25 fps. There are two methods used when transferring
film to PAL: running the film at 25 fps (referred to as the 24 @ 25 method), and adding
two extra fields per second (similar to NTSC’s 3:2 pull-down, referred to as the 24 & 1
method, or the 24 @ 25 pull-down method).
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24 @ 25 Method
Running the film at 25 fps sets up a one-to-one relationship between the film and video
frames. The drawback is that the action in the film is sped up by 4 percent, and the audio
will need an identical speed increase to maintain synchronization. To take advantage of
the wide variety of 25 fps video equipment available, you can choose to edit with the
action 4 percent faster. Another option is to use the Cinema Tools Conform feature to
change the clip’s timebase to 24 fps, correcting the speed. The video can then be edited
with Final Cut Pro as long as the sequences using it have a 24 fps timebase.
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Note: Final Cut Pro includes an Easy Setup and sequence preset with “24 @ 25” in their
names, as well as a timecode format named “24 @ 25.” These are all intended to be used
with clips that originated as PAL 25 fps video but have been conformed to 24 fps video.
See Working with 25 fps Video Conformed to 24 fps for more information.

24 & 1 Method
Adding two extra video fields per second (also known as the 24 @ 25 pull-down method
in Final Cut Pro) has the advantage of maintaining the original film speed, at the expense
of losing the one-to-one film-to-video frame relationship. This method records an extra
video field every twelfth film frame.
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Working with 24p Video
With its frame rate and progressive scanning, 24p video is well suited for use with telecine
transfers. It uses the same frame rate as film, providing a one-to-one relationship between
the film and video frames without requiring a frame rate conversion.

31Chapter 2 Before You Begin Your Film Project



Your Final Cut Pro system needs to be equipped with specialized hardware to capture
24p video, either as compressed or uncompressed clips. Alternatively, some DV cameras,
such as the Panasonic AG-DVX100 camcorder, can shoot 24p video and use the 2:3:3:2
pull-down method to record it to tape at 29.97 fps (the NTSC standard). Using Final Cut Pro
and Cinema Tools, you can capture this video and remove the 2:3:3:2 pull-down so that
you can edit it at 24 fps. See Adding and Removing Pull-Down in 24p Clips for more
information.

Note: When used as part of an NTSC system, the 24p videotape recorder’s (VTR’s) frame
rate is actually 23.976 fps (referred to as 23.98 fps) to be compatible with the NTSC 29.97 fps
rate.

Timecode Considerations
There are several general issues related to timecode that you should be aware of. If you’re
using NTSC video, you can also choose between two timecode formats.

General Timecode Tips
When using video or audio equipment that allows you to define the timecode setting, it
is recommended that you set the “hours” part of the timecode to match the tape’s reel
number. This makes it much easier to recognize which reel a clip originated from. It is
also best to avoid “crossing midnight” on a tape. This happens when the timecode turns
over from 23:59:59:29 to 00:00:00:00 while the tape is playing.

You have the option to use record run or free run timecode during the production:

• Record run timecode: The timecode generator pauses each time you stop recording.
Your tape ends up with continuous timecode, because each time you start recording
it picks up from where it left off.

• Free run timecode: The timecode generator runs continuously. Your tape ends up with
a timecode break each time you start recording.

To avoid potential issues while capturing clips, it is strongly suggested that you use the
record run method, which avoids noncontinuous timecode within a tape.

Whenever a tape has noncontinuous timecode (with jumps in the numbers between
takes), make sure to allow enough time (handles) for the pre-roll and post-roll required
during the capture process when logging your clips. See the Final Cut Pro documentation
for additional information about timecode usage.

About NTSC Timecode
Normal NTSC timecode (referred to as non-drop frame timecode) works as you would
expect—each frame uses the next available number. There are 30 frames per second,
60 seconds per minute, and 60 minutes per hour. Because NTSC’s actual frame rate of
29.97 fps is a little less than 30 fps, non-drop frame timecode ends up being slow (by
3 seconds and 18 frames per hour) when compared to actual elapsed time.
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To compensate for this, drop frame timecode skips ahead by two frames each minute,
except those minutes ending in “0.” (Note that it is only the numbers that are skipped—not
the actual video frames.) This correction makes the timecode accurate with respect to
real time but adds confusion to the process of digital film editing.

With non-drop frame timecode, once you find an A frame, you know that the frame at
that frame number and the one five away from it will always be A frames. For example,
if you find an A frame at 1:23:14:15, you know that all frames ending in “5” and “0” will
be A frames. With drop frame timecode, you are not able to easily establish this sort of
relationship.

Note: It is standard practice to have A frames at non-drop frame timecode numbers
ending in “5” and “0.”

It is highly recommended that you use non-drop frame timecode for both the video and
audio in all film editing projects, even though both Cinema Tools and Final Cut Pro are
able to use either type. Whichever you use, make sure to use the same for both the video
and audio tapes.

Note: PAL timecode does not have this issue—it runs at a true 25 fps.

What Happens to the Timecode After Using Reverse Telecine?
The Reverse Telecine feature (used to change 29.97 fps video to 23.98 fps video) directly
affects the timecode of the video frames. Because Cinema Tools must generate new
23.98 fps timecode for the frames (based on the original timecode), you may see a
difference between the burned-in timecode numbers and the numbers shown in
Final Cut Pro. Though the timecode discrepancies between the window burn and
Final Cut Pro timecode may be confusing, Cinema Tools tracks the new timecode of the
23.98 fps video and is able to match it back to its original NTSC or PAL values, and thus
back to the film’s key numbers.

Note: The Reverse Telecine feature is most often used to convert the NTSC video to
23.98 fps to match the audio timecode, but it can also convert the video to 24 fps.

This is what happens to the timecode: reverse telecine removes six frames per second,
so the timecode numbers continue to match at the beginning of each second. This means
that a clip that lasts for 38 seconds when played at its NTSC rate of 29.97 fps will still last
for 38 seconds when played at the reverse-telecined rate of 23.98 fps.

NTSC video frames (29.97 fps)

One second

Clip start

Reverse-telecined video frames (23.98 fps)

1:00 1:01 1:02 1:03 1:04 1:05 1:06 1:07 1:08 1:09 1:10 1:11 1:12 1:13 1:14 1:15 1:16 1:17 1:18 1:19 1:20 1:21 1:22 1:23 2:00

1:00 1:011:021:031:041:051:061:071:081:091:10 1:11 1:12 1:13 1:14 1:15 1:16 1:17 1:18 1:191:201:211:221:231:241:251:261:271:281:29 2:00

Discarded fields

33Chapter 2 Before You Begin Your Film Project



In the above illustration, the blue NTSC fields represent fields that are removed during
the reverse telecine process on a clip using traditional 3:2 pull-down. (See Adding and
Removing Pull-Down in 24p Clips for information about 2:3:3:2 pull-down.) The window
burn NTSC timecode will be different from what Final Cut Pro shows for all frames except
the first one of each second, regardless of the clip’s length.

What Happens to the Timecode After Using Conform?
There are three common situations you would use the Conform feature for:

• Converting PAL 25 fps video to 24 fps: The timecode is not changed, which ensures that
an EDL exported after the clips are edited will accurately refer to the original PAL
timecode. The drawback is that the timecode, at 25 fps, no longer accurately represents
the true passage of time when played at 24 fps because each frame is displayed for a
slightly longer time. See Working with 25 fps Video Conformed to 24 fps for more
information.

• Conforming 29.97 fps video to 29.97 fps: The timecode is not changed. This process is
used to correct issues in a QuickTime file prior to using the Reverse Telecine feature.
See Solutions to Common Problems for more information.

• Converting NTSC 29.97 fps video to 23.98 fps: The timecode is altered, with a number
skipped every five frames. This conform situation is rarely used.

See Using the Conform Feature for more information.

Audio Considerations
Because the audio for a film is recorded separately on a sound recorder, there are a
number of issues that you must be aware of and plan for:

• What type of sound recorder to use: For more information, see Choosing a Sound
Recorder.

• What timecode format to use: For more information, see Choosing an Audio Timecode
Format.

• How to mix the final audio: For more information, see Mixing the Final Audio.

• How to synchronize the audio with the video: For more information, see Synchronizing
the Audio with the Video.

Choosing a Sound Recorder
When choosing a sound recorder, you have several options: an analog tape recorder
(typically a Nagra), a Digital Audio Tape (DAT) recorder, or a digital disc recorder. Whether
analog or digital, make sure the recorder has timecode capability.
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Choosing an Audio Timecode Format
Unlike video or film, which must be structured with a specific frame rate, audio is linear
with no physical frame boundaries. Adding timecode to audio is simply a way to identify
points in time, making it easier to match the audio to video or film frames.

During the shoot, you have the choice of which audio timecode standard to use (typically
30 fps, 29.97 fps, 25 fps, 24 fps, or 23.98 fps). You also have the choice, with 30 fps and
29.97 fps, of using drop frame or non-drop frame timecode. For NTSC transfers, it is highly
recommended that you use non-drop frame timecode for both the video and audio
(although Cinema Tools can work with either). See About NTSC Timecode for more
information about drop frame and non-drop frame timecode.

A consideration for the audio timecode setting is how the final audio will be mixed:

• If the final mix is to be completed using Final Cut Pro: The setting needs to match the
Final Cut Pro Editing Timebase setting in the Sequence Preset Editor.

• If the final mix is to be completed at an audio post-production facility: The timecode needs
to be compatible with the facility’s equipment.

Note: Make sure to consult with the facility and make this determination before the shoot
begins.

In general, if you are syncing the audio during the telecine transfer, the timecode should
match the video standard (29.97 fps for NTSC, 25 fps for PAL, or 24 fps for 24p). Check
with your sound editor before you shoot to make sure the editor is comfortable with your
choice.

Mixing the Final Audio
The way you mix the final audio depends on how complicated the soundtrack is (multiple
tracks, sound effects, and overdubbing all add to its complexity) and your budget. You
can either finish the audio with Final Cut Pro or have it finished at a post-production
facility.

Finishing the Audio with Final Cut Pro
If you capture high-quality audio clips, you can finish the audio for your project with
Final Cut Pro, which includes sophisticated audio editing tools. Keep in mind, however,
that good audio is crucial to a good film, and a decision not to put your audio in the
hands of an audio post-production facility familiar with the issues of creating audio for
film might lead to disappointing results.
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You can export the audio from Final Cut Pro as an Open Media Framework (OMF) file for
use at an audio post-production facility. An exported OMF file contains not only the
information about audio In and Out points, but also the audio itself. This means that, for
example, any sound effects clips you may have added are included. When you use an
OMF file, the recording quality must be as high as possible, as this is what the audience
will hear. Make sure to use a good capture device and observe proper recording levels.

Exporting Audio EDLs
Another approach is to use lower-quality clips in Final Cut Pro and then export an audio
Edit Decision List (EDL) for use at an audio post-production facility. There they can capture
high-quality versions of the audio clips straight from the original production audio source
and edit them based on the audio EDL. For this to work, the timecode and roll numbers
of the original sound rolls must be kept track of and used to create the audio EDL.

Audio clips captured as part of video clips do not retain their original timecode and roll
numbers, and the Final Cut Pro EDL cannot be used by an audio post-production facility.
This is most common with clips created from scene-and-take transfers, where the audio
is synchronized to the film and recorded onto the videotape, losing the original audio
timecode. But because the telecine log from the transfer generally contains timecode
and reel number information for both the video and audio, importing this log into the
Cinema Tools database allows the database to track audio usage, and you can export an
audio EDL from Cinema Tools once you finish editing.

See Exporting an Audio EDL for details about the process.

Synchronizing the Audio with the Video
The production audio for a film is recorded separately on a sound recorder; this is known
as dual (or double) system recording. Synchronizing the audio with the film and video,
ensuring good lip-sync, is a critical step in making a movie. How you synchronize depends
on the equipment used and when syncing is done. There are also considerations related
to your video standard, how the telecine transfer was done, and the timecode used that
directly impact the process.

There are three times when audio synchronization is important:

• During the telecine transfer

• During editing

• While creating the release print

Different strategies may be required to maintain sync at each of these times. Make sure
you have planned accordingly.

36 Chapter 2 Before You Begin Your Film Project



Synchronization Basics
Synchronizing the audio with the video image can be fairly easy as long as some care
was taken during the shoot. There are two aspects to synchronizing your audio:
establishing sync at a particular point in each clip, and playing the audio at the correct
speed so that it stays in sync.

While shooting, you must provide visible and audible cues to sync on. The most common
method is to use a clapper board (also called a slate or sticks) at the beginning of each
take. Even better, you can use a timecode slate that displays the sound recorder’s timecode.
To sync the audio with the video, position the video at the first frame where the slate is
closed, then locate the sound (or timecode) of the related audio. Note that production
requirements occasionally require the slate to occur at the end of the take, generally with
the slate held upside down.

Because the film is often either slightly sped up or slowed down during the telecine
transfer, the audio must also have its speed changed. If the audio is being synced during
the transfer, the speed change is handled there. If the audio is being synced to the
videotape after the transfer, the speed change must happen then.

Synchronizing During the Telecine Transfer
During the shoot, you typically start the sound recorder a little before the camera rolls
and stop it a little after the camera stops. Because you end up recording more audio than
film, you cannot play the audio tape and the film through several takes and have them
stay in sync. If you want the telecine transfer to record synchronized audio on the
videotape, you must either use the scene-and-take transfer method, synchronizing each
take on its own, or create a synced sound roll before performing a camera-roll transfer.

A large benefit to synchronizing during the telecine transfer, aside from having videotapes
with synchronized audio ready to be captured, is that the telecine log usually includes
the audio timecode and sound roll number information. Importing the log into
Cinema Tools makes it possible to export an audio EDL so that an audio post-production
facility can recapture the audio clips at a higher quality later, if needed.

• NTSC transfers: When transferring film to NTSC video, it is always necessary to run the
film 0.1 percent slower than 24 fps (23.976 fps, typically referred to as 23.98 fps) to
compensate for NTSC video’s actual frame rate of 29.97 fps (instead of an ideal 30 fps).
Because the film has been slowed down, audio too must be slowed to maintain sync.

• PAL transfers: PAL transfers using the 24 @ 25 method (speeding up the film to 25 fps)
require that the audio also be sped up if you are syncing the audio during the telecine
transfer or if you intend to edit the video at this rate.

If you are transferring the film to video using the 24 & 1 method (recording an extra
video field every twelfth film frame), you should run the audio at its normal speed
regardless of where sync is established. Use 25 fps timecode for the audio in this case.
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Synchronizing in Final Cut Pro
If you don’t synchronize your sound and picture onto tape via the telecine transfer, they
are captured into Final Cut Pro as separate audio and video clips. You can then synchronize
them in Final Cut Pro, using the clapper board shots. See Synchronization Basics for more
information. After you synchronize two or more clips, you can link them together as one
clip, using the Final Cut Pro merged clips feature. See Synchronizing Separately Captured
Audio and Video and the Final Cut Pro documentation for more information.

Working in Final Cut Pro
Decisions you make regarding the telecine transfer and how you work with audio affect
how you use Final Cut Pro during the editing process.

Setting the Editing Timebase for Sequences
In Final Cut Pro, you must set the editing timebase for sequences to match the frame rate
of the captured clips.

Important: Do not place clips into a sequence if the clips and sequence have different
frame rates. If you do, the resulting film list is likely to be inaccurate. For example, if you
want to edit at 24 fps, make sure your clips’ frame rates are all set at 24 fps (either by
using the Reverse Telecine feature or the Conform feature).

See About Easy Setups and Setting the Editing Timebase and the Final Cut Pro
documentation for details about setting the editing timebase for sequences.

Outputting to Videotape When Editing at 24 fps
One of the benefits of editing at 24 fps is that you get a one-to-one relationship between
the film and video frames, allowing for very accurate cut lists. A drawback is that you
need a 24p VTR to directly record video as 24 fps—you cannot easily record the video
on standard NTSC or PAL video equipment. This can be a problem if you want to record
a videotape of the edited project, either to show others or to give the negative cutter a
visual reference to use along with the cut list, but there are solutions:

• If you’re working with NTSC video: You can use the pull-down insertion feature in
Final Cut Pro to apply a pull-down pattern to the video, thus outputting it at 29.97 fps.
See Pull-Down Patterns You Can Apply to 23.98 fps Video for details. There are also
third-party cards and applications that can perform a 3:2 pull-down on the video,
allowing it to run at the NTSC 29.97 fps rate.

• If you’re working with PAL video: If you know that you will want to record a videotape
when finished, it’s easiest to edit at 25 fps (with the film having been sped up to maintain
the one-to-one relationship).
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Using Effects
Final Cut Pro provides extensive effects capabilities, including common film effects such
as dissolves, wipes, speed changes, and text credits. Keep in mind that the video output
of Final Cut Pro is not intended to be transferred to film, and these effects must be created
by a facility specializing in opticals, or created digitally using high-resolution scans of
footage to be composited. See Using Effects, Filters, and Transitions for more information,
including an outline of the basic workflow for including effects and transitions in your
digitally edited film.
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The primary purpose of Cinema Tools is to export film lists based on edits made in
Final Cut Pro. You can also use Cinema Tools in workflows involving Color, DPX image
sequences, and REDCODE media files. There are a few critical steps that are necessary for
these workflows, but for the most part, the Cinema Tools workflow you should follow
depends on the equipment you use, your video standard, and how you like to work.

This chapter covers the following:

• Basic Film Workflow Steps (p. 41)

• Film Workflow Examples (p. 42)

• Basic Digital Intermediate Workflow Steps (p. 46)

• Digital Intermediate Workflow Using a Telecine (p. 49)

• Working with REDCODE Media (p. 51)

Basic Film Workflow Steps
This section details a Cinema Tools database workflow for working with film. See Film
Workflow Examples for possible scenarios. See How Much Can Be Done from Final Cut Pro?
for information about which steps can be done directly in Final Cut Pro.

The typical Cinema Tools film workflow is outlined below.

Stage 1: Creating the Cinema Tools Database
The heart of Cinema Tools is its database, where the relationships between the elements
of your movie (the film, video, and audio) are established and tracked. Although there is
no actual requirement that the database be created prior to editing, it can provide some
useful tools to help with capturing clips and planning the edit.

See Creating the Cinema Tools Database for more information.

Stage 2: Capturing the Source Clips with Final Cut Pro
You must capture the video and audio on your editing computer. How you do this depends
in large part on the actual media used for the telecine transfer.

See Capturing the Source Clips with Final Cut Pro for more information.
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Stage 3: Connecting the Clips to the Database
Once you have captured the source clips, you can connect them to the Cinema Tools
database (also known as linking the clips to the database). Connecting a clip to the
database gives Cinema Tools the ability to access a record’s clip while creating the cut
list, reducing the chance of timecode entry problems.

When creating a cut list, Cinema Tools starts by looking at the clip pathname used in the
edit and matching it back to the database. Being able to work with the clip file in this
way reduces the chances of a timecode error, which can cause inaccurate records in the
cut list. This is especially important when editing at 24 fps. See How Cinema Tools Creates
Film Lists and Connecting Source Clips to the Database for more information.

Stage 4: Preparing the Clips for Editing
Cinema Tools has two powerful features that can be used on your clips prior to editing
them: the Reverse Telecine feature and the Conform feature.

See Preparing the Clips for Editing for more information.

Stage 5: Editing the Clips in Final Cut Pro
You edit the clips in Final Cut Pro much as you would for any video project, but there are
a few important things to keep in mind. See Editing with Final Cut Pro for descriptions
of these considerations.

Stage 6: Creating Cut Lists and Other Lists with Cinema Tools
Once you have edited your clips and are satisfied with your digitally edited project, you
are ready to generate film-related lists that describe how to cut the negative or workprint.
The cut list provides a list of the edits and of titling information.

See Creating Cut Lists and Other Lists with Cinema Tools for more information.

Film Workflow Examples
The following sections detail several Cinema Tools database workflow scenarios. Keep in
mind that there are many possible variations of these workflows, and you often do not
have to follow the steps exactly in order. It’s also possible to use parts of several workflows.
See Basic Film Workflow Steps for details about specific steps. For a discussion of the
integration between Final Cut Pro and Cinema Tools, see How Much Can Be Done from
Final Cut Pro?

Following are sections covering two groups of workflows—those that use scene-and-take
transfers (If You Used Scene-and-Take Transfers) and those that use camera-roll transfers
(If You Used Camera-Roll Transfers). These workflows are further divided depending on
whether a telecine log is available and whether you have device control of your video
player during the capture process.
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If You Used Scene-and-Take Transfers
Because scene-and-take transfers require a database record for each take (because of
noncontinuous key numbers), an important first consideration is whether or not a telecine
log is available.

Workflow for a Scene-and-Take Transfer with a Telecine Log
Importing a telecine log automatically creates the database entries.

Yes
Generate a batch capture

list with Cinema Tools

Import the batch list into
the Final Cut Pro Browser

and batch capture

Use the Cinema Tools
Connect Clips command

to connect clips to database

Device
control?

Key number
burned in?

Yes No

Import a telecine log
into the database

Create a new
database

Connect clips
to the database

Trim clips to match
database records

Use Final Cut Pro
to manually capture

each clip

Connect clips to
the database and

use Identify feature
to determine and

enter key number and
timecode for a known

frame of each clip

Use Final Cut Pro
to manually capture

each clip

Indicates steps that use automated processes.

No

The blue boxes show the preferred workflow, which contains the most automated steps and 
produces the most accurate cut list.

Workflow for a Scene-and-Take Transfer Without a Telecine Log
With no telecine log to import, you can do either of the following:

• Manually add entries to the database for each clip: With this workflow (outlined in the
following diagram), you export a batch capture list with Cinema Tools. If you have
device control and you already know the In and Out points of the clips, this method
can be efficient.
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• Manually capture the clips with Final Cut Pro and use the Synchronize with Cinema Tools
command to create the Cinema Tools database: This workflow is most useful when you
don’t know the exact In and Out points for each clip or if you do not have device control.
You can also create the Cinema Tools database by dragging the folder containing the
clips to the Cinema Tools application icon. You can use the Identify feature of
Cinema Tools to determine and enter the key number information for each database
record.

Yes
Generate a batch capture

list with Cinema Tools

Import the batch list into
the Final Cut Pro Browser

and batch capture

Use the Cinema Tools
Connect Clips command

to connect clips to database

Device
control?

Key number
burned in?

Yes No

Create a new
database

Connect clips
to the database

Trim clips to match
database records

Use Final Cut Pro
to manually capture

each clip

Connect clips to
the database and

use Identify feature
to determine and

enter key number and
timecode for a known

frame of each clip

Use Final Cut Pro
to manually capture

each clip

No

Add an entry for each clip
to the database

Indicates steps that use automated processes.

The blue boxes show the preferred workflow, which contains the most automated steps and 
produces the most accurate cut list.

If You Used Camera-Roll Transfers
The primary consideration when using camera-roll transfers is the film list generation
method you intend to use. See How Cinema Tools Creates Film Lists for an explanation
of the two available methods. Make sure to sync the audio to the video before you capture
the clips.
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Clip-Based Workflow for a Camera-Roll Transfer
The clip-based method is more reliable because there are fewer variables.

Import log into database
(should generate one

record per camera roll)

Enter at least one record
for each camera roll,

defining key number and
timecode relationship

Optional: Enter additional
records, one for each clip
(recommended when you

have device control)

Optional: Enter additional
records, one for each clip
(recommended when you

have device control)

Yes No

Yes
Generate a batch capture

list with Cinema Tools

Import the batch list into
the Final Cut Pro Browser

and batch capture

Use the Cinema Tools
Connect Clips command

to connect clips to database

Device
control?

Key number
burned in?

Yes No

Connect clips
to the database

Trim clips to match
database records

Use Final Cut Pro
to manually capture

each clip

Connect clips to
the database and

use Identify feature
to determine and

enter key number and
timecode for a known

frame of each clip

Use Final Cut Pro
to manually capture

each clip

No

Telecine
log?

Create a new
database

Indicates steps that use automated processes.

The blue boxes show the preferred workflow, which contains the most automated steps and 
produces the most accurate cut list.
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Timecode-Based Workflow for a Camera-Roll Transfer
The timecode-based method must be used in certain situations, such as when generating
a list from an external EDL or when the clip files are offline.

Use Final Cut Pro to
capture the entire camera

roll as a single clip or
capture desired takes as

separate clips (the timecode
must not change from 

the original)

Create a new
database

Enter at least one record,
defining key number and

timecode relationship

Import log into database
(should generate one 
record per camera roll)

Yes NoTelecine
log?

Basic Digital Intermediate Workflow Steps
The digital intermediate (DI) process generally refers to any workflow that involves source
video of 2K resolution or higher, whether from a high-quality film scan or a digital camera,
and that results in new output media being generated for distribution instead of relying
on conforming the original camera negative. The output can be high-resolution digital
files or a film print made from the files.

The primary goal of this workflow is to edit low-resolution versions of the source video
clips in Final Cut Pro but have Color be able to color correct the original full-resolution
source video clips and output the final movie. This is accomplished by exporting an Edit
Decision List (EDL) from Final Cut Pro that Color uses to match to clip records in a
Cinema Tools database.

There are two common approaches that you can take in a DI workflow:

• Scan all of the film: This is the simplest approach but requires a lot of disk storage space
for the large video files that result. This approach is detailed in this section.

46 Chapter 3 Cinema Tools Workflows



• Use a telecine for all of the film, and then scan only the clips that are used: This approach
is a bit more complicated and uses a telecine to provide the offline video for Final Cut Pro
to edit. This approach is detailed in the Digital Intermediate Workflow Using a Telecine
section.

A typical scan-based DI workflow is outlined below.

Final Cut Pro

Offline
edit

Color

Apple ProRes
video clips

EDL

EDLXML

Offline
QuickTime
conversion

Conform
video

Create
high-quality

film scan Final
program
output

Color
correct

2K DPX
image

sequences

DPX

Cinema Tools

Create
database

Stage 1: Creating Apple ProRes Files for Final Cut Pro
Final Cut Pro cannot work directly with the DPX image sequences that are typically used
in this workflow. You can use Color to create QuickTime files (usually based on an
Apple ProRes codec) from the DPX image sequences. Using Color ensures that the
QuickTime files have the correct reel number (the folder name that contains the actual
DPX files) and timecode (as embedded in the DPX files).
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You can create these downconverted files in Color by creating a new project with Render
File Type set to QuickTime and Export Codec set to the codec you want to use. Then
simply edit all the shots you want to convert into the Timeline, add them to the Render
Queue, and click Start Render. See the Color documentation for more information.

Stage 2: Creating the Cinema Tools Database
A Cinema Tools database for a DI workflow is much simpler than a database for a typical
film workflow because there is often no film information to track. You can create the
database by simply dragging the folder that contains the original media files to the
Cinema Tools application icon (it doesn’t matter whether Cinema Tools is already open
or not). A dialog appears asking if you want to create a new database. The new database
creates a record for each clip found in the folder and its subfolders.

Note: If you create a Cinema Tools database by dragging a folder containing many DPX
files to the Cinema Tools application icon, the process can take a long time and it might
appear that Cinema Tools is not responding. Be sure to give Cinema Tools plenty of time
to process the clips.

Once you have created the database, you can easily add new clips to it as they become
available by dragging them to the List View window.

Stage 3: Editing the Clips in Final Cut Pro
You edit the downconverted video clips in Final Cut Pro much as you would for any video
project, but there are a few important things to keep in mind. See Editing with Final Cut Pro
for descriptions of these considerations.

Stage 4: Exporting an EDL File from Final Cut Pro
After you have completed editing the downconverted video clips in Final Cut Pro, you
export an EDL. This file contains a list of every edit, with the reel names of the source clips
and their In and Out point timecode numbers.

Stage 5: Importing the EDL into Color
When you import an EDL into a Color project, you can choose the folder that contains
the source clips the EDL refers to. You can choose the folder that contains the original
DPX clips and have Color connect the EDL records to the clips, or you can choose the
Cinema Tools database you created from the clips.

The advantages of choosing the Cinema Tools database are:

• You can easily correct any issues there might be between the EDL and the actual clips.
For example, if a reel name does not match, you can change the reel name in the
Cinema Tools database to match the name listed in the EDL.

• Once you have created the Cinema Tools database, choosing it when importing an EDL
into Color can be faster than choosing the folder with the clips. Choosing the database
becomes especially useful if you end up importing the EDL into Color multiple times
as additional clips become available.
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• If the EDL refers to clips on more than one volume, a Cinema Tools database can connect
to all of the clips. Color can automatically connect to the clips on only one volume, and
you must manually connect to the clips on the other volumes.

Stage 6: Finishing the Project in Color
Once you have imported the EDL into Color and matched it to the source clips, the clips
are conformed to match the edits, and you can proceed with the usual color correction
process. Color is then used to render the final output video.

Digital Intermediate Workflow Using a Telecine
Using a telecine to create the offline video clips to edit with Final Cut Pro requires far less
storage space than using a film scan for all of the film footage. After the edit is finished,
you use Cinema Tools to generate the pull list, which is used to create scans for only the
video clips that are actually used in the program. The drawbacks of this method are that
the original camera negative must be processed twice and the clips from each process
must use the same reel names and timecode.

Cinema Tools
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database

Pull list

EDL
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Final
program
output

Color
correct

Conform
video

Film list
Offline
video

Create
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Stage 1: Creating the Offline Video Clips
Using a telecine, you create the offline video clips that Final Cut Pro uses to edit the
program. You should try to create offline video clips with the same frame rate as the DPX
image sequence clips you will create with the film scan when the offline edit is finished.
You also need to make sure the reel name and timecode of the telecine clips will match
those of the clips from the film scan.

Note: Cinema Tools and Color use the name of the folder containing the DPX image
sequence files as the reel name.

You should also generate a telecine log file that Cinema Tools can use to create a database
for exporting the pull list used by the film scanner.

Stage 2: Creating the Cinema Tools Database
You create a Cinema Tools database using the telecine log file. This database is used to
generate the pull list after you finish editing the program.

Stage 3: Editing the Clips in Final Cut Pro
You edit the offline video clips in Final Cut Pro much as you would for any video project,
but there are a few important things to keep in mind. See Editing with Final Cut Pro for
descriptions of these considerations.

Stage 4: Exporting the Pull List
After you have finished editing the offline video clips, you can export a Cinema Tools film
list that includes the pull list used to scan the high-quality video clips used in the program.

Stage 5: Creating the High-Quality Video Clips
The pull list is used by a film scanner to create high-quality video clips, usually DPX image
sequences, that are then used to finish the program in Color.

It is critical that the reel names and timecode of the scanned clips match what the telecine
process provided for the offline video clips.

Stage 6: Exporting an EDL File from Final Cut Pro
After you have completed editing the offline video clips in Final Cut Pro, you export an
EDL. This file contains a list of every edit, with the reel names of the source clips and their
In and Out point timecode numbers.

Stage 7: Importing the EDL into Color
When you import an EDL into a Color project, you can choose the folder that contains
the source clips the EDL refers to. You can choose the folder that contains the scanned
DPX clips and have Color connect the EDL records to the clips, or you can choose a
Cinema Tools database you create from the clips.
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The advantages of choosing the Cinema Tools database are:

• You can easily correct any issues there might be between the EDL and the actual clips.
For example, if a reel name does not match, you can change the reel name in the
Cinema Tools database to match the name listed in the EDL.

• Once you have created the Cinema Tools database, choosing it when importing an EDL
into Color can be faster than choosing the folder with the clips. Choosing the database
becomes especially useful if you end up importing the EDL into Color multiple times
as additional clips become available.

• If the EDL refers to clips on more than one volume, a Cinema Tools database can connect
to all of the clips. Color can automatically connect to the clips on only one volume, and
you must manually connect to the clips on the other volumes.

Stage 8: Finishing the Project in Color
Once you have imported the EDL into Color and matched it to the source clips, the clips
are conformed to match the edits, and you can proceed with the usual color correction
process. Color is then used to render the final output video.

Working with REDCODE Media
Working with media recorded using the RED ONE camera requires that your computer
have RED Final Cut Studio support software installed. See the RED Digital Cinema Camera
Company website at http://www.red.com/support for more information.

Each REDCODE media file is made up of several files inside a folder with an .RDC extension.
For example, you can have a folder with the name H046_C001_1002VL.RDC that contains
the following files:

• H046_C001_1002VL_001.R3D

• H046_C001_1002VL_F.mov

• H046_C001_1002VL_H.mov

• H046_C001_1002VL_M.mov

• H046_C001_1002VL_P.mov

The file with the .R3D extension is the actual media clip—the other files in the folder with
.mov extensions are QuickTime movies that are optionally created by the RED ONE camera,
providing different resolutions of the media file.

To add a record that is connected to a REDCODE clip to a Cinema Tools database, you
need to drag the .RDC folder that contains the media files or any of the .mov files in the
folder to the Cinema Tools List View window. Alternatively, you can drag a folder that
contains multiple .RDC folders (representing multiple REDCODE clips) to the Cinema Tools
application icon to create a new database based on the clips.
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When you play the clip in the Clip window, a .mov file (usually the one with “_M” in its
name) is played.

Important: There has to be at least one .mov file in the folder for Cinema Tools to be able
to play the clip in the Clip window.
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At the heart of Cinema Tools is its database, providing powerful organizational tools.

This chapter covers the following:

• An Introduction to Cinema Tools Databases (p. 53)

• Deciding How You Should Create the Database (p. 54)

• Creating and Configuring a New Database (p. 58)

An Introduction to Cinema Tools Databases
A Cinema Tools database contains records that:

• Describe your source clips

• Track the relationship between the film rolls and edge code (key numbers, ink numbers,
or both) and the video reels and timecode

• Can also track other elements such as scenes, shots, and takes, as well as sound rolls
and audio timecode

You generally create a database for each film or video project. Alternatively, you can
create databases for sections of your project and later merge them all into one large
database.

When you work on film projects, the database makes it possible for you to export film
lists that tell the negative cutter how to cut your original camera negative. When you
work on projects using a digital intermediate workflow, the database makes it easier to
manage your original full-resolution media.

Beyond creating film lists, you may want to use the database as an organizational tool.
It can function similarly to the code book traditionally used in the post-production of
film, tracking important elements such as the scene, shot, and take; the camera and lab
rolls; the edge code numbers; the video reels and timecode numbers; the sound rolls and
audio timecode numbers; and the source clips.
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Depending on your situation, you may be able to simplify the database creation process
by building the database from a telecine log or by creating just one database record per
camera roll.

Understanding the Basic Structure of a Cinema Tools Database
A database is made up of records, and each record describes one source clip. There are
three different types of source clips for which you might create a database record:

• If you used a scene-and-take transfer: You’ll have one database record for each take,
where each source clip is one take.

One source clip
containing one take

Take 1

One
database

record

• If you used a camera-roll telecine transfer: You’ll have one database record per camera
roll, where each source clip is one camera roll (typically containing several takes).

One source clip
containing one camera roll

One
database

record

• If you have broken down source clips into groups of takes: Each database record is
associated with one source clip that contains several takes.

One source clip
containing multiple takes

Take 1 Take 2 Take 3

One
database

record

Deciding How You Should Create the Database
The way you create the database depends on how you want to use it and whether or
not you have a telecine log or Avid Log Exchange (ALE) file.

54 Chapter 4 Creating a Cinema Tools Database



If you haven’t done so yet, take a look at Cinema Tools Workflows for general information.
Use these examples to guide you in determining the basic steps you need to take to
create your database and capture your clips. The steps you take, and the order of those
steps, differ depending on a number of factors, most of which are summarized in the
workflow examples.

Capturing Before You Create the Database
When using a traditional film workflow, it is possible to capture your source clips before
creating your database, and to build the Cinema Tools database by importing a batch
capture list created in Final Cut Pro. This approach is not as easy as building a database
from a telecine log or ALE file because you then need to manually add the key number
and film roll information to each database record. See Importing Database Information
from a Batch Capture List for more information.

When using a digital intermediate workflow, you will need to capture, or more often
transfer, your video files from their source media using the Final Cut Pro Log and Capture
or Log and Transfer window. You can then create the Cinema Tools database by simply
dragging the folder with the captured files to the Cinema Tools application icon.

If You Have a Telecine Log or ALE File
A telecine log, sometimes referred to as a FLEx file, is a file created by the telecine
technician during a telecine transfer. You can also use an Avid Log Exchange (ALE) file as
you would use a telecine log. The telecine log records the key numbers of the original
camera negative and the timecode of the video transfer, and tracks the relationship
between them.

Advantages of Using a Telecine Log or ALE File
Creating your database from a log is ideal because it provides these advantages:

• Time savings: You can create database records from a telecine log. You don’t have to
manually create and enter details in each record. You can then generate a batch
capture list from the database, expediting the capture process.

• Accuracy and completeness: Assuming the log you use is accurate, you’ll instantly have
an accurate database and you won’t have to worry about your own potential data
entry errors. Using the database batch capture list also ensures that the source media
files you capture match your database information.

To build a database from an existing log
1 Create a new, empty database.

See Creating and Configuring a New Database for more information.

2 Generate the database records from the log.
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See Importing Database Information from a Telecine Log or ALE File for more information.

If You Do Not Have a Telecine Log or ALE File
Although it’s faster and more efficient to use a log, you can build a database without one.
This is the most common approach with digital intermediate workflows.

To create a database without a log
1 Create a new, empty database.

See Creating and Configuring a New Database for more information.

2 Enter database records manually.

See A Potential Database Shortcut for Camera-Roll Transfers and Entering Database
Information Manually for more information.

Note: Alternatively, you could capture your source clips before creating your database
and then build the Cinema Tools database by importing a batch capture list created in
Final Cut Pro. See Importing Database Information from a Batch Capture List for more
information.

Is Your Edge Code Number-to-Timecode Relationship Continuous or
Noncontinuous?
The edge code number-to-timecode relationship in a camera roll is continuous if the
camera roll was transferred to video without stopping.

The edge code number-to-timecode relationship is noncontinuous if:

• You used a scene-and-take telecine transfer, where the video recording was stopped
and restarted in between takes

• The film roll was made up of takes that were spliced together before it was transferred
to video

Note: Occasionally the edge code number-to-timecode relationship is broken if, during
filming, the camera crew opened up a camera to check, clean, or change parts of the
camera (often called checking the gate). When the camera is opened for such purposes,
the film is typically unthreaded and then rethreaded. When the film is rethreaded, it
may be on a different perforation number. This means that at the telecine, the telecine
technician needs to stop, reframe, and make an edit, thus breaking the edge code
number-to-timecode relationship in the camera roll. This should be evident in the
telecine log.
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A Potential Database Shortcut for Camera-Roll Transfers
If you used a camera-roll transfer and need to manually create your database, you may
be able to save time by creating one database record per camera roll, depending on
whether or not the edge code number-to-timecode relationship is continuous for each
camera-roll transfer.

If the Edge Code Number-to-Timecode Relationship Is Continuous on Each Roll
You can create one database record per camera roll, and Cinema Tools can use the
timecode-based method of locating database records in order to create film lists. In this
case, each camera roll acts as one source clip.

As long as you create an accurate database record for the camera roll, Cinema Tools will
be able to accurately create film lists. However, if you also connect the source clips to the
database records, you are providing extra insurance that the match-back will go smoothly
even if there is a timecode error. See Timecode-Based Workflow for a Camera-Roll Transfer
and How Cinema Tools Creates Film Lists for more information.

Even if you have a continuous edge code number-to-timecode relationship, you may
want to take the time to create database records for each source clip for your own
organizational and tracking purposes. For example:

• A database can be used to cross-check which take is on which sound roll and which
lab roll contains a negative you need.

• You may want to have records for each clip so that you can add notes about different
clips.

• Database records provide a poster frame of each clip for quick visual reference, and
you can access and play the whole clip from the database.

If the Edge Code Number-to-Timecode Relationship Is Noncontinuous on Each Roll
You need to create separate database records for each clip and connect each clip to its
record. Each database record must include the key number or ink number of the first
frame of the associated source clip, so that Cinema Tools can adequately track the edge
code number-to-timecode relationships throughout your sequence.

Additional Uses for the Database
Optionally, you may want to use the database for purposes beyond simply matching
video back to film, and this can affect how you create databases:

• Individual databases for dailies: If you have daily shoots that you want to process and
track separately, you can create new individual databases for each daily session. If you
do create individual databases for dailies, consider naming each database file by the
date of the daily. Eventually, you can merge the databases into a master database by
importing all the databases into one database.
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• Creating an audio Edit Decision List (EDL): If you plan to give an audio EDL to the audio
post-production facility, make sure that the audio timecode, video timecode, and sound
roll information is entered in each database record. Creating the database by importing
a telecine log is the easiest and most efficient way to make sure that all the necessary
information is entered in the database.

Creating and Configuring a New Database
When you create a new Cinema Tools database, you make default selections for your
project settings in the New Database dialog.

Note: When you import data from a telecine log, the film standard, video timecode rate,
audio timecode rate, and telecine speed are typically included in the log and are
automatically set in Cinema Tools. Data from the telecine log takes precedence over the
defaults, so even if your default settings are different from the telecine log data,
Cinema Tools uses the settings in the telecine log.

You can create a new database using Cinema Tools or Final Cut Pro.

Creating a New Database Using Cinema Tools
You can create a new database and configure its default settings directly in Cinema Tools.

Note: If a database is already open when you create a new one, the currently open
database is closed.

To create a new database
1 Do one of the following:

• Open Cinema Tools and click Create a New Database in the Welcome dialog, if it appears.

The Welcome dialog generally appears only the first time you open Cinema Tools.

After that, Cinema Tools opens the database that was open the last time you closed
Cinema Tools. If there was no database open when you closed Cinema Tools, the
Welcome dialog appears again.

• Choose Database > New Database (or press Command-Shift-N).
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• Drag one or more folders with clips from a Finder window to the Cinema Tools
application icon.

Note: If you drag a mixture of selected clips and folders to the application icon, a dialog
appears advising you not to mix the two types of items. Dragging selected clips to the
application icon does not create a new database, but opens the clips in the Clip window
instead.

2 In the New Database dialog, choose default settings for your database and click OK. See
Settings in the New Database Dialog for information about the settings.

Note: The settings in this dialog can be left at their default values when you are creating
a database from video clips and do not intend to track any film-related information in
the database records.

3 In the “Create a new database” dialog, choose a location and enter a filename for the
database.

An empty database is created, and you are ready to enter information in it. See About
Working with Database Information for more information.

Important: If you created the database by dragging a folder that contains many clips,
especially if they are DPX image sequences, it can take Cinema Tools a significant amount
of time to process and add all of the clips to the new database. Cinema Tools may appear
to have stopped responding during this time. Be sure to allow plenty of time for
Cinema Tools to finish processing the folder of clips.

Creating a New Database Using Final Cut Pro
There are two methods you can use to create a Cinema Tools database while using
Final Cut Pro:

• Synchronize a set of clips with a new database.

• Import a telecine log file into a new database.

Synchronizing a Set of Selected Clips to Create a New Database
You can use the Synchronize with Cinema Tools command if you have one or more clips
in the Final Cut Pro Browser that you would like to add to a new Cinema Tools database.
This can be useful when you have manually captured a set of clips but have no telecine
log to go with them, or when you want to create a separate database for a set of clips
already in a database.
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To create a new database using the Synchronize with Cinema Tools command
1 In the Final Cut Pro Browser, select the clips that you want to add to a new Cinema Tools

database.

These can be clips that are already in a database, or they can be new clips that are not
in a database.

2 Choose Tools > Synchronize with Cinema Tools.

A dialog appears that allows you to configure the synchronization process.

The Database field shows the currently selected database.

3 Select the “Add new records” checkbox.

This option must be selected when you are synchronizing with a new database.

4 Select the “Auto connect” checkbox if you want the database to automatically connect
the clips to any new records that are created in the database.

5 Click New Database to create a new Cinema Tools database.

6 In the dialog that appears, enter a name and location for the database, and configure its
default settings. See Settings in the New Database Dialog for information about these
settings.

7 To close the dialog, click Save when finished.

8 Click OK.

A new Cinema Tools database is created, and the selected clips, along with any film-related
information they might contain, are added to it.
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See Synchronizing Final Cut Pro Clips with Cinema Tools for more information about the
Synchronize with Cinema Tools command, including how to use it to synchronize clips
to an existing database.

Importing a Telecine Log File to Create a New Database
When you import a telecine log file into Final Cut Pro, you can choose to import it into a
new or existing Cinema Tools database. See Importing Telecine Logs Using Final Cut Pro
for more information.

Settings in the New Database Dialog
When you make choices in the New Database dialog, keep the following points in mind:

• Choosing a default setting does not lock you into using that setting in the database
records. Default settings are applied automatically to new database records, but you
can change the film standard, video timecode rate, and audio timecode rate for each
clip individually in the Detail View window.

• When you import data from a telecine log, the film standard, video timecode rate, audio
timecode rate, and telecine speed are typically included in the log and are automatically
set in Cinema Tools. Data from the telecine log takes precedence over the defaults, so
even if your default settings are different from the telecine log data, Cinema Tools uses
the settings in the telecine log.

• The settings in this dialog can be left at their default values when you are creating a
database from video clips and do not intend to track any film-related information in
the database records, such as in a typical DI workflow.

If you need to change default settings you already made, see Changing the Default
Database Settings for information.

Tip: If you are combining existing databases or want to check information such as default
settings, filenames, and modification dates for an existing database, choose Database >
Database Properties. The Database Properties dialog displays the full pathname and size
of the database file, as well as the creation and modification dates. You can see the default
project settings for the film standard, video timecode rate, and audio timecode rate.

The New Database dialog contains the following settings:

• Film Standard: Cinema Tools supports the 4-perf 35mm, 3-perf 35mm, and 16mm-20
formats. (See Film Background Basics for information about these standards.)

Normally you use the same film stock throughout a film, so the film standard doesn’t
change. However, if you need to, you can set the film standard for each shot individually
in the Detail View window. For example, if you have some clips that are reverse but
most are normal, you can specify the reverse film standard in the Detail View window
for those clips.
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Choose the standard film type used for your project from the Film Standard pop-up
menu:

• 35mm 4p: 35mm film, 4 perforations per frame

• 16mm 20: 16mm film, 20 frames per key number

• 35mm 3p: 35mm film, 3 perforations per frame

• Video TC Rate: Cinema Tools supports four different video timecode rates. See Film
Background Basics for information about timecode rates. The film lab that transfers
your film to video can tell you what kind of timecode is recorded on the videotape.

Choose the type of timecode recorded on the videotapes for your project from the
Video TC Rate pop-up menu:

• 30 NDF: Non-drop frame NTSC timecode at 29.97 fps

• 30 DF: Drop frame NTSC timecode at 29.97 fps

• 25 FPS: PAL timecode at 25 fps

• 24 FPS: Video timecode at 24 fps or 23.98 fps

• Sound TC Rate: Usually, timecode is recorded along with the soundtracks on the
production sound rolls. That timecode can be used to locate the audio that goes with
any particular clip, and many systems can use that timecode to synchronize the audio
with the video. The primary purpose for entering the sound roll and audio timecode
information in the database is for matching audio back to an audio Edit Decision List
(EDL). See Exporting an Audio EDL for more information.

Choose the type of timecode recorded on your production sound rolls from the Sound
TC Rate pop-up menu:

• 30 NDF: Non-drop frame NTSC timecode at 29.97 fps

• 30 DF: Drop frame NTSC timecode at 29.97 fps

• 25 FPS: PAL timecode at 25 fps
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• 24 FPS: Video timecode at 24 fps or 23.98 fps

• Telecine Speed: Telecine speed (shown as TK Speed in the Detail View window, the Clip
window’s Identify pane, and optionally in the Final Cut Pro Browser window) refers to
the frame rate of the film in the telecine equipment during the transfer to video.

From the Telecine Speed pop-up menu, you choose the speed at which the film was
transferred:

• 24: 24 fps or 23.98 fps telecine film speed

• 25: 25 fps telecine film speed

• 30: 29.97 fps telecine film speed

If you are working with NTSC video, you usually choose 24 fps as the telecine film speed,
though the actual telecine film speed is approximately 23.98 fps. The Telecine Speed
pop-up menu also allows you to choose a setting of 30 fps because it is possible to
transfer film to NTSC video with the film running at a speed of 30 fps (actually 29.97 fps).

If you are working with PAL video, see Frame Rate Basics for a discussion of the PAL
frame rate choices.

If your film was transferred to video at a telecine film speed of 24 fps, choose 24 fps as
the telecine film speed. If your film was transferred to video at a telecine film speed of
25 fps, choose 25 fps.
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To work with the database, you need to know how to open it, find specific records, and
access information about a record’s clip. This chapter also details using the List View,
Detail View, and Clip windows.

This chapter covers the following:

• Opening an Existing Database (p. 65)

• Viewing Database Properties (p. 66)

• About the Detail View Window (p. 66)

• Settings in the Detail View Window (p. 67)

• About the List View Window (p. 73)

• Settings in the List View Window (p. 74)

• Finding and Opening Database Records (p. 76)

• Settings in the Find Dialog (p. 77)

• Backing Up, Copying, Renaming, and Locking Databases (p. 80)

• About the Clip Window (p. 80)

• Settings in the Clip Window (p. 81)

• Accessing Information About a Source Clip (p. 84)

Opening an Existing Database
The first step in working with a database is to open it.

To open an existing database
Do one of the following:

µ Choose Database > Open Database (or press Command-Shift-O), then select the database
in the dialog.

µ Drag a database file from a Finder window to the Cinema Tools application icon.
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All the records in the open database are listed in the List View window, and the Detail
View window shows the first record’s details. See About the Detail View Window and
About the List View Window for details about using these two windows.

Note: The current database closes if one is already open.

Viewing Database Properties
You can use the Database Properties dialog to see a wide variety of information about
the current database, including its default settings and statistics about the records.

To open the Database Properties dialog
µ Choose Database > Database Properties (or press Command-I).

About the Detail View Window
You use the Detail View window to view, enter, and change information in a database
record. When you open an existing database, the Detail View window displays the first
record. The specific numbers in the Detail View window (reels, rolls, and key and ink
numbers) all describe values for the first frame of the source clip associated with the
database record.

The Detail View window appears along with the List View window whenever you open
a database.

To view the Detail View window
Do one of the following:

µ Choose Window > Detail View (or press Command-2).

µ If necessary, drag the List View window to a different screen position.
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µ If necessary, click the Detail View window to bring it to the front.

See Settings in the Detail View Window for more information about the Detail View
window.

Settings in the Detail View Window
The Detail View window includes a number of fields and buttons for creating a database
record. Only a few of these settings are required for the purpose of using the database
to create a cut list or change list. The required settings depend on the type of list you will
create and the method you will use to create it.

These settings are required if you intend to generate a cut list or change list for a
film-based project:

• Lab, camera, or daily roll

• Key number or ink number

Additionally, each source clip must be connected to a record, unless you can use the
timecode-based method for cut list or change list generation (see A Potential Database
Shortcut for Camera-Roll Transfers).

To use the timecode-based method for cut list or change list generation, these elements
are also needed:

• Video reel

• Video timecode and duration

These settings are required if you intend to export an audio EDL:

• Each source clip must be connected to a record, or each record must have the video
reel and video timecode and duration entered.

• Each record must have the sound roll, audio timecode, and audio timecode rate (Sound
TC Rate) entered.
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The Detail View window contains the following fields and buttons:

Field for take notes

Field for telecine
session notes

Previous Record and
Next Record buttons

Database Fields and Buttons
These fields and buttons apply to the entire database.

• Previous Record and Next Record buttons (arrows): Click these buttons to switch to the
previous or next record (as currently sorted and displayed in the List View window).

Note: One of these buttons is dimmed when you are at the beginning or end of the
list and there isn’t a previous or next record.

As a shortcut, you can use the Left Arrow and Right Arrow keys on your keyboard. If
you have made changes to the current record, a dialog appears asking if you want to
save those changes.

• New Record button: Click to create a new database record. In the dialog that appears,
enter the scene and take identifiers for the new database record. See Using Scene, Shot,
and Take Identifiers for more information.

• Save button: Click when you have added or modified data in the current database
record. Your added or modified information is not recorded unless you click Save.

• Telecine Session area: This area, in the middle-right part of the window, lists the name
of the telecine log file imported into the database (if applicable).

• Telecine Session Notes field: Enter any notes you want to include about the telecine
session.

Note: This field is available only if you have imported a telecine log file into the database.

Scene and Shot Description Fields
You only need to enter this data once per scene. Once you enter it, it is added to all
existing and new records for the same scene.

• Scene description field: Enter a description of the scene.
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• Shot description field: Enter a description of the shot.

• Script Pages fields: Enter the starting and ending script pages associated with the scene
and the shot.

Film Settings
The following settings relate specifically to the film. In general, you can ignore these
settings if your project does not involve film or you are not intending to finish the project
by conforming the original camera negative.

• Scene field: Use this field to enter or modify the identifier for the scene. See Using Scene,
Shot, and Take Identifiers for more information.

• Take field: Enter a take identifier here. Takes are usually identified as numbers, but you
can enter whatever text you want to use to identify the take, up to 15 characters. If
there are multiple takes in the source clip, think of the take identifier as a subclip
identifier.

• Cam Roll field: (If you intend to create a cut list or change list for a film-based project,
one of the film roll fields must be completed.) If editing material from camera rolls,
enter the camera roll identifier given to the roll of film by the camera assistant during
production. The camera roll identifier should be the same as that which appears on
the slate for the take.

Note: In many cases the camera roll and the lab roll are the same thing and can be
given the same identifier. You can choose to enter data in either one or both of these
fields. You should, however, be consistent. When creating a cut list or change list,
Cinema Tools gives you the choice of showing the camera roll, lab roll, or daily roll.
Whichever one you choose, it must be present in every database record, or Cinema Tools
will report an error when you export a film list.

• Lab Roll field: (If you intend to create a cut list or change list for a film-based project,
one of the film roll fields must be completed.) If editing material from lab rolls, enter
the identifier given to the lab roll by the laboratory that processed the film. Or, enter
an identifier for a roll created from select takes, for printing. (Sometimes such a roll is
referred to as the A negative.) In many cases the lab roll and the camera roll are the
same thing and can be given the same identifier—see the note above.

• Daily Roll field: (If you intend to create a cut list or change list for a film-based project,
one of the film roll fields must be completed.) If editing material from daily rolls, enter
the identifier given to the daily roll from which this source clip originated.
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• Key fields: (If you intend to create a cut list or change list for a film-based project, these
fields or the ink number fields are required.) The first field should contain the key prefix
that is constant throughout a roll of film. For example, for the key number KJ 29 1010
5867+07, the key prefix is “KJ 29 1010,” which you enter as “KJ291010.” You can enter
up to eight characters (including spaces, although most often you will be skipping the
spaces, as in this example). In the second field, enter the second part of the key
number—the frame number—for the first frame of the clip. For example, for the key
number KJ 29 1010 5867+07, the frame number is “5867+07.” The frame number
identifies each foot or half foot within the reel, plus the frame count number. If you
know the key number for another part of the clip, the Identify feature can determine
and enter the key number (Key fields) for the first frame of your clip. See Calculating
Edge Code and Timecode Numbers for more information.

• Ink fields: (If you intend to create a cut list or change list for a film-based project, these
fields or the Key fields are required.) In the first field enter the prefix number, and in
the second field enter the frame number. For example, in the ink number 123 4567+08,
the prefix is “123” and the frame number is “4567+08,” indicating that the frame occurs
at 4567 feet and 8 frames.

• TK Speed pop-up menu: This pop-up menu gives you the option of individually specifying
the telecine transfer film speed for each database record. If the database record was
created from a telecine log, this setting should already be correct and there should be
no need to change it. If you are creating the database manually, the setting in this
pop-up menu should reflect the telecine film speed setting you chose when you set
your project defaults. See Settings in the New Database Dialog for more information.

• Film Std pop-up menu: This pop-up menu gives you the option of individually specifying
the film standard for each database record. If the database record was created from a
telecine log, this setting should already be correct and there should be no need to
change it. If you are creating the database manually, the setting in this pop-up menu
should reflect the setting you chose in the New Database dialog.

For clips that are in reverse direction, you can specify a reverse direction for the film
standard by choosing either the 35.4p.rev (for 4-perf 35mm) or 16.20.rev (for 16mm-20)
item. Reverse-direction film is film that has key numbers going in a descending rather
than an ascending order. You’ll see this when, for example, film has been shot in reverse,
or when a film roll was loaded into the camera “tails out,” so that the key numbers are
in reverse order. See Settings in the New Database Dialog for more information.

For clips that use the 3-perf 35mm standard, you choose the perforation offset of the
key number. This offset (3-perf•1, 3-perf•2, or 3-perf•3) refers to the relationship of the
perforation marked with the symbol “•” and the film frame at that point. See 3-Perf
35mm Offsets for more information.

Note: Reverse-direction 3-perf 35mm film is not supported.
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Video Settings
The following settings relate specifically to the video clips.

• Video Reel field: (Unless all the clips you will be editing are connected to the database,
this field is required if you intend to create a cut list or change list or audio EDL.) Enter
the identifier of the video reel that contains this take. This field is essential for creating
an accurate cut list or change list. When you connect a clip to a database record that
does not yet contain the reel identifier, Cinema Tools looks for this information in the
clip file and automatically enters it in the database record. Make sure you enter the
exact, correct identifier here, so that the database record can be properly matched to
the shot after you digitally edit your program. For example, “001” is not the same as
“0001.”

Important: When connecting DPX image sequences to a database, Cinema Tools uses
the name of the folder containing the DPX image sequence files as the video reel name.
This folder name should not be changed during a DI project.

• Video Timecode field: (Unless all the clips you will be editing are connected to the
database, this field is required if you intend to create a cut list or change list or audio
EDL.) Enter the timecode number of the video frame that represents the first frame of
the clip. The relationship between the key numbers and the timecode is established
when the film is transferred to video, and this information is usually entered
automatically when you create the database from a telecine log. When you connect a
clip to a database record that does not yet contain the clip timecode, Cinema Tools
looks for this information in the clip file and automatically enters it in the database
record. You can also determine the timecode value for this field by looking at the first
frame of the clip, provided that both the key number and the timecode are burned in
to the video.

Tip: If you enter the video reel and timecode information in the Detail View window,
you can use the database to locate source material on the videotape while you are
editing. For example, if you are editing a clip and there is something in the clip that
you are unsure about because you can’t see it clearly, you may want to view it on the
videotape because the video is of higher quality. You can check the clip’s database
record to find which video reel contains the material and the timecode location on the
reel.
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• Video Duration field: (Unless all the clips you will be editing are connected to the
database, this field is required if you intend to create a cut list or change list or audio
EDL.) Enter the timecode duration of the source clip. The value for this field can come
from a telecine log. If you connect a clip to a database record that does not yet contain
the clip timecode duration, Cinema Tools looks for this information in the clip file and
automatically enters it in the database record. Because duration is expressed as hours,
minutes, seconds, and frames, you might find it more informative than the length of
the film expressed as feet and frames. The timecode duration is significant if you intend
to perform a batch capture, or if you will be creating a cut list or change list by matching
the edited program back to the video reel and timecode.

• Video TC Rate pop-up menu: This pop-up menu displays the default video timecode
rate that you chose when you created the database, or the format that was indicated
by the telecine log you imported to create the database. The lab that transfers your
film to video can tell you which kind of video timecode is recorded on the videotape.
See Settings in the New Database Dialog for more information.

Sound Settings
The following settings relate specifically to the audio clips.

• Sound Roll field: (Required if you intend to create an audio EDL.) Enter the sound roll
name.

• Sound Timecode field: (Required if you intend to create an audio EDL.) Enter the starting
audio timecode number for the clip. The audio timecode standard can be different
from the video timecode standard.

• Sound TC Rate field: (Required if you intend to create an audio EDL.) Enter the type of
timecode used on your production sound rolls.

Clip Button and Settings
The following apply specifically to the clip linked to this record.

• Take Notes field: Enter any notes you want to include about the source clip.

• Clip thumbnail: The thumbnail display shows the poster frame of the connected clip.

Additionally, placing the pointer over the thumbnail display shows a tooltip with the
clip’s location. This can be especially useful if the clip is missing because it lets you
know where Cinema Tools thinks the clip should be.
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See Choosing a Different Poster Frame for a Clip for more information about the poster
frame.

• Connect Clip/Open Clip button: If a clip has not been connected to the database record,
this button is labeled Connect Clip. If a clip has already been connected, the button is
labeled Open Clip.

• Click Connect Clip to select a source clip to connect to this record. When you select
a clip, it is connected to the database record, and the first frame of the clip appears
in the box below the Connect Clip/Open Clip button.

• Click Open Clip to open a Clip window for the connected clip. If the related clip is
not found, a dialog opens so that you can select the correct clip.

• Press the Command key to change Open Clip to Disconnect Clip. Click Disconnect
Clip to disconnect the clip from the database record.

About the List View Window
The List View window displays a list of database records in the open database. It might
show a complete list of all database records, or, if you use the Find feature, it might show
only those records that are found (the “found set”). The List View and Detail View windows
appear whenever you open a database.

To view the List View window
Do one of the following:

µ Choose Window > List View (or press Command-1).

µ Drag the Detail View window to a different screen position.

µ Click the List View window to bring it to the front.
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The Show All and Find buttons allow you quickly either to show all of the records in the
open database (click Show All) or to show a specific set of records by using the Find dialog
(click Find). See Finding and Opening Database Records for information about using the
Find button.

The pop-up menu at the top-left corner of the window lets you choose the display mode,
determining the type of information that appears. See Settings in the List View Window
for details about the different display modes and how to use the columns to select records
to work with.

By default, the columns in the List View window are sorted by the Slate value, in ascending
order. You can sort the data based on any displayed column by clicking the column’s
name. The name changes color to indicate it is controlling the sort, and an arrow appears
to show the sort direction. An arrow pointing up indicates an ascending sort order, and
an arrow pointing down indicates a descending order. Click the column’s name to change
the sort direction.

Sorting the columns can make it easy to locate records with missing items. For example,
clicking the Cam Roll column name groups together all records without an entry in that
field and places them at the top or bottom of the list, depending on the arrow’s direction.

You can also locate a record using a specific key number or timecode number by sorting
the columns. For example, clicking the Keycode column name puts the records in order
based on their key numbers. You can then scroll through the list and locate a record using
a specific film frame.

Settings in the List View Window
The List View window shows a set of columns based on the display mode you choose in
the pop-up menu at the top-left corner of the window.
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List View Window Controls
The following controls along the top of the List View window determine the columns
that appear and allow you to choose the records that are shown.

• Display mode pop-up menu: Use this pop-up menu to configure the List View window
to show the columns most useful to you.

• Keycode: Displays information about the film, including key numbers and rolls.

• Video: Displays video timecode and reel information.

• Sound: Displays audio timecode and sound roll information.

• Ink Numbers: Displays information about the workprint, including ink numbers and
daily rolls.

• Show All: Click this button to show all of the records in the current database.

• Find: Click this button to open the Find dialog. You can use the Find dialog to choose
which records appear in the List View window. See Settings in the Find Dialog for more
information.

List View Window Columns
The following columns can appear in the List View window, depending on the the display
mode you choose.

• Columns that appear in all display modes: The following columns appear in all display
modes:

• Slate: A combination of the Scene and Take fields, separated by a hyphen

• Clip: The name of the clip connected to each database record

• Keycode display mode columns: The following columns appear in the Keycode display
mode:

• Lab Roll: The value entered in the Lab Roll field (in the Detail View window)

• Cam Roll: The value entered in the Cam Roll field

• Keycode: The value entered in the Key field

• Video display mode columns: The following columns appear in the Video display mode:

• Reel: The value entered in the Video Reel field

• Timecode: The value entered in the Video Timecode field

• Sound display mode columns: The following columns appear in the Sound display mode:

• Roll: The value entered in the Sound Roll field

• Timecode: The value entered in the Sound Timecode field

• Ink Numbers display mode columns: The following columns appear in the Ink Numbers
display mode:

• Lab Roll: The value entered in the Lab Roll field
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• Daily Roll: The value entered in the Daily Roll field

• Ink Number: The value entered in the Ink field

Finding and Opening Database Records
You typically open database records in the Detail View window by selecting the record
in the List View window. The set of records displayed in the List View window is often
referred to as the found set, because you use the Find command to specify which records
are listed there.

Note: You can select only one record at a time.

To select a database record in the List View window
Do one of the following:

µ Click any displayed record.

µ Double-click a record to have its clip open in the Clip window.

µ Use the keyboard’s Up Arrow key to select the record before the currently selected one.

µ Use the keyboard’s Down Arrow key to select the record after the currently selected one.

µ Use the keyboard’s Page Up key to jump up one page of records in the list.

µ Use the keyboard’s Page Down key to jump down one page of records in the list.

Once you have selected a record, it stays selected as you change the display mode.

Important: You cannot change the settings in any of the records in the List View window.
Use the Detail View window to make changes.

To display specific records in the List View window
µ Use the Find dialog.

See the instructions for using the Find command (below) for details.

To navigate through records within the Detail View window
µ Click the Previous Record and Next Record buttons.

Previous Record and
Next Record buttons
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To find a key number
µ In the List View window, choose Keycode from the pop-up menu, then click the Keycode

column heading to sort by key number.

See About the List View Window for more details.

To use the Find command to find records in the open database
1 Open the Find dialog by doing one of the following:

• Choose Database > Find (or press Command-F).

• Click the Find button in the List View window.

2 Configure the settings and click Find Records.

See Settings in the Find Dialog for more information.

Alternatively, you can click Show All Records if you want to see all of the database records.

Settings in the Find Dialog
The settings in the Find dialog make it easy to find specific records based on their Scene
and Take values.

The Find dialog contains the following settings:

• Scene and Take: The values you enter in the Scene and Take fields depend on what you
want to do:

• To find all the records in the open database: Leave the Scene and Take fields blank and
click Show All Records.
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• To find all the records for a particular scene or shot: Enter the identifier for that scene
or shot in the Scene field, leave the Take field blank, then click the Find Records
button. (The Take field is disabled unless you select the “Show only exact matches”
checkbox.) For example, if you enter “1” in the Scene field and then click Find Records,
Cinema Tools finds all records associated with scene 1, including the shots 1, 1A, 1B,
1C, and so on. If you enter “1A” in the Scene field, only the records for shot 1A are
found.

• To find the record for a specific scene and take: Select “Show only exact matches,” enter
the scene and take identifiers in the Scene and Take fields, then click Find Records.

See Scene, Shot, and Take Number Details for more information.

• Results: Choose one of the following from the Results pop-up menu:

• Replace Current Found Records: Found records replace the records displayed in the
List View window.

• Add to Current Found Records: Found records are added to the set in the List View
window. The Add to Current Found Records option is useful when you want to find
records for more than one scene, but not for all scenes. For example, to see only the
records for scenes 5 and 6, choose Replace Current Found Records, enter “5” in the
Scene field, then click Find Records. Then, choose Add to Current Found Records,
enter “6” in the Scene field, and click Find Records. Only the records for scenes 5 and
6 appear in the List View window.

• Show only exact matches: Select this checkbox to find a specific record that matches
the Scene and Take field entries.
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Scene, Shot, and Take Number Details
The way Cinema Tools interprets scene numbers can lead to unexpected results when
using the Find dialog.

Cinema Tools looks at a scene number as having up to four parts:

• Prefix: This is an optional set of one or more letters in front of the scene number,
usually used to indicate a new, unique scene added to the script. For example, the
“A” in scene A54C-3. Prefixes don’t always indicate unique scenes, however—the
actual letters used in the prefix control how they affect using the Find dialog. Prefixes
using the letters A, B, C, and D are treated as indicating unique scenes. Prefixes using
any of the other letters are not treated as indicating unique scenes.

• Scene number: This is the first set of numbers. Depending on the prefix, it might be
the entire scene number, although with some prefixes (A,B, C, or D), the prefix becomes
part of the scene number. For example, in the A54C-3 example the scene is “A54.” In
the example E54C-3, the scene is “54.”

• Suffix: This is a set of one or more letters after the scene number, indicating the shot
for the scene. For example, the “C” in scene A54C-3.

• Take number: This is the number after the suffix (shot indicator) that identifies a specific
take. Usually it is preceded by a hyphen (which you don’t enter in the Find dialog).
For example, the “3” in scene A54C-3.

The tricky part is determining whether the prefix indicates a unique scene or not. Prefixes
using letters from A to D are treated as referring to unique scenes. Prefixes using letters
from E to Z are treated as being modifiers to the scene number, but not unique scenes.

For example, if you use the Find dialog to search for scene 54, it will find 54, G54, and
K54 (all are considered to be scene 54) but will not find A54, B54, C54, or D54 (which
are all considered to be different scenes from scene 54).

Suffixes indicate shots that are part of the scene. If you search for scene 54, you will find
all shots for scene 54, such as 54A and 54F, but not B54A, because the prefix makes this
a different scene.

Take numbers are related to specific shots, which in turn are related to specific scenes.
If you search for scene 54, you will find all shots and takes for that scene.

If you enter “54A” in the Find dialog’s Scene field, you will find only those records for
shot A of scene 54; you will not find records for scene 54B.

Entering a number in the Take field will find only shots using that take. For example,
entering “54A” in the Scene field and “3” in the Take field will find only record 54A-3.
Entering “54” in the Scene field (with no shot specified) and “3” in the Take field will
find any records for scene 54 that have a take 3, such as 54A-3 and 54D-3.
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Backing Up, Copying, Renaming, and Locking Databases
As is the case with all important data, it is wise to store backup copies of your Cinema Tools
database files and to lock the database files if you want to make sure they are not modified
or deleted. Do this by using any of the standard desktop methods for copying and locking
files. You can back up your files on your computer’s hard disk or on separate removable
media. If you are going to lock a database file, make sure that the database is closed
before you lock it.

You can also use any standard desktop method to rename a database file. Changing a
database filename (as opposed to a source clip filename) does not affect the content of
the database or any of the database functions.

Important: Changing a source clip filename (by editing it in the Finder) is not
recommended because it breaks the link between the source clip and the database.
However, you can reconnect clips to the database using the Reconnect command.

About the Clip Window
You use the Clip window to play the selected clip, identify the timecode and key number
of a specific frame, view general information about the clip, and process it with the Reverse
Telecine and Conform features.

To open the Clip window
Do one of the following:

µ Choose File > Open Clip (or press Command-O), locate a clip, then click Choose.

µ Click Open Clip in the Detail View window (if a clip is connected to the current record).

µ Click Connect Clip in the Detail View window, then select a clip (if one has not already
been connected to the record).

µ Drag one or more (up to 20 total) clips from a Finder window to the Cinema Tools
application icon. A Clip window opens for each clip.

Note:  If you drag a folder containing clips to the Cinema Tools icon, a new database is
created. See Creating a New Database Using Cinema Tools for more information.
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You can have multiple Clip windows open at one time. They are dynamically added to
and removed from the Window menu as you open and close them.

See Settings in the Clip Window for information about the buttons and settings in the
Clip window.

Settings in the Clip Window
You can play the clip by clicking the Play button (the triangle to the left of the timeline)
or by pressing the Space bar. To play the clip using the Space bar, you must make sure
that an Identify pane text field is not currently selected—you can press the Tab key as
needed or click the Analysis button to deselect the text fields.

Important: Depending on your computer, high-resolution video, such as 2K media, may
not play back smoothly.
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If the clip has audio, you can control the volume by clicking the speaker icon next to the
Play button and then dragging the volume slider. You can also drag the playhead to scroll
through the clip. You can click the left arrow and right arrow buttons at the right side of
the timeline or press your keyboard’s Left Arrow and Right Arrow keys to step through
the clip one frame at a time.

Most of the buttons along the bottom of the window open additional windows or dialogs
and are also available as commands in the Clip menu. The two buttons in the upper-right
corner determine what information is shown on the right side of the window.

Buttons Along the Bottom of the Window
• Set Poster Frame: Assigns the currently displayed frame to the Detail View window’s

thumbnail display.

• Disconnect Clip: The Disconnect Clip button changes depending on whether the current
clip is connected to the database. With a clip connected (as shown above), the button
is labeled Disconnect Clip. Click Disconnect Clip to disconnect the clip from the database.

• Enter in Database: If the current clip is not connected to the database, the Disconnect
Clip button is labeled Enter in Database. Click Enter in Database to open a dialog where
you can connect the clip to an existing record or a new record by entering scene and
take values.

• Reverse Telecine: Opens the Reverse Telecine dialog.

• Conform: Opens the Conform Clip dialog.

• Previous Clip and Next Clip buttons (arrows): The left and right arrows in the lower-right
corner of the Clip window make it easy to switch to the previous or next record (as
currently sorted and displayed in the List View window) that has a clip assigned to it.

Note: These buttons are active only when the current clip is linked to a record in the
current database and that record is part of the List View window’s found set. Additionally,
one of these buttons is dimmed if there isn’t a previous or next clip.
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Buttons in the Upper-Right Corner
• Identify: Click to show the Identify pane, which displays the clip’s information from the

Cinema Tools database it is connected to. You can use the Identify pane to enter film
and timecode information in the database or to get information about the frame that
is currently displayed in the Clip window. Additionally, the settings update to show the
information for each frame as you move through a clip. See Using the Identify Feature
to Calculate Database Information for more information about using the Identify feature.

• Analysis: Click to show the Analysis pane, which displays the clip’s file information. This
information includes both file specifics (name and size, where it is located, and when
it was created) and content specifics (duration, frame rate, frame size, and compression
type used).
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Accessing Information About a Source Clip
The Analysis pane of the Clip window gives you access to specific information about a
source clip.

Click the Analysis
button to display
the Analysis pane.

The Analysis pane displays the full path (location) and name of the file, along with its size
and dates of creation and modification. You can also see the duration of the movie
contained in the clip.

Information is also listed for each track in a clip:

• For video tracks: You see the frame size and frame rate, the compressor used and the
compression quality, the average data rate, and whether it is a self-contained or
reference media file. See The Difference Between Self-Contained and Reference Media
Files for more information.

• For audio tracks: You see the sample rate and the number of channels for up to two
tracks.
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Once you have created and configured your Cinema Tools database, you are ready to
start entering information.

This chapter covers the following:

• About Working with Database Information (p. 85)

• Importing Database Information (p. 86)

• Entering Database Information Manually (p. 91)

• Using the Identify Feature to Calculate Database Information (p. 96)

• Deleting a Database Record (p. 98)

• Choosing a Different Poster Frame for a Clip (p. 98)

• Changing the Default Database Settings (p. 99)

• Changing All Reel or Roll Identifiers (p. 100)

• Verifying and Correcting Edge Code and Timecode Numbers (p. 101)

About Working with Database Information
As described in Deciding How You Should Create the Database, there are two basic
approaches to creating your project database:

• You can generate the database by importing a telecine log, ALE file, or Final Cut Pro
batch capture list.

• You can enter information manually or by dragging a folder of clips to the Cinema Tools
application icon.

See Importing Database Information for information about the different methods you
can use to import information into your database.
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Even if you do generate a database with a telecine log, you may want to make
modifications and additions to the database records at a later time. You can do this by
using the Detail View window or the Clip window. (In the Clip window, you can only
modify existing database records.) See Entering Database Information Manually for more
information. Also see Using the Identify Feature to Calculate Database Information for
details about how to determine various types of database information.

You can modify any information in the database by editing settings in the Detail View
window and the Identify pane of the Clip window. Some of the calculations you make
using the Identify feature update preexisting information, modifying the database
automatically. See the following for more information:

• Deleting a Database Record

• Choosing a Different Poster Frame for a Clip

• Changing the Default Database Settings

• Changing All Reel or Roll Identifiers

Also see Verifying and Correcting Edge Code and Timecode Numbers for details about
how to ensure that you have correct values in your database.

Important: Before you can enter information in the database, you need to have an existing
database. See Creating and Configuring a New Database for details about creating a new,
empty database.

Importing Database Information
You can create a database by importing information from a telecine log or ALE file, a
Final Cut Pro batch capture list, or an existing Cinema Tools database.

Importing Database Information from a Telecine Log or ALE File
You can enter information in the database by importing the telecine log from the
film-to-video transfer.

Cinema Tools currently supports the following telecine logs:

• ATN log files from Aaton

• FLX (Film Log EDL Exchange, commonly known as FLEx) log files from TLC (Time Logic
Controller software)

• Film Transfer List (FTL) log files from Evertz

• Avid Log Exchange (ALE) files (not technically telecine logs, but contain similar
information for your database)
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You can import telecine log files using either Cinema Tools or Final Cut Pro. See Importing
Telecine Logs Using Cinema Tools and Importing Telecine Logs Using Final Cut Pro for
more information.

Assigning Camera Letters
Whether you import the telecine log file using Cinema Tools or Final Cut Pro, you have
the option of having Cinema Tools dynamically assign a camera letter to all records that
are imported. The camera letter uses the first letter of the camera roll value and is
appended to the take entry of each record.

This is useful in those cases where multiple cameras were used for each take, with the
letters making it easy to distinguish between the clips from different cameras. Additionally,
if you set up a multiclip in Final Cut Pro, the camera letters are used to create the different
angles.

Importing Telecine Logs Using Cinema Tools
To import a telecine log into Cinema Tools, you must first have a database open. The
database can be an existing one to which you want to add new records, or it can be a
new one with no records.

To import a telecine log using Cinema Tools
1 Do one of the following:

• Open an existing Cinema Tools database. See Opening an Existing Database for more
information.

• Create a new Cinema Tools database. See Creating and Configuring a New Database
for more information.

2 Import the telecine log file by choosing File > Import > Telecine Log (or pressing
Command-L).

3 In the dialog that appears, select the telecine log or ALE file.
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4 To assign a camera letter to the imported records, select the “Append a camera letter”
checkbox (the camera letter is dynamically determined by the first letter of the camera
roll value, if present, and is appended to the Take entry of each record).

5 Click Open.

The data in the log is entered in the open database, and each new record is displayed in
the List View window.

When Cinema Tools has finished creating the records from a telecine log, it tells you how
many events there were in the log and how many of those events were imported into
the database. Sometimes events in a telecine log refer to edits in which no film was
transferred. For those events, no record is created in the database.

After the records have been imported, you can export a batch capture list from
Cinema Tools that you can import into Final Cut Pro to automate the clip capture process.
See Generating a Batch Capture List from Cinema Tools for more information.

Importing Telecine Logs Using Final Cut Pro
When you import a telecine log using Final Cut Pro, you choose whether you want to
import it into an existing Cinema Tools database or whether a new database should be
created.

When records are added to the selected Cinema Tools database, each record creates an
offline clip in the Final Cut Pro Browser so that the clips can be batch captured. Each of
these clips also has the film-related information contained in the log file added to it.

To import a telecine log using Final Cut Pro
1 Create a new project or open an existing project.

This project will contain the offline clips created when the telecine log file is imported.

2 Select the project in the Browser.

3 Choose File > Import > Cinema Tools Telecine Log.
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The Import a Cinema Tools Telecine Log dialog appears.

Select the telecine
log file to import.

Choose to either
create a new database
or import the file into
an existing database.

Choose a camera letter
to append to the 
imported takes
(if needed).

Lists the currently 
selected database.

4 Use the top half of the dialog to select the telecine log file to import.

5 To assign a camera letter to the imported records, select the “Append a camera letter”
checkbox (the camera letter is dynamically determined by the first letter of the camera
roll value, if present, and is appended to the Take entry of each record).

6 Do one of the following:

• To create a new Cinema Tools database to import the telecine log file into: Click New
Database. This opens a new dialog where you can enter a name and location for the
database, as well as configure its default settings. See Settings in the New Database
Dialog for information about these settings. Click Save when finished.

• To open a dialog where you can select an existing database to import the telecine log file
records into: Click Choose Database. Click Open when finished.

The selected database, whether new or previously existing, is listed in the Database field
of the Import a Cinema Tools Telecine Log dialog.
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7 Click Open to import the selected telecine log file into the selected Cinema Tools database.

After the records have been imported and the offline clips have been added to the
Browser, you can use Final Cut Pro to batch capture the clips. See the Final Cut Pro
documentation for information about batch capturing clips.

Importing Database Information from a Batch Capture List
You may want to create database records by importing a Final Cut Pro batch capture list
if:

• You don’t have a telecine log or Avid Log Exchange (ALE) file

• You have already batch captured the clips you want into Final Cut Pro and you want
database records to be created for those source clips instead of the takes listed in your
telecine log

Creating database records from a Final Cut Pro batch capture list is not ideal because you
lose the advantages of using a telecine log or ALE file to build your database. For example,
a Final Cut Pro batch capture list does not contain the key number and camera or lab roll
information that would be imported from a telecine log. See Advantages of Using a
Telecine Log or ALE File for more information.

Tip: In most cases, instead of exporting a Final Cut Pro batch capture list and importing
it into a Cinema Tools database, you should use the Final Cut Pro Synchronize with
Cinema Tools feature. See Synchronizing Final Cut Pro Clips with Cinema Tools for more
information.

To import database information from a Final Cut Pro batch capture list
1 Make sure that a Cinema Tools database is open.

2 In Cinema Tools, choose File > Import > Final Cut Pro Batch List.

3 In the dialog that appears, select the batch capture list you exported from Final Cut Pro.

4 Click Open to import the batch capture list.

The data in the batch capture list is used to create database records.

Note: The source clips are not yet connected to database records. You still need to use
the Connect Clips command to connect them. See Using the Connect Clips Command
for more information.

5 In each database record, enter the edge code number information and film roll identifier.
(These items are required to create a cut list or change list.)

Note: Because a Final Cut Pro batch capture list includes everything in the Final Cut Pro
Browser, it may include clips or sequences that you don’t want. For this reason, you should
delete any database records you don’t need. See Deleting a Database Record for more
information.
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Importing an Existing Cinema Tools Database
One Cinema Tools database can be imported into another Cinema Tools database. There
are a few reasons why you might want to do this:

• You may want to create separate databases for organization and archiving purposes
and then bring them all together in a master database. For example, you might want
to create separate databases for your dailies. If you want to manage your dailies by
creating a date-named database for each of the dailies, you can import the telecine
log for that daily session, export a batch capture list, capture the clips, and use the
Cinema Tools Connect Clips command to connect all the clips to that date-named
database file. Then, you can import that database file into a master database that
contains all of the daily databases.

• You may need to correct a database that has incorrect project defaults. To do this, you
create a new, empty database with the correct defaults and then import your original
database file into the new one.

To import one database file into another
1 Open the database into which you want to import another database file by choosing

Database > Open Database (or pressing Command-Shift-O) and then selecting the
database in the dialog.

2 Choose File > Import > Database.

3 In the dialog that appears, select the database you want to import.

Entering Database Information Manually
You can use the Detail View window to manually edit database records. Before you can
edit information in a database, you need to create database records.

Note: If a database record has already been created for a clip, you can also use the Identify
pane of the Clip window to enter information. See Using the Identify Feature to Calculate
Database Information for details.
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Understanding the Relationship Between Scenes, Shots, and Takes
To enter scene, shot, and take information in the database, you first need to know how
scenes, shots, and takes are understood by the database.

A motion picture production is composed of a series of scenes, and each scene is typically
composed of a number of shots or angles. A shot is a continuous film recording that
does not have any cuts. In shooting the film, there may be a number of takes for each
shot, so a take is a version of a shot. There can be many shots for each scene. The diagram
below shows an example of the relationship between scenes, shots, and takes as they
might exist in a Cinema Tools database.

Scene 1 Shot 1A

Shot 1

Shot 1B

Take 1

Take 2

Take 4

Take 2

Take 3

Take 5

Slate 1-1

Slate 1-2

Slate 1-4

Slate 1A-2

Slate 1A-3

Slate 1B-5

Creating a New Database Record
You must create database records if you are manually entering database information.

To create a new, empty database record
1 Do one of the following:

• Choose Database > New Record (or press Command-N).

• Click New Record in the Detail View window.

2 In the dialog that appears, either enter identifiers for the scene and take or leave these
fields blank, then click OK. See Using Scene, Shot, and Take Identifiers for more information.
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Note: You don’t have to enter anything in the Scene and Take fields in order to use
Cinema Tools to match your digital edits back to your original camera negative. You can
leave these fields blank or enter their values later. Also keep in mind that the scene and
take entries are used to create the clip names if you export a batch capture list. See
Generating a Batch Capture List from Cinema Tools for more information.

The Detail View window appears after you click OK.

To create new database records with connected clips
Do one of the following:

µ Choose File > Import > Files, choose one or more media files to import in the dialog that
appears, then click Open.

µ Choose File > Import > Folders, choose one or more folders that contain media files you
want to create database records from, then click Open.

µ Drag one or more media files or folders from a Finder window to the Cinema Tools List
View window.

Note: You cannot drag a mix of media files and folders to the List View window.

A dialog appears that tells how many new records were created. Each record includes
the video reel, video timecode, clip duration, and timecode rate settings from its connected
clip.

Note: New records are not created for any clips that are already connected to other
records in this database.
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Using Scene, Shot, and Take Identifiers
An identifier can be any combination of numbers and letters (up to 15 characters).

• Take identifier: If the source clip associated with a database record contains more than
one take, you can think of the take identifier as a source subclip identifier. If the source
clip associated with a database record contains just one take, you can think of the
take identifier as a source clip identifier.

• Scene identifier: The identifier you enter in the Scene field actually identifies both the
scene and the shot (camera position) for the clip. For the Scene identifier, most people
enter the number or letter combination that appears in the Scene field on the slate.
The typical method for identifying scenes and shots is to use a number for the scene
and add a letter to specify the shot in the scene. So when a slate says “Scene 12B,” it
is referring to shot B in scene 12. You see this reflected in the Detail View window;
the first number you enter in the Scene field appears next to the word “Scene” in the
Detail View window. Next to the word “Shot,” both the number and the letter appear.

For example, if you enter “1D” in the Scene field, you see the following at the top-left
corner of the Detail View window:

• “1” next to the word “Scene”

• “1D” next to the word “Shot”

Tip: In the Scene field, you can enter a letter (A through D) before the first number,
and the letter will be part of the scene identifier. Adding a letter to the beginning of
a scene identifier is a useful naming scheme when you need to add a scene in the
middle of an existing series of scenes. For example, between scene 1 and scene 2 you
could add a scene named A2, so the new order would be scene 1, scene A2, scene 2,
scene 3, and so on. Adding other letters (E through Z) does not add a new scene. For
example, scene G2 is the same as scene 2. See Scene, Shot, and Take Number Details
for more information.

About the Descriptive Scene and Shot Data
All the shots for a scene are related to that scene, and all the source clips for a shot are
related to that shot. Because the database remembers these relationships, you only need
to enter the descriptive data for each scene and shot once.

When you enter or change the descriptive data for a scene, that same data appears for
all the other shots associated with that scene, both in existing database records and any
records you create later that have the same scene identifier. Similarly, any descriptive
data you enter for a shot appears in existing database records with the same shot identifier.
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In the example below, all records for scene A54 will have the same descriptive text
(“Outside”) and page numbers (146 to 167). All takes for this shot (A54J) will have the
same descriptive text (“Left” in this example) and page numbers (148 to 155). Each take
for that shot will also have a unique Take Notes entry.

Entering Information in a Database Record
Once you have created a database record, you can enter the information about its clip.

To enter information in a database record
1 Make sure the record is displayed in the Detail View window. (If necessary, click the record

in the List View window to open it in the Detail View window.)

See Finding and Opening Database Records for more information.

2 Enter information and settings in the Detail View window.

Settings in the Detail View Window describes all the settings and specifies which ones
are required if you plan to use the database to generate cut lists or change lists.

You can press the Tab key to navigate from one field or setting to another.

Tip: When you connect a clip to a database record and the record does not yet contain
the clip timecode, reel, and timecode duration, Cinema Tools looks for this information
in the clip file and automatically enters it in the database record.
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If you know the edge code or timecode number for another frame in a clip, the Identify
feature can help you determine the correct timecode or edge code number for the first
frame of a clip. See Using the Identify Feature to Calculate Database Information for
details.

3 Click Save.

Until you save, data in the Detail View window is not entered in the database. You can
choose Database > Revert Record (or press Command-R) to revert to the last saved version
of the record.

Using the Identify Feature to Calculate Database Information
You can use the Clip window’s Identify feature to determine the key number, ink number,
or timecode values for clips in the database. The database requires these values for the
first frame of the clip, but you might not have them if you aren’t creating database records
from a telecine log or if your clips lack window burn.

Note the following requirements for using the Identify feature to determine or verify edge
code or timecode values:

• You need to know a key number, ink number, or timecode value for at least one frame
in the clip.

• The clip needs to have a database record.

• The key number-to-timecode relationship must be continuous. See Is Your Edge Code
Number-to-Timecode Relationship Continuous or Noncontinuous? for more information.

Keep in mind that with the Identify feature, the Key, Ink, Video Timecode, and Sound
Timecode fields should always reflect the values of the frame currently displayed in the Clip
window, whereas in the Detail View window these fields are associated with the first frame
of the clip. The Identify feature will, however, calculate and enter the first-frame values
you see in the Detail View window.

Calculating Edge Code and Timecode Numbers
If you know the edge code (key number or ink number) and timecode values for any
frame in a clip, you can use the Identify feature to determine these values for the first
frame of the clip, and that information is automatically entered in the database.

This feature is especially useful if you are working with video that does not have window
burn, because without window burn you have to track the timecode and edge code by
physically marking one frame in each clip. If the frame that is marked is not the very first
frame of the clip, the Identify feature can calculate what the values are for the first frame,
and those values are automatically entered in the database.
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To enter the edge code and timecode values in the database
1 If it isn’t already open, open the clip in the Clip window in one of the following ways:

• Choose File > Open Clip (or press Command-O) and use the dialog to select the clip.

• Click Open Clip in the Detail View window of the clip’s database record.

2 Click Identify in the Clip window to display the settings for the current frame.

3 Locate the marked frame in the clip playback area.

Tip: Use the arrow keys on your keyboard to move forward and backward frame by frame.

The Identify settings update to show the information for each frame as you move through
a clip, so you can locate the marked frame.

4 Enter the edge code and timecode values for the marked frame (the frame showing in
the Clip window) in the appropriate fields.

Note: You may be using ink numbers instead of key numbers, or vice versa. If so, you can
leave the field you aren’t using blank.

Enter the key number
or ink number for
the marked frame.

Enter the video
timecode value for
the marked frame.

Note: If you decide you want to reset the values to what they were when you opened
the clip in the window, click Revert.

5 When identifying a 3-perf 35mm clip, you must also choose the offset (3-perf•1, 3-perf•2,
or 3-perf•3) from the Film Std pop-up menu.

Note: You should not need to change the Film Std setting if you are using any of the
other film formats.

6 Click Save.

The clip’s database record is immediately updated with the values for the first frame of
the clip. Additionally, the clip’s duration is calculated and entered.
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About Modifying Data with the Identify Feature
You can use the Identify feature for a clip only if a database record has been created for
that clip. The Clip window’s Identify pane includes fields and pop-up menus for settings
that also appear in the Detail View window. You can modify these settings with the
Identify feature, but keep the following important facts in mind:

• The Identify pane’s Key, Ink, Video Timecode, and Sound Timecode fields should always
reflect the values of the frame currently displayed in the Clip window, whereas in the
Detail View window these fields are associated with the first frame of the clip. Therefore,
what you see or enter in the Identify pane of the Clip window could be different from
what you see or enter in the Detail View window. See Using the Identify Feature to
Calculate Database Information for details.

• The Identify feature can track the key numbers only if the key number-to-timecode
relationship is continuous, as it is with most camera-roll transfers. See Is Your Edge
Code Number-to-Timecode Relationship Continuous or Noncontinuous? for more
information.

If you changed the values in the window and want to go back to previous values, click
Revert instead of Save. After you click Save, the database record is updated, and these
changes are reflected in the Detail View window.

Deleting a Database Record
You may find that you have records that you no longer need. You can delete them from
a database.

Note: Be careful when you delete a database record, because there is no way to undo
this command.

To delete a database record
1 Open the database record in the Detail View window, or select it in the List View window.

2 Choose Database > Delete Record (or press Command-Delete).

Note: When you delete a database record that is connected to a source media file, you
don’t delete the file from your hard disk. You delete only the database record.

Choosing a Different Poster Frame for a Clip
By default, when you connect a clip to a database record, a small picture of the first frame
of the clip appears in the Detail View window. This picture is called the poster frame. You
can choose to display a different frame of the clip if the first frame of the clip is hard to
recognize, as with black frames.
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The default clip poster frame does not appear in the Detail View window until after:

• The clip has been connected to a database record

• The clip has been opened in the Clip window

To choose a new poster frame for a clip
1 If it isn’t already open, open the clip in the Clip window in one of the following ways:

• Choose File > Open Clip (or press Command-O) and use the dialog to select the clip.

• Click Open Clip in the Detail View window of the clip’s database record.

2 In the clip playback area, locate the frame you want to use as the poster frame.

Tip: Use the arrow keys on your keyboard to move forward and backward frame by frame.

You can drag the 
playhead to locate and 
display the frame you 
want to use as the clip 
poster frame.

Click the Set Poster Frame 
button to have the 
current frame appear as 
the thumbnail image in 
the Detail View window.

3 Click Set Poster Frame when the clip playback area displays the frame you want to use.

The new poster frame appears in the Detail View window of the clip.

Note: Regardless of the poster frame you set, the Clip window always opens to the first
frame of the clip.

Changing the Default Database Settings
Although you cannot directly change a database’s default settings, you can get the same
effect by creating a new database with the proper settings and importing the original
database into it.
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To change the default settings for a database
µ Create a new database with the default settings you want, then import your original

database into the new one. See Importing an Existing Cinema Tools Database for more
information.

Changing All Reel or Roll Identifiers
There may be times when you want to change all occurrences of a reel or roll identifier
in a database. For example, you might need to change a reel identifier that is not
EDL-compatible to one that is EDL-compatible. Or, you might need to change the reel or
roll identifier in a database to match identifiers that are actually used in an EDL or to
correct situations where reel identifiers are not exact matches, such as “0001” and “001.”

Note: If you will be exporting a batch capture list from the database, it’s best to make
the reel or roll identifier changes before exporting the list.

To change all instances of a reel or roll name in a database
1 Click the Show All button in the List View window to make sure that all of the database

records are listed in the List View window.

2 Choose Database > Change Reel.

3 Make the following settings in the Change Reel dialog:

• Choose the type of roll or reel.

• In the From field, enter the identifier that you want to change.

• In the To field, enter the new identifier.

4 Click OK.

Choose the type
of reel or roll.

Enter the old
and new identifiers.

After you click OK, all records displayed in the List View window are searched, and each
time the roll or reel identifier that you want to change is found, it is replaced by the new
identifier.
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Verifying and Correcting Edge Code and Timecode Numbers
Assuming you know the timecode, key number, or ink number values for a frame in a
clip—either by a marked frame or by window burn—you can use the Identify feature to
verify these values for the clip. Verification is important because your cut list or change
list is only as accurate as these values.

Verifying values with the Identify feature is especially useful when:

• You find a discrepancy between the timecode and ink numbers or key numbers in the
window burn and those values in the Cinema Tools database or in Final Cut Pro

• You entered the values manually and need to double-check your data entry work

Important: The Identify feature can track edge code numbers only if the edge code
number-to-timecode relationship is continuous, as it is with most camera-roll transfers.
See Is Your Edge Code Number-to-Timecode Relationship Continuous or Noncontinuous?
for more information. If the edge code number-to-timecode relationship is noncontinuous,
you can verify and correct the edge code number and timecode values for the source
clips by visually checking these values against the window burn and, if necessary, manually
updating the edge code number and timecode values in Cinema Tools and the timecode
values in Final Cut Pro.

To verify and correct the edge code and timecode values entered for a clip
1 If it isn’t already open, open the clip in the Clip window in one of the following ways:

• Choose File > Open Clip (or press Command-O) and use the dialog to select the clip.

• Click Open Clip in the Detail View window of the clip’s database record.
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2 In the clip playback area, locate a frame near the beginning of the clip for which you
know the correct edge code number or timecode value. This is easy if your video has
window burn.

Click Identify to show the 
current frame’s settings.

Burned-in 
timecode value

Burned-in 
edge code value

3 If necessary, click Identify to show the record’s settings.

4 Look at the Key, Ink, and Video Timecode fields in the Identify pane to see if the numbers
match the window burn of the frame in the Clip window. (You may be using ink numbers
instead of key numbers, or vice versa. If so, you can leave the field you aren’t using blank.)

5 If any of the Key, Ink, or Video Timecode fields are incorrect, enter the correct numbers
in the fields.

6 In the clip playback area, locate a frame near the end of the clip and repeat steps 4 and
5.

• If the edge code number and timecode values are correct at the beginning of the clip, but
not at the end of the clip: Frames may have been dropped during capture, in which case
you should recapture the clip. See Avoiding Dropped Frames for more information. It
might also be because the clip doesn’t have a continuous edge code
number-to-timecode relationship, in which case the Identify feature cannot help you
confirm the edge code number and timecode values because it works by a calculation
based on a continuous edge code number-to-timecode relationship.

• If the timecode value is incorrect: There is a good chance that the timecode is wrong in
Final Cut Pro. Open the same frame in Final Cut Pro and see if the timecode value is
correct. If it isn’t, make sure to correct the timecode in Final Cut Pro. You can do this
by using the Modify Timecode dialog. See the Final Cut Pro documentation for more
information about how to modify the timecode.
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If you used serial device control, the timecode mismatch may have happened because
you didn’t set the appropriate timecode offset in Final Cut Pro for the specific deck you
used. You need to make this setting once per deck, per computer. For more information,
see the section about calibrating the timecode signal in the Final Cut Pro documentation.

7 If you entered new numbers in the fields, click Save. Otherwise, if the values were already
correct, close the window.
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Establishing the relationships between the source clips and the Cinema Tools database
is key to a successful project.

This chapter covers the following:

• About Source Clips and the Database (p. 105)

• Preparing to Capture (p. 105)

• Generating a Batch Capture List from Cinema Tools (p. 109)

• Connecting Source Clips to the Database (p. 115)

• Fixing Broken Clip-to-Database Links (p. 120)

About Source Clips and the Database
Once you have created the project database, it’s time to capture your source clips with
Final Cut Pro. (Source clips are the media files you start with when you begin editing.)

After capturing, you establish connections between the database records and the source
clips.

Tip: Use the scenarios in Cinema Tools Workflows to guide you in determining the basic
steps you need to take to capture your source clips and connect them to the database.
The steps you need to take, and the order of those steps, differ depending on factors that
are summarized in the workflow examples. For example, in some situations it is not
necessary to connect the clips to the database.

Preparing to Capture
Detailed information about capturing clips is provided in the Final Cut Pro documentation.
Before you capture, you need to pay attention to a few factors that can affect your project:

• Avoiding dropped frames during the capture process

• How your hardware is set up for video capture

• Considerations regarding the capture of audio
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• How to prepare for batch capturing (if you have a video deck with device control)

• Considerations for capturing source clips individually (if you do not have device control)

A Caution About Using OffineRT Media with Cinema Tools
When you capture media with the OfflineRT Easy Setup in Final Cut Pro, your captured
media is highly compressed, allowing you to capture more source clips to your hard
disk—approximately 2 hours of video per gigabyte (GB) of hard disk space. However,
it can be very difficult, if not impossible, to read the key number and timecode
information in the window burn after capturing with OfflineRT compression. You typically
need to see the window burn in order to verify and correct the key number and timecode
values and to use the Cinema Tools Reverse Telecine feature. For this reason, OfflineRT
may not be ideal for Cinema Tools users.

For more information about OfflineRT, see the Final Cut Pro documentation.

Avoiding Dropped Frames
If computer performance is impeded or if your scratch disk is not fast enough, frames
may be dropped during the capture process, meaning one or more individual frames are
not captured at all. When a frame is dropped during capture, the frame before it is
repeated. As a result, a frame you see while editing may not be the frame you see when
the film is cut. Dropped frames can cause timecode errors, which can result in an incorrect
cut list and interfere with the reverse telecine process. You can prevent this problem in
Final Cut Pro by setting the program to stop capturing and to notify you when a frame
is dropped.

To set Final Cut Pro to stop capturing when frames are dropped
1 In Final Cut Pro, choose Final Cut Pro > User Preferences.

2 In the General tab, make sure “Abort capture on dropped frames” is selected.

When this option is selected, a message appears when frames are dropped during capture
and the capture is stopped.

If dropped frames occur, first make sure that other programs are not open, so that
performance is not slowed. Then, recapture the source clip.

If you attempt to use the Reverse Telecine feature for a source clip that contains dropped
frames, a warning appears.
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Setting Up Your Hardware to Capture Accurate Timecode
The ability of Final Cut Pro to capture frame-accurate timecode for each clip is also
dependent upon the proper setup of your capture hardware. When using DV decks, this
is easy. In Final Cut Pro 3 and later, capturing video with a DV deck using FireWire for
both device control and video and audio input results in 100 percent accurate timecode.
If you are instead capturing from a deck using serial device control—for example, a Digital
Betacam or Beta SP deck—there are a couple of important steps you need to take during
setup to ensure timecode accuracy.

What Is Device Control?
Device control makes it possible for Final Cut Pro to control your video camera or video
deck. If your video camera or deck uses a protocol supported by Final Cut Pro,
Final Cut Pro can exchange timecode and device control data with the camera or deck.
If you have device control, you can cue and capture several source clips at once (called
batch capturing). If you do not have device control, you need to capture source clips
individually. See the Final Cut Pro documentation for supported device control protocols.

Before you capture from a deck using serial device control, you need to take these steps
to ensure all-important timecode accuracy:

• Genlock your deck with your video capture interface.

• Calibrate the timecode offset.

Genlocking the Deck and Video Capture Interface
In addition to connecting the serial device control cable from your deck to your computer
(using a recommended serial interface adapter) and connecting the necessary video and
audio connectors, you must also make sure that your deck is genlocked with your video
capture interface. Genlocking refers to locking two video devices together using a
blackburst generator.

If your deck and video capture device support genlock (also called external sync), connect
them to a common signal generator (usually a blackburst generator, which outputs a
continuous black video signal). This is done using the genlock connectors found on your
video deck and video capture interface (these may also be labeled reference video).
Genlocking your deck with your video capture interface synchronizes these devices,
ensuring timecode accuracy.

Important: If you are capturing from a deck using serial device control and your video
capture interface cannot be genlocked with the deck, the accuracy of the timecode
captured with your clips cannot be guaranteed.
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Calibrating the Timecode Offset
Even when your deck and video capture interface are genlocked together, if you are
going to use serial device control instead of FireWire device control to capture, it is still
essential to calibrate the capture offset (found in the Final Cut Pro Device Control Presets
tab) prior to capture. To use serial device control, you need to make this setting once per
deck, per computer. For more information, see the section about calibrating the timecode
signal in the Final Cut Pro documentation.

Considerations Before Capturing Audio
Before you capture your audio with Final Cut Pro, you need to take into account the
following:

• If you have an audio deck that can adjust the audio speed to sync to your editing frame
rate when necessary: Use the audio deck to do this before you capture the audio into
your computer. See Determining How to Prepare Source Clips for Editing to find out
how you might need to adjust your audio speed.

Note: If you don’t have an audio deck, there are other ways you can adjust the audio
speed after capturing. See Making Adjustments to Audio Speed for more information.

• If you will be editing at 24 fps (the same frame rate at which the film was recorded): Capture
the audio at the speed at which it was recorded.

• Before capturing an audio clip that you plan to sync to a video clip: Make sure your
device-controllable audio deck is genlocked to a video capture interface installed in
your computer. (See the Final Cut Pro documentation for more information about
genlocking your audio deck to a video capture interface.) Also, in Final Cut Pro, select
the “Sync audio capture to video source if present” option in the General tab of the
User Preferences window.

Considerations Before Capturing Clips Individually
Clips can also be captured individually with Final Cut Pro, without using device control.
(See the Final Cut Pro documentation for details about capturing clips individually.)

When you capture your clips, remember these points:

• If you don’t use device control, Final Cut Pro cannot receive the correct timecode for
the clips during capture. This means you need to correct the timecode for each and
every source clip in Final Cut Pro. To do this, open each clip in the Viewer and note the
timecode value that appears in the window burn of the first frame of the clip. Then
choose Modify > Timecode and enter the value from the window burn in the Source
field, selecting the Drop Frame checkbox if appropriate. Finally, make sure to update
the key number information for the clip in the Cinema Tools database by using the
Identify feature. See Verifying and Correcting Edge Code and Timecode Numbers for
more information.
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• You don’t want to drop any frames while capturing because that can result in an
incorrect cut list and will interfere with the reverse telecine process.

• If your video has non-drop frame timecode, make sure that Non-Drop Frame is chosen
from the Default Timecode pop-up menu in the Final Cut Pro Device Control Presets
tab. A quick way to do this is to choose DV-NDF in the Easy Setup dialog in Final Cut Pro.
(Refer to the Final Cut Pro documentation for more details about using Easy Setups.)

• The naming of the source clips is important because you will need to connect clips to
database records. To make the connection process as smooth as possible, use an easy
naming scheme with the scene and take identifiers. For example, the clip for scene 33,
take 1 could be named “33-1.” Hyphens are fine in a clip name, but do not use a slash
(/) or colon (:).

Generating a Batch Capture List from Cinema Tools
If you have a video deck or camera with device control, such as a DV-format camera with
FireWire or a high-end video deck or camera, batch capturing is the most convenient
way to bring media into your computer. With batch capture, you connect a video deck
or camera to your computer and, based on a Cinema Tools–generated list of the source
clips, Final Cut Pro copies all of the source clips from the tape to your computer. In other
words, when you use batch capture, you do not need to use your video deck or camera
to manually locate each source clip before you capture it with Final Cut Pro.

To set up a batch capture, you specify the clips you want to capture (after your
Cinema Tools database has been created) and Cinema Tools generates a list based on
the information in the database. After you import this batch capture list into Final Cut Pro,
those source clips appear in the Browser as offline clips, meaning they are logged and
ready to be batch captured. When your source media is on multiple tapes, you can still
use batch capture. When you begin the batch capture, you see a list of all the video reels
needed. When all the clips from one reel are captured, you are prompted to select another
reel.
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Advantages of Using a Cinema Tools Batch Capture List
Using a Cinema Tools batch capture list provides several benefits:

• Time savings: You can let Cinema Tools generate your batch capture list for you instead
of creating it manually yourself.

• Accuracy: The batch capture list captures source clips that match your database
records.

• Convenient source clip filenaming: When you batch capture from a database batch
capture list, your source clip files are named with a naming scheme based on the
scene and take identifiers. For example, scene 10, take 1 would be given the filename
“10-1.”

• Automatic linking between source clips and the database: With the Connect Clips
command, you can automatically link your captured source clips to the appropriate
database records.

Note: You do not have to create a batch capture list from a Cinema Tools database. An
alternative is to first batch capture your clips with Final Cut Pro and then generate a
database from your Final Cut Pro batch capture list. However, this is not ideal because
you lose some of the advantages of building your database from a telecine log or Avid
Log Exchange (ALE) file. Most importantly, the key number and camera roll information
is not added to each database record, so you have to enter that information manually.
See Importing Database Information from a Batch Capture List for more information.

About Standard and XML Batch Capture List Differences
You have the option with Cinema Tools of creating either a standard or XML-based batch
capture list. In both cases, you can choose whether to include all records in the found
set or just those records that have valid video reel, timecode start, and timecode duration
values and are not already connected to a clip.

• Standard batch capture lists: These are plain text files that contain reel, clip name (based
on the shot and take fields), comment, and timecode information. You choose whether
to output a video or audio list.

• XML batch capture lists: These lists contain the same information as the standard lists,
including both the audio and video information, plus all of the film information such
as edge code values, film type, and telecine speed. This additional information is added
to each clip’s entry in the Final Cut Pro Browser, where it can be displayed.

Tip: When set to include all records in the current found set, exported XML batch
capture lists can actually be thought of as an XML representation of the database for
those records. Your facility may find additional uses for these lists beyond capturing
clips.
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How Cinema Tools Names Batch-Captured Clips
If you capture clips with a batch capture list, and if there is both a scene and a take
identifier in the database record, Cinema Tools creates a clip name using the scene and
take identifiers, separated by a hyphen. For example, the clip for scene 10, take 1 would
be named “10-1.” If there are no scene and take identifiers, Cinema Tools creates a clip
name based on the video reel and timecode. For example, a clip from reel 001 that
begins at timecode value 01:35:30:15 would be named “001-01.35.30.15.”

When naming the clips, Cinema Tools makes sure that none of the clips have the same
name. For example, clips from different cameras may have had the same scene and take
identifiers. When this happens, the clip names are distinguished by adding the roll or
reel identifiers to clips after the first one. For example, the clips for scene 4, take 4 in
roll 1A and roll 1B would be named “4-4” and “4-4B,” respectively. If there were no roll
or reel identifiers found, those clips would be named “4-4” and “4-4_1.”

Note: Before exporting a batch capture list from Cinema Tools, it’s best to sort by Slate
in the List View window to see if any clips have the same Slate column descriptions. If
any clips have exactly the same information in the Slate column, modify the Scene or
Take fields in those database records so that they are not the same. This helps ensure
that none of the clips in the batch capture list have the same name.

Important: In order to make the clip-connecting process as automated as possible, do
not change the filenames that Cinema Tools creates for the source clips when they are
captured.

Using Standard Batch Capture Lists
Exporting standard batch capture lists and importing them into Final Cut Pro is a
straightforward process.

To export a standard batch capture list from Cinema Tools
1 Make sure that the List View window displays the database records of the clips you want

to capture.
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To display all of the records in the database, click Show All in the List View window.

In the List View window, 
display the database 
records for which you 
want to capture clips.

Important: The batch capture list will include only database records that have video reel,
timecode start, and timecode duration values. Also, any database records that are already
connected to a clip do not appear in the batch capture list.

2 Choose File > Export > Batch Capture.

3 In the Export Batch Capture dialog, choose what you want to capture, then click OK:

• Final Cut Pro Video: Choose this option to capture all video and audio contained in the
source clips. When you choose this option, the batch log includes the video reel and
video timecode information entered in each clip’s database record.

• Final Cut Pro Audio: Choose this option to capture only the audio from the source clips.
When you choose this option, the batch log includes the sound roll and audio timecode
information entered in each clip’s database record.

4 In the dialog that appears, select a location and enter a name for the batch capture list.

5 Do one of the following:

• To include all records in the batch file: Click “Export all records in the current found set.”
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• To include only those records that have video reel, timecode start, and timecode duration
values and are not already connected to a clip: Click “Export only eligible records in the
current found set.”

6 Click Save.

A plain text batch capture list is created and saved to the designated location.

Tip: You can edit the batch capture list in a text editor. However, make sure that you do
not delete or overwrite the Tab characters that separate the fields in each line. You can
delete lines for clips you don’t want to capture.

To import a standard Cinema Tools batch capture list into Final Cut Pro
1 Either open an existing project or create a new project in Final Cut Pro.

2 In Final Cut Pro, choose File > Import > Batch List at [current fps], where “current fps” is
the sequence preset frame rate.

You can change the sequence preset frame rate by choosing Audio/Video Settings from
the Final Cut Pro menu.

3 In the dialog that appears, select the batch capture list you exported from Cinema Tools,
then click Choose.

The clips appear in the Browser as offline clips, ready to be batch captured. See the
Final Cut Pro documentation for details about batch capturing.

Important: If your video has non-drop frame timecode, make sure that Non-Drop Frame
is chosen from the Default Timecode pop-up menu of the preset you choose in the
Final Cut Pro Device Control Presets tab (located in the Audio/Video Settings window)
before you begin capturing.

Using XML Batch Capture Lists
Exporting XML batch capture lists from Cinema Tools and importing them into Final Cut Pro
is similar to the process used for standard batch capture lists.

To export an XML batch capture list from Cinema Tools
1 Make sure that the List View window displays the database records of the clips you want

to capture.

To display all of the records in the database, click Show All in the List View window.

2 Choose File > Export > XML Batch List.
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3 In the dialog that appears, select a location and enter a name for the batch capture list.

4 Do one of the following:

• To include all records in the XML file: Click “Export all records in the current found set.”

• To include only those records that have video reel, timecode start, and timecode duration
values and are not already connected to a clip: Click “Export only eligible records in the
current found set.”

5 Click Save.

An XML batch capture list is created and saved to the designated location.

To import an XML Cinema Tools batch capture list into Final Cut Pro
1 In Final Cut Pro, choose File > Import > XML.

2 In the dialog that appears, select the XML batch capture list you exported from
Cinema Tools, then click Choose.

The Import XML dialog appears.

3 Choose the project to add the batch list clips to using the Destination pop-up menu.

You can also create a new project using this pop-up menu.

4 Choose the default sequence preset to use from the Default pop-up menu.

5 When importing XML files exported from Cinema Tools, you can leave all of the checkboxes
unselected.

6 Click OK to import the XML file.

The clips appear in the Browser as offline clips, ready to be batch captured. See the
Final Cut Pro documentation for details about batch capturing.

Additionally, you can see the film details, such as keycode information and telecine film
speed (TK speed), in the Browser. See Showing Film-Related Information in the Browser
for information about adding film columns to the Browser.
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Connecting Source Clips to the Database
Because source clips and database records can be created by different means at different
times, you may need to establish the link between a source clip and its record after they
both exist. This process is called connecting a clip to a record. How you connect clips to
the database depends on how you captured your clips.

• If you created your database by dragging a folder of clips to the Cinema Tools application
icon: All of the records were automatically connected to the clips. You can use the
Connect Clips command to connect the records to a different set of clips later if
necessary, or to reconnect the source clips if they are moved to a different disk.

• If you captured your source clips by using a batch capture list: Use the Connect Clips
command to automatically connect all your source clips to the database. See Using
the Connect Clips Command for more information.

• If you did not capture your source clips by using a batch capture list: You need to
individually connect source clips to database records by using either the Detail View
window or the Clip window. These two methods are equally easy and accessible, so
the one you choose may depend on which window happens to be open. The Clip
window is most convenient if you’re interested in selecting a new poster frame for
each clip as you go, or if you want to use the Conform or Reverse Telecine feature on
each clip immediately after you connect it to the database.

Keep in mind these basic rules for connecting clips:

• Each database record can have a maximum of one clip connected to it, and each clip
can be connected to a maximum of one database record in the same database. In other
words, you can’t have two clips connected to one database record, and you can’t have
one clip connected to two different records in the same database. (However, a clip can
be connected to records in multiple databases. For example, you could have a clip
connected to a record in a master database and to a record in a second, smaller database
that represents an edited sequence.) See Synchronizing a Set of Selected Clips to Create
a New Database for more information. Also, a database record does not have to have
a clip connected to it.

• You can connect source clips to database records any time between the time you
capture the clips and the time you export lists.

• If you are working with camera-roll transfer video that has a continuous key
number-to-timecode relationship, you can use the timecode-based method of film list
generation so you don’t have to connect your source clips to database records. See A
Potential Database Shortcut for Camera-Roll Transfers and How Cinema Tools Creates
Film Lists for more information.
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Avoid Moving or Renaming Your Source Clips in the Finder
Once a source clip is connected to the database, that link must be intact when you
generate any film lists. If the link is broken, the lists will be incomplete. A clip-to-database
link is broken if:

• The source clip filename is changed

• The source clip file is moved or deleted

See Fixing Broken Clip-to-Database Links for information about fixing broken links.

Using the Connect Clips Command
You can use the Connect Clips command to connect source clips to the database in a
variety of situations:

• If you captured clips using a batch capture list: The Connect Clips command can connect
your captured source clip files to the appropriate database records. This process requires
that the reel name and the timecode of the captured clips match those of the database
entries.

• If you moved your connected clips to a new location: Once you have clips connected to
your database, moving the clips to a different folder or disk causes the clips to be
disconnected. You can use the Connect Clips command to reconnect the records to
the relocated clips.

• If you renamed one or more of your clips: Once you have clips connected to your database,
renaming the clips causes them to be disconnected. As long as the clips still have the
same reel number and timecode information, you can use the Connect Clips command
to reconnect the records to the renamed clips.

• If some clips have been updated and put in a different folder: If you have created different
versions of some connected clips (for example, versions that have been color corrected
or recaptured using a different codec) and have put the new clips in a separate folder,
you can use the Connect Clips command to connect records to those new clips.

Important: Records connected to DPX image sequence clips use the folder name that
contains the image sequence files as the reel name, and the name of the first image as
the clip name. If you change the name of the folder that contains the image sequence
files, you have effectively changed the clip’s reel name, and you cannot use Connect Clips
to reconnect to the DPX image sequence clip.

The Connect Clips command uses a record’s video reel and timecode values when trying
to connect records in the found set to clips in the selected folder (and its subfolders). You
also need to keep the following in mind when using the Connect Clips command:

• Only records with video reel and timecode entries can be connected to a clip.
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• If a record in the found set matches a clip in the selected folder, the record is connected
to that clip, even if the record already had a connected clip. This is useful when you
have moved a set of clips to a new location and want to reconnect them to their records.

• Any records that do not match clips in the selected folder are not modified—if a record
is already connected to a clip in a different folder, it remains connected to that clip if
no matching clip is found in the selected folder.

To use the Connect Clips command to connect clips to the database
1 Make sure that the List View window displays the records to which you want to connect

clips.

To display all of the records in the database, click Show All in the List View window.

In the List View window, 
display the database 
records to which you 
want to connect clips.

2 Choose Database > Connect Clips.

3 In the dialog that appears, navigate to the folder where the clips are located.

All clips in the folder and its subfolders are available for Cinema Tools to connect to.

4 Click Open.

For every database record, Cinema Tools looks in the selected folder and its subfolders
for a clip with a matching video reel and timecode value. Each time Cinema Tools finds
a matching clip, it connects the clip to the correct database record.

Additionally, poster frames are automatically created for each record that gets a clip
connected.
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Connecting Clips Using the Detail View Window
In the Detail View window, you can tell whether a database record is connected to a clip
by looking at the button below the clip poster frame.

The Open Clip button 
replaces the Connect
Clip button if a clip is 
already connected to
the record.

If the button is labeled Open Clip, the current database record has a clip connected to it.
If the button is labeled Connect Clip, there is no clip connected to the database record.

To use the Detail View window to connect a clip to a database record
1 Open the database record in the Detail View window.

See Finding and Opening Database Records for details.

2 Click the Connect Clip button.

Note: If the button is labeled Open Clip, the database record already has a clip connected
to it. If you want to connect a different clip to the record, you need to disconnect the
current clip first.

3 In the dialog that appears, select a clip to connect to the current database record.

When you select the clip, three things happen:

• The clip is connected to the database.

• A poster frame of the first frame of the clip appears in the Detail View window, and
above the poster frame you see the name of the clip.

The name of the clip 
appears above the
clip poster frame.

Tip: Additionally, placing the pointer over the thumbnail display shows a tooltip with
the clip’s location. This can be especially useful if the clip is missing because it lets you
know where Cinema Tools thinks the clip should be.

• A Clip window opens for the clip. If you want a different frame to represent the clip in
the database, go to that frame, then click the Set Poster Frame button. See Choosing
a Different Poster Frame for a Clip and Settings in the Clip Window for more information.
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Note: If you don’t want the Clip window to open after you connect a clip, press the
Command key when you click the Connect Clip button.

To use the Detail View window to disconnect a captured clip
1 Open the database record in the Detail View window and press the Command key.

The Open Clip button changes to Disconnect Clip.

2 Click Disconnect Clip.

Note: Clicking this button breaks the link between the source clip and the record so that
they are no longer connected. It does not delete the clip from your hard disk.

Connecting Clips Using the Clip Window
When a clip has not been connected to a database record, the Clip window contains a
button labeled Enter in Database. If a clip is already connected, the button is labeled
Disconnect Clip.

The Enter in Database button offers you a way to connect a source clip to an existing
database record or create a new database record and connect the clip to it.

To use the Clip window to connect a source clip to the database
1 Choose File > Open Clip to open the clip in the Clip window, then select the clip in the

dialog.

2 Click the Enter in Database button.

This button changes
to Disconnect Clip when 
the clip is connected
to a database.

3 Enter a scene and take identifier for the source clip in the dialog that appears.

Important: Text entries are case sensitive. Additionally, do not enter the hyphen that
separates the take number from the scene/shot value.

See Using Scene, Shot, and Take Identifiers for more information.
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4 Do one of the following:

• Click OK to connect this clip to the existing record in the database that corresponds to
the scene and take you entered in the dialog. If no record exists for that scene and take,
a new record is created.

• Click New Record to create a new record, even if there already is an existing record that
corresponds to the scene and take you entered.

In either case, the source clip in the Clip window is connected to the record, so the
relationship is established in the database. A source clip can be connected to a record in
more than one database, but within one database it can only be connected or related to
one record. If the source clip is moved or renamed, the relationship should be re-created.

To use the Clip window to disconnect a captured clip
1 Open the clip in the Clip window.

2 Click Disconnect Clip.

Note: Clicking this button breaks the link between the source clip and the record so that
they are no longer connected. It does not delete the clip from your hard disk.

Fixing Broken Clip-to-Database Links
When a source clip that has been connected to the database is renamed or moved, the
link between the clip and the database breaks and the clip needs to be reconnected. For
individual clips, clicking the Open Clip button in the Detail View window opens a dialog
that lets you reconnect the clip to the database record. If a group (folder) of source clips
has been moved, you can use the Connect Clips command in the Database menu to
update any broken links to clips that are in the folder you select.

Reconnecting Individual Clips
You can easily reconnect a single clip whose link to the database has been broken because
the clip was renamed or moved.

To reconnect a source clip that has been renamed or moved
1 Open the database record in the Detail View window.

See Finding and Opening Database Records for details.

2 Click Open Clip.

3 In the dialog that appears, click Reconnect, then select the clip.

The clip is connected to the database record.
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Locating Broken Links and Reconnecting Groups of Clips
For clips that have been moved or renamed, the Connect Clips command in the Database
menu makes it easy to locate and fix the broken links for several clips in one folder. This
command updates any broken links to clips that are in the selected folder and its
subfolders.

Note: When a disk volume containing clips is unmounted, Cinema Tools cannot find the
clips until the volume is mounted again. You don’t need to use the Connect Clips
command to fix this kind of temporarily broken link. To reestablish such connections,
simply mount the disk volume that contains the missing clips.

To locate and fix links that are broken because source clips have been moved
1 Make sure that the List View window displays the set of records that you want to search

for broken links.

To display all of the records in the database, click Show All in the List View window.

2 Choose Database > Connect Clips.

3 In the dialog that appears, navigate to the folder where the clips are located.

All clips in the folder and its subfolders are available for Cinema Tools to connect to.

4 Click Open.

5 In the dialog, select the correct clip for the current record and click Open.

For every database record, Cinema Tools looks in the selected folder and its subfolders
for a clip with a matching video reel and timecode value. Each time Cinema Tools finds
a matching clip, it connects the clip to the correct database record.

Additionally, poster frames are automatically created for each record that gets a clip
connected.
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Spending some time with your source clips before you start editing can make the editing
experience smoother.

This chapter covers the following:

• An Introduction to Preparing Source Clips for Editing (p. 123)

• Determining How to Prepare Source Clips for Editing (p. 123)

• Using the Conform Feature (p. 125)

• Reversing the Telecine Pull-Down (p. 127)

• Making Adjustments to Audio Speed (p. 139)

• Synchronizing Separately Captured Audio and Video (p. 139)

• Dividing or Deleting Sections of Source Clips Before Editing (p. 141)

An Introduction to Preparing Source Clips for Editing
After the Cinema Tools database has been created and your source clips have been
captured, there are a few key steps to take before you begin editing. See Determining
How to Prepare Source Clips for Editing for information about these processes.

If your audio and video were captured separately, see Synchronizing Separately Captured
Audio and Video for more information.

Also, in the interest of efficient use of disk space, you may want to eliminate some of the
content you captured before you begin editing. See Dividing or Deleting Sections of
Source Clips Before Editing for information.

Determining How to Prepare Source Clips for Editing
The steps you need to take to prepare your clips for editing depend on the telecine speed,
whether you have NTSC or PAL video, and which frame rate you plan to use for editing.

Your main goals are to:

• Set the video frame rate to match the frame rate at which you want to edit
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• Maintain or restore audio/video sync

Note: See Working with 24p Video and 24 fps EDLs for information about working with
24p video.

Choosing an Editing Frame Rate
In general, it’s a good idea to edit at the frame rate at which the picture was originally
filmed and recorded. For example, if you film, record, and edit at 24 fps, the audio, the
video, and the original sound and picture are at the same rate. When you edit at the same
speed at which you filmed and recorded, you can digitize directly from the original sound
recordings because the picture and sound are in sync. No adjustments need to be made
for synchronization purposes.

There is an exception to this recommendation: in an NTSC environment, where you need
to use NTSC equipment and output to NTSC tapes, you may prefer to edit at 23.98 fps
because then you can take advantage of the Real-Time Effects pull-down feature in
Final Cut Pro that lets you output your 23.98 fps video to an external FireWire device as
29.97 fps video. You can choose from three different pull-down patterns (2:3:2:3, 2:3:3:2,
and 2:2:2:4). These pull-down patterns are not available with 24 fps video.

Note: Additionally, Final Cut Pro includes two pull-down options for 24 fps PAL video
that allow you to output the 24 fps video to an external FireWire device as 25 fps video.

See Adding Pull-Down to 23.98 fps Video for more information about adding a pull-down
using Final Cut Pro. See the Final Cut Pro documentation for more information about
using the Real-Time Effects pull-down feature.

Keep in mind that if you record at 24 fps and then convert to 23.98 fps, your video is
running at a speed slightly slower than that of the original recording. Because it is slower,
it is called pulled down. When video is pulled down, the digitized audio also needs to be
pulled down, either by slightly slowing down the playback of the original audio source
while digitizing (for example, in the telecine transfer process), or by adjusting the speed
of the clip to 99.9 percent after capturing.

Ways You Can Prepare the Source Clips
There are a few different ways to adjust your source clips to the frame rate at which you
want to edit:

• Use specialized hardware to capture at your chosen frame rate: If you have the right
equipment, you can use it to convert the frame rate in real time while the clips are
captured and adjust the audio speed to match. When you do this, the clips are already
in sync and do not require the Cinema Tools Reverse Telecine or Conform feature for
frame rate conversion.
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• Use the Reverse Telecine feature: If your clips have the NTSC standard frame rate of
29.97 fps, you can use the Reverse Telecine feature to reverse the 3:2 pull-down that
was used to convert the clips to 29.97 fps, thus removing the extra fields created by
the pull-down and converting the clips to 23.98 fps or 24 fps. When clips contain both
audio and video, the Reverse Telecine feature also adjusts the audio speed so that the
audio and video remain in sync after the frame rate is changed.

• Use the Conform feature: If your clips have the PAL standard frame rate of 25 fps, you
can use the Conform feature to convert them to the frame rate at which you want to
edit. When clips contain both audio and video, the Conform feature also adjusts the
audio speed so that the audio and video remain in sync after the frame rate is changed.

Note: If the audio is separate and not contained in the source clips, you also need to sync
audio and video clips and merge them together as one clip in Final Cut Pro. See
Synchronizing Separately Captured Audio and Video for more information.

Using the Conform Feature
Conforming a clip to a frame rate means that each frame in the clip is given an equal
duration in seconds based on a frame rate you specify. For example, if you conform a clip
with 360 frames to 24 frames per second, each frame becomes 1/24 of a second, and the
total duration of the clip is 360/24 seconds, or 15.0 seconds. Use the Conform feature to
change the frame rate of a clip to the frame rate at which you want to edit. If the clip
contains audio and video, the Conform feature also adjusts the audio rate so that the
audio and video remain in sync.

Refer to Ways You Can Prepare the Source Clips for help in deciding whether or not you
should use the Conform feature.

Important: Conforming modifies the actual source media file. You must have
read-and-write access to the media file for the Conform feature to be available.
Additionally, you cannot use the Undo command to restore the file to its original frame
rate; however, you can use the Conform feature a second time to return the file to its
original frame rate if necessary.

Conforming One Clip at a Time
You can individually conform each clip.

To conform a clip in Cinema Tools
1 Choose File > Open Clip, then select the clip in the dialog.

2 In the Clip window, click the Conform button.
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3 In the Conform Clip dialog, choose a new frame rate from the “Conform to” pop-up menu,
then click Conform.

You can also conform 25 fps clips to 24 fps from within Final Cut Pro.

To conform a clip in Final Cut Pro
1 Select one or more clips in the Browser to conform from 25 fps to 24 fps.

2 Choose Tools > Conform 25 to 24.

The clips are conformed to 24 fps.

Note: If any of the selected clips are not 25 fps, a warning appears stating that one or
more clips will not be processed.

Batch Conforming Several Clips at a Time
As an alternative to conforming the frame rate of each clip individually, you can use the
Batch Conform feature to conform the frame rates of all the clips in a selected folder.

To batch conform in Cinema Tools
1 Make sure all the clips you want to conform are in the same folder.

2 Choose File > Batch Conform.

3 In the dialog that appears, select any clip file in the folder that contains the clips you want
to conform, then click Choose.

Note: You only need to select one clip file. All the clips in the folder will be conformed.

4 In the Batch Conform dialog, choose a frame rate from the “Conform to” pop-up menu,
then click Conform.

After the batch conform process is completed, the following occur:

• The clips are conformed to the chosen frame rate and placed in a Cinema Tools–created
subfolder named “Conformed [frame rate],” where “frame rate” is the new frame rate
for the clips. A folder might be named Conformed 24.0, for example.
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• If Cinema Tools is unable to complete the conform process for a clip, that clip is moved
into a Cinema Tools–created subfolder named Skipped. (A clip is not processed if it
doesn’t contain a video track, if the frame rate is not supported, or if no codec is found
for the video track.)

• A text file named “conform.log” appears at the top level of the folder. This log gives
the date and time that the process started and ended, for each clip. If any problems
were encountered, such as running out of disk space or memory, an error message
describing the problem also appears in the log.

Reversing the Telecine Pull-Down
When you use a telecine to transfer your 24 fps or 23.98 fps film to 29.97 fps NTSC video,
the typical way the film’s frames are distributed into the NTSC frames is by the 3:2
pull-down method. The 3:2 pull-down method, described in Working with NTSC Video,
inserts extra fields of video. The reverse telecine process removes the extra fields (as
shown in the illustration below), changing the frame rate of the video to the original film
frame rate. In other words, the reverse telecine process reverses the 3:2 pull-down. Reversing
(or removing) the 3:2 pull-down provides a one-to-one relationship between the video
and film frames so that your cut lists are accurate.
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Note: The Reverse Telecine feature cannot be used with temporally compressed video,
such as MPEG-2-format video.
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3:2 Pull-Down Removal

Important: If your source clips originated from a special type of DV camcorder that shoots
24p, such as the Panasonic AG-DVX100 camcorder, a simpler form of the Reverse Telecine
dialog appears. See Removing 2:3:3:2 or 2:3:2:3 Pull-Down with Cinema Tools for
instructions for reversing the pull-down for clips that originated from a 24p-capable DV
camera.
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Tips for Using Reverse Telecine
Following are some tips for using reverse telecine:

• Reverse telecine works best if the captured video does not have any dropped frames.
If you attempt to use the Reverse Telecine feature on a clip that has dropped frames,
a warning appears. See Avoiding Dropped Frames for more information.

• If you have to reverse the pull-down for several clips, you might want to use the Batch
Reverse Telecine feature instead, because it allows several clips to be processed at
once. See Using Batch Reverse Telecine for more information.

• Reversing the 3:2 pull-down with software is a time-consuming process; you’ll need
to allow waiting time while your computer does its work. Hardware reverse telecine,
performed by a third-party capture card while the video is captured into your
computer, is a speedier option.

Determining the Field Capture Information
You need to enter field capture information in the Reverse Telecine dialog. Typically, all
of your clips are generated with the same hardware and settings, so you only need to
look at a few frames of one clip to determine the field capture mode. A clip can be
captured as one field or both fields, with field 1 or field 2 dominance.

Look at the key number and timecode window burn on the video frames to determine
the frame sequence and verify whether the video has one or two fields. The key number
window burn usually includes the A, B, C, and D frame type indicators. (Also, the timecode
often has the number “1” at the end to indicate field 1, and “2” to indicate field 2.) In the
Clip window, use the arrow keys on your keyboard to step through a few frames of a clip
and observe the sequence of film frame numbers. Refer to the table below to find out
your field information.

In the Reverse Telecine dialog,
select as capture modeThen your video contains

If the repeating frame
sequence is

Field 1 - Field 2Both fields, with field 1
dominance

AA, BB, BC, CD, DD or A1A2,
B1B2, B3C1, C2D1, D2D3

Field 2 - Field 1Both fields, with field 2
dominance

AB, BB, CC, DD, DA, or A2B1,
B2B3, C1C2, D1D2, D3A1

Field 1 OnlyOne field, with field 1 dominanceA, B, B, C, D or A1, B1, B3, C2, D1

Field 2 OnlyOne field, with field 2 dominanceA, B, C, D, D or A2, B2, C1, D1, D3
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What Is Field Dominance?
The field dominance of a captured clip is determined by the telecine hardware and is
usually not configurable by the user. Video frames are composed of two fields; one field
consists of all the even lines of the video, and the other field consists of all the odd lines.
At the telecine, the two fields are scanned at different times, which means that the film
frame can advance between the time that the first field is scanned and the time that
the second field is scanned.

• When only one field is captured: Field 1 dominance means that only field 1 is captured,
and field 2 dominance means that only field 2 is captured.

• When both fields are captured: Field 1 dominance means that each captured frame is
digitized from two video fields, but field 1 occurs earlier.

Note: With field 1 dominance, the two video fields digitized into each captured frame
should have the same timecode address, because SMPTE timecode is specified as
beginning on field 1. Field 2 dominance, when both fields are captured, means that
field 2 occurs earlier and that the captured frame contains video fields with two different
timecode values.

About A Frames
If your video has window burn, the easiest way to locate an “A” frame is to look at the
key number in the video frame, which typically has a letter after it indicating the frame
type. This letter is called the frame type indicator. A frames include any frame with a frame
type indicator that begins with “A,” including an AA (also known as A1A2), AB (also known
as A2B1), A1, or A2 frame. When you view the video a frame at a time, the frame type
indicator for an A frame shows an “A” and the frame number is solid (not flickering
between two frames).

The frame type indicator 
in the window burn tells 
you this is an A frame.
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If you are using non-drop frame timecode and your source clips have not yet been edited,
there is a reliable five-frame pattern where an A frame occurs every five frames. Usually,
any timecode number ending in “0” or “5” is an A frame (for example, 1:23:14:10 and
1:23:14:15).

During batch reverse telecine, if a clip starts on a timecode number that is not evenly
divisible by five (that is, timecode numbers ending in “5” or “0”), Cinema Tools trims frames
from the beginning of the clip so that the clip starts on the next frame with a timecode
number that ends in “0” or “5.” This is done to make sure that all source clips start on an
A frame. Clips that are trimmed are noted in the batch reverse telecine log file, which is
named “reverse.log.”

When key numbers are not burned in to the video, finding an A frame is much more
difficult. If there is a lot of motion in the video, you might be able to distinguish one of
the original film frames from the next in the video. In that case, look for a video frame
made up of two fields from the same original film frame, which has different film frames
before and after it. Such a frame would be an A frame.

Using Reverse Telecine on a Single Source Clip in Cinema Tools
Use single-clip reverse telecine to perform reverse telecine on one clip. You can also
perform reverse telecine on clips using Final Cut Pro. See Using Reverse Telecine on Source
Clips in Final Cut Pro for more information.

In most cases, you need window burn to use the Reverse Telecine feature because you
need to examine the key numbers or timecode in the clip itself to make reverse telecine
settings. However, if your source clips originated from a certain type of camcorder that
shoots 24p, such as the Panasonic AG-DVX100 camcorder, you do not need window burn
in order to reverse the pull-down. See Removing 2:3:3:2 or 2:3:2:3 Pull-Down with
Cinema Tools for specific information.

Note: For reverse telecine to function properly, a media file cannot be in use by any other
application. Also, a clip cannot be open in the Finder, nor can it be write-protected. If you
perform reverse telecine on clips that are open in another application, an alert message
appears warning you that the file is busy.

To use the single-clip Reverse Telecine feature on a clip in Cinema Tools
1 Choose File > Open Clip, then select the clip in the dialog.

2 In the Clip window, position the playhead so that a still frame with clearly readable window
burn is displayed.

You need to see the window burn in order to identify the frame type for the Reverse
Telecine dialog. Often the first frame will do, but any frame in the clip can be displayed.
(Reverse telecine will be applied to the entire clip, regardless of which frame is displayed.)

3 In the Clip window, click Reverse Telecine.
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4 In the dialog that appears, select the capture mode that indicates the correct field capture
for the clip:

• Field 1 Only: Select this option if the video contains only field 1.

• Field 2 Only: Select this option if the video contains only field 2.

• Field 1 - Field 2: Select this option if the video contains both fields, and field 1 is the
dominant field (the first field to appear).

• Field 2 - Field 1: Select this option if the video contains both fields, and field 2 is the
dominant field.

See Determining the Field Capture Information for details.

Note: If Cinema Tools finds pull-down information embedded in the source clips, a simpler
version of this dialog appears. See Removing 2:3:3:2 or 2:3:2:3 Pull-Down with Cinema Tools
for more information.

5 In the Fields area, use the pop-up menu to choose the style of frame types to show (Style
1 shows letters only, and Style 2 shows letters with field numbers), then select the frame
type that matches the type of frame currently displayed in the Clip window.
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Your frame type choices vary depending on the field capture mode you selected.

Select the frame type 
that corresponds to the 
frame showing in the 
Clip window.

If you want to see the 
choices as letters and 
numbers (for example, 
A2, B2, C1, and so on), 
choose Style 2 from the 
pop-up menu.

Different choices are 
available depending
on which capture mode 
is selected.

6 Select “New (smaller)” or “Same (faster)” to specify the kind of file you want the Reverse
Telecine feature to create:

• New (smaller): This option creates a new clip file that does not contain the extra frames
introduced by the 3:2 pull-down. The new file is about 20 percent smaller, but this
method is slower. Regardless of whether the original file was reference or self-contained,
this method creates a self-contained file. See The Difference Between Self-Contained
and Reference Media Files for more information.

• Same (faster): This option modifies the current clip file so that the extra frames are not
visible to the editing system, but the data is not removed from the file. This process is
faster but does not reduce the size of the file. The resulting file is self-contained if it
was originally self-contained, or reference if it was originally reference.
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Note: This “Same (faster)” method is available only when the clip has been captured
or recompressed to have only one field per frame. This is because reversing the 3:2
pull-down for a clip with two fields per frame requires deinterlacing two different
frames, removing one field from each of those two frames, and then making a new
frame out of the other two fields. When new frames are being created, a new movie
file must be created.

Tip: If you choose the “New (smaller)” method, the original file is no longer needed, but
it is not automatically deleted. A dialog suggests naming the new file the same name as
the original, with the extension .rev added. To delete the original file by replacing it with
the new one, remove the .rev extension in the dialog so that the new file has the same
name as the original. Keep in mind, though, that if you delete the original file, you cannot
use reverse telecine a second time if you want to try a different setting.

7 From the “Conform to” pop-up menu, choose the frame rate that allows you to maintain
or restore audio/video sync:

• 23.98: This frame rate is useful if you want to later use the Final Cut Pro pull-down
feature that lets you output 23.98 fps video as 29.97 fps video. (See Pull-Down Patterns
You Can Apply to 23.98 fps Video for more information.)

• 24.0: You may want to conform and edit the clips at this rate if you plan to include
them in a project that contains other clips that are exactly 24 fps.

Note: If the audio and video are contained in the same clip, and you choose 24.0 from
this pop-up menu, the Reverse Telecine feature increases the audio speed by a very
small percentage so that it is in sync with 24 fps instead of 23.98 fps.

Choose a frame rate.

Leave this checkbox 
selected.

8 Leave the Standard Upper/Lower checkbox selected.

The Standard Upper/Lower checkbox should be selected unless you find that the reverse
telecine process does not produce the correct results. It is only relevant when both video
fields are captured; it has no effect if only one field was captured. See Checking Your
Reverse Telecine Results for more information.

9 Click OK to start the reverse telecine process.

If you selected the “New (smaller)” file option, you are asked to give the new reversed
clip a name and location. If the original clip was connected to a database record, the new
reversed clip replaces its connection to the record (regardless of whether or not the new
clip overwrites the old clip).
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Note: Occasionally there are clips with individual frame durations that are longer than
they should be. This situation can cause the Reverse Telecine feature to report one or
more dropped frames, when in fact there aren’t any. If you see this message, try using
the Conform feature to conform the clip to 29.97 fps before starting the reverse telecine
process again. The Conform feature ensures that all the frames are the same length. See
Using the Conform Feature for more information.

As long as you created a new file (by default, with the extension .rev) and did not delete
the original file, you can perform reverse telecine a second time if necessary (for example,
to try a different field setting).

To prepare to use the single-clip Reverse Telecine feature a second time
1 Disconnect the current reversed file from its database record.

2 Connect the original file to the database record.

3 Rename or move the current reversed file if you want to keep it from being overwritten.

Now you can perform the steps for using the single-clip Reverse Telecine feature on a
clip in Cinema Tools as described previously in this section.

Checking Your Reverse Telecine Results
After a telecine 3:2 pull-down transfer, the upper field is typically field 1 and the lower
field is field 2, except when using DV. Normally, when the Standard Upper/Lower
checkbox is selected, Cinema Tools determines what needs to be done and the clips
are processed correctly. However, on rare occasions, video is captured or processed in
such a way that field orders are switched, and this can result in flawed reverse telecine
results.

To check your results, look at the frames of a clip that has been processed by reverse
telecine. As you look at each frame in the clip, you should see the sequence of A, B, C,
and D frames repeat and each letter should be clearly legible. You should not see any
interfield flicker. The film frame numbers should increase sequentially, and those digits
should also be clearly legible. If not, try using the reverse telecine process again, but
without selecting the Standard Upper/Lower checkbox.

Using Reverse Telecine on Source Clips in Final Cut Pro
Final Cut Pro includes a menu command that allows you to perform reverse telecine on
the clips selected in the Browser.
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It is important to understand that, although Final Cut Pro initiates the reverse telecine
process, it is Cinema Tools that actually performs the task. Additionally, you are not
presented with the same choices as when using reverse telecine directly in
Cinema Tools—the settings that are used for the reverse telecine process using
Final Cut Pro are the last settings that were used in Cinema Tools. Therefore, you should
always perform reverse telecine on a clip directly in Cinema Tools to verify the proper
settings before processing clips using Final Cut Pro.

Important: Performing reverse telecine using Final Cut Pro modifies the original media
file—you do not have the option of creating a new media file as you do when using
Cinema Tools. You must have read-and-write privileges for the media files.

To use Final Cut Pro to perform reverse telecine on source clips
1 In the Final Cut Pro Browser, select the clips you want to process.

Note: Only files using a frame rate of 29.97 fps will be processed.

2 Choose Tools > Cinema Tools Reverse Telecine.

Cinema Tools opens and performs the reverse telecine, displaying a dialog that shows
the task’s progress.

Using Batch Reverse Telecine
If you need to reverse the telecine 3:2 pull-down of several clips, you can use the Batch
Reverse Telecine command to process several clips at once.

Note: If your source clips originated from a certain type of DV camcorder that shoots 24p,
such as the Panasonic AG-DVX100 camcorder, see Removing 2:3:3:2 or 2:3:2:3 Pull-Down
with Cinema Tools for more information.

Preparing to Use Batch Reverse Telecine
There are a couple of things you should do before using batch reverse telecine:

• Before you start a batch reverse telecine process, use the single-clip reverse telecine
process on one of your clips and check the results to make sure the settings you plan
to use work correctly. See Using Reverse Telecine on a Single Source Clip in Cinema Tools
for instructions.

• If you are working with video that contains two fields, make sure that all your clips have
the same field dominance. See Determining the Field Capture Information for more
information. Some digitizing hardware may switch unpredictably between field 1 and
field 2 dominance. If you find that some of your clips have one and some have the
other, you can separate your clips into two field dominance batches and batch process
them separately.

Using Batch Reverse Telecine for Multiple Source Clips
Before you use batch reverse telecine to process multiple source clips, make sure to read
Preparing to Use Batch Reverse Telecine.
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To use batch reverse telecine
1 Place all the clips that you want to process in one folder.

2 Choose File > Batch Reverse Telecine.

3 In the dialog that appears, select any source clip file in the folder that contains the source
clips, then click Choose.

4 In the Batch Reverse Telecine dialog that appears, select the capture mode that indicates
the correct field capture for the clip:

• Field 1 Only: Select this option if the video contains only field 1.

• Field 2 Only: Select this option if the video contains only field 2.

• F1 - F2: Select this option if the video contains both fields, and field 1 is the dominant
field (the first field to appear).

• F2 - F1: Select this option if the video contains both fields, and field 2 is the dominant
field.

Select the field capture 
information for this clip.

See Determining the Field Capture Information for details.

Note: If Cinema Tools finds pull-down information embedded in the source clips, a simpler
version of this dialog appears. See Removing 2:3:3:2 or 2:3:2:3 Pull-Down with Cinema Tools
for more information.

5 From the “Conform to” pop-up menu, choose the frame rate that allows you to maintain
or restore audio/video sync:

• 23.98: This frame rate is useful if you want to later use the Final Cut Pro pull-down
feature that lets you output 23.98 fps video as 29.97 fps video. (See Pull-Down Patterns
You Can Apply to 23.98 fps Video for more information.)

• 24.0: You may want to conform and edit the clips at this rate if you plan to include
them in a project that contains other clips that are exactly 24 fps.

Note: If the audio and video are contained in the same clip, and you choose 24.0 from
this pop-up menu, the Reverse Telecine feature increases the audio speed by a very
small percentage so that it is in sync with 24 fps instead of 23.98 fps.

6 Leave the Standard Upper/Lower checkbox selected.
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The Standard Upper/Lower checkbox should be selected unless you find that the batch
reverse telecine process does not produce the correct results. See Checking Your Reverse
Telecine Results for more information.

7 To save the original clips in a separate folder, leave the Keep Originals checkbox selected.
If you don’t want to save the original clips, deselect it. (When you deselect the checkbox,
the original clips are deleted as each new clip is created.)

Important: You cannot undo a reverse telecine operation. If you do not save the original
clips and later find out that one of the settings was incorrect, you will need to recapture
the clips to correct the setting and perform reverse telecine on the clips a second time.

8 Click OK to start the batch reverse telecine process.

After the process is complete, the following occur:

• For each clip in the folder, a new clip with the same name is created and placed in a
Cinema Tools–created subfolder named Reversed.

• If you selected Keep Originals, the original files are placed in a Cinema Tools–created
subfolder named Originals.

• If Cinema Tools is unable to complete the reverse telecine process for a clip, that clip
is moved into a Cinema Tools–created subfolder named Skipped. A clip is not processed
if it doesn’t contain a video track, if the frame rate is not supported, or if no codec is
found for the video track.

• A text file appears at the top level of the folder you started with, named “reverse.log.”
This log gives the date and time that the process started and ended, as well as a start
time for each clip. If any problems were encountered, such as running out of disk space
or memory, an error message describing the problem also appears in the log.

Additionally, you will need to use the Reconnect command to connect the newly created
reverse-telecined clips to their records. See Fixing Broken Clip-to-Database Links for more
information.

Using Batch Reverse Telecine a Second Time
If, after performing the batch reverse telecine, you decide you need to change a setting
and redo the batch reverse telecine, perform the following steps.

To prepare to use batch reverse telecine a second time
1 Move the clips from the Originals folder to their original folder.

Note: If you did not select Keep Originals, you must recapture the original clips.

2 If you would like to keep the current reverse telecine versions of the clips while creating
the new versions, you need to move them from the Reversed folder to another folder or
rename the Reversed folder (for example, to Reversed 1).

You can leave the current files where they are if you would like them to be overwritten.

3 Similarly, you need to move or rename the “reverse.log” file if you would like to save it.
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4 Follow the steps in Using Batch Reverse Telecine for Multiple Source Clips to perform the
batch reverse telecine.

Note: If you connected the original reverse-telecined clips to the database records using
the Reconnect command, the new reverse-telecined clips should automatically be
connected to the database.

Making Adjustments to Audio Speed
If you need to make audio speed adjustments in order to reestablish synchronization
with the video, there are various ways you can do this.

Note: The reverse telecine and conform processes automatically adjust the audio speed
in a clip to match changes made to the video frame rate of the same clip.

• You can adjust the speed with the Final Cut Pro Speed command. First, unlink the audio
and video clips. Select the audio clip in the Timeline, then choose Modify > Speed and
enter a new speed percentage. For example, to slow down an audio clip by 0.1 percent,
enter “99.9.” Relink the audio and video clips when you have finished modifying the
speed of the audio clip.

• Some sound recorders and audio playback equipment can have their playback speed
adjusted to sync with the video. When using such equipment, you can capture the
audio with the correct speed for synchronization.

• You can use specialized equipment, such as that available from Aaton, designed to
control and adjust the audio for proper sync with any video rate. You use this equipment
before capturing the audio into your computer.

• If you don’t need the audio speed adjusted for editing, but you do need it adjusted for
the finished project, you can have the audio finished at an audio post-production facility
that can adjust the speed.

Synchronizing Separately Captured Audio and Video
If your sound and picture were not synchronized onto videotape, but were instead
captured separately, you can synchronize them in Final Cut Pro.

In Final Cut Pro, a feature called merged clips lets you link one or more source media files
together so that they become one clip. First you synchronize them, and then you merge
them into one clip.
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The clapper boards (also called slates) in your shots provide the audible and visible cues
on which to sync your audio and video clips. There are a couple of different techniques
you can use to synchronize clips before merging them, depending on how you shot your
footage.

• If your video and audio clips do not span exactly the same timecode values, and you slated
all your shots at the beginning with a clapper board: You can use In points to line up all
the clips you want to merge.

When you do this, the beginning of the resulting merged clip corresponds to the In
point you used, and all the clips line up at that point. The end of this merged clip
corresponds to the end of the clip with the latest timecode value.

Video

Merged clip

Audio

Audio

• If your video and audio clips do not span exactly the same timecode values, and you have
one or more shots that you tail-slated at the end: You can use Out points to line up all
the clips you want to merge.

When you do this, the end of the resulting merged clip corresponds to the Out point
you used, and all clips line up at that point. The beginning of this merged clip
corresponds to the beginning of the clip with the earliest timecode value.

Video

Audio

Audio

Merged clip

For details about how to synchronize and merge clips in Final Cut Pro, see the section in
the Final Cut Pro documentation that describes working with merged clips.
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Dividing or Deleting Sections of Source Clips Before Editing
Before you edit your media in Final Cut Pro, you have the option of further dividing or
eliminating parts of source clips. If you used a batch capture list and device control for
capturing, you may have captured your source clip files exactly as you want them. On
the other hand, you may feel that the captured source clips need to be broken down into
individual takes, or you may want to eliminate some of the content you captured before
you begin editing in order to make efficient use of available disk space.

Strategies for Breaking Down Source Clips Before Editing
Before you begin, if the edge code number-to-timecode relationship is not continuous
throughout the camera roll from which a source clip came, be aware that there are a
couple of important things you need to do after you break down source clips:

• Create a new database record for the new source clip that is created when you break
down a clip, and make sure the new source clip is connected to the database record.

• Update the clip’s database record so that the edge code number information is correct
for the clip’s new first frame. (This is necessary only if you delete material from the
beginning of a clip.)

Note: See Is Your Edge Code Number-to-Timecode Relationship Continuous or
Noncontinuous? for more information.

There are a variety of ways to break down source clips before editing:

• An easy way to break source clip files into smaller source clips is to use Final Cut Pro.
First, make one or more subclips from the clip in the Browser. You can then use the
Media Manager to delete any part of the clip that you did not select as a subclip. See
the section about creating and working with subclips in the Final Cut Pro documentation
for more information.

• Another way to select and save portions of a clip is to use QuickTime Pro. If you use
QuickTime Pro for this purpose, make sure to choose “Make movie self-contained” in
the “Save as” dialog. See The Difference Between Self-Contained and Reference Media
Files for more information.

• If you are using hole-punched or otherwise marked frames (rather than window burn)
to identify the key numbers for each of your source clips, make sure you do not trim
off any of the marked frames.

• If the telecine transfer involved the 3:2 pull-down method, it’s a good idea to start each
source clip on an A frame. After the 3:2 pull-down, A frames are the only film frames
that are not divided into two video frames. Because of this and because the A frame
is the start of the video five-frame pattern, it is preferable to have one as the first frame
in all video clips. See About A Frames for more information.
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The Difference Between Self-Contained and Reference Media Files
There are two basic video and audio file types that you need to be aware of, especially
if you are breaking a large media file into smaller ones using QuickTime Pro. Because
video files tend to be large, the type of media file you create can have a large impact
on your hard disk space.

• Self-contained media files: A self-contained media file is complete; you can delete the
original file and its duplicate will still play on its own. For that reason, self-contained
media files are typically large files. It’s a good idea to save your media as self-contained
if you intend not to use large portions of the original, and then you can delete the
original once you have saved the bits you want.

• Reference media files: A reference media file is a file with dependencies on the original
media file. Reference files do not contain any actual media content—they contain
only pointers to a specific part of the original media file. The files for these clips are
small. If you delete, move, or rename the original media file, any files that refer to it
will no longer play, because they cannot locate the original.

One way to tell if a media file is self-contained or reference is to open it in the
Cinema Tools Clip window and click the Analysis button. The Analysis pane displays this
information. Another way to tell is to look at its file size—media files with dependencies
have small (20 kilobyte or so) file sizes, whereas self-contained media files, even short
ones, can have file sizes up to hundreds of megabytes or more.

Deleting a Source Clip File
To eliminate an unwanted source clip file before you start editing, drag the clip to the
Trash. Then, if there is a record for that clip in the Cinema Tools database, delete that
database record. Refer to Deleting a Database Record for more information.
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Once your source clips have been captured and prepared, you can edit them in
Final Cut Pro. However, there are a number of issues to consider before you begin editing
material that originated on film.

This chapter covers the following:

• About Easy Setups and Setting the Editing Timebase (p. 143)

• Working with 25 fps Video Conformed to 24 fps (p. 144)

• Displaying Film Information in Final Cut Pro (p. 146)

• Opening Final Cut Pro Clips in Cinema Tools (p. 150)

• Restrictions for Using Multiple Tracks (p. 150)

• Using Effects, Filters, and Transitions (p. 151)

• Tracking Duplicate Uses of Source Material (p. 157)

• Ensuring Cut List Accuracy with 3:2 Pull-Down or 24 & 1 Video (p. 158)

About Easy Setups and Setting the Editing Timebase
Cinema Tools installs Easy Setups that were created to make setting up Final Cut Pro
convenient for Cinema Tools users. When you select an Easy Setup in Final Cut Pro, your
sequence presets, capture presets, device control presets, and external video presets are
all set for you so that you don’t have to select them individually. Cinema Tools users may
want to take advantage of these Easy Setups:

• 23.98fps from DV PAL: Choose this Easy Setup to capture PAL video and to set the editing
timebase to 23.98 fps. This option assumes you will conform the captured video to
23.98 fps.

• 24fps from DV PAL: Choose this option to capture PAL video and to set the editing
timebase to 24 fps. This option assumes you will conform the captured video to 24 fps.

• 23.98fps from DV NTSC: Choose this option to capture NTSC video (in the non-drop
frame timecode format) and to set the editing timebase to 23.98 fps. This option assumes
you will reverse telecine the captured video to 23.98 fps.
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• 24fps from DV NTSC: Choose this option to capture NTSC video (in the non-drop frame
timecode format) and to set the editing timebase to 24 fps. This option assumes you
will reverse telecine the captured video to 24 fps.

• DV NTSC NDF: Choose this option to capture NTSC video (in the non-drop frame
timecode format) and to set the editing timebase to 29.97 fps. This option assumes
you will not perform reverse telecine on the captured video.

• DV PAL 24 @ 25: Choose this option to capture PAL video and set the editing timebase
to 24 fps, but use 25 fps timecode. This option assumes you will conform the 25 fps
video to 24 fps.

Refer to the Final Cut Pro documentation for details about accessing and working with
Easy Setups.

Important: If you don’t use an Easy Setup, you still need to set the editing timebase,
before you begin editing, to the frame rate of your source clips. This ensures that new
sequences you create in Final Cut Pro are set for the frame rate at which you want to edit.
See the Final Cut Pro documentation for details about setting the editing timebase in the
Sequence Preset Editor.

All Easy Setups designed specifically for Cinema Tools users, except for “DV PAL 24 @ 25,”
have the name Cinema Tools in the title. For example, “Cinema Tools - 23.98fps from DV
NTSC.”

By default, the Easy Setups for Cinema Tools users do not appear in the pop-up menu in
the Choose Setup dialog. To see all the Easy Setups in the pop-up menu, including the
ones for Cinema Tools, select the Show All checkbox in the dialog.

Or, to add specific Easy Setups to the pop-up menu, you can add an asterisk (*) to the
end of the Easy Setup filename. For example, you would edit the “Cinema Tools - 23.98fps
from DV NTSC” filename to look like this: “Cinema Tools - 23.98fps from DV NTSC*.”

The Easy Setup files are found in the following location: /Library/Application
Support/Final Cut Pro System Support/Custom Settings/.

Working with 25 fps Video Conformed to 24 fps
The most commonly used method for transferring 24 fps film to PAL video is the 24 @
25 method (described in 24 @ 25 Method). Because this method requires the film to play
4 percent faster, you might have audio sync issues—at the least the onscreen action will
be sped up.
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To help with the audio sync issues, you can use the Conform feature to slow the video
back down to its original 24 fps rate. Because the conform process does not alter the
25 fps timecode created during the film transfer, you have the option of retaining that
timecode format while you edit in a 24 fps editing timebase. This can be useful for those
situations where your negative cutter prefers to receive a 25 fps EDL instead of a film cut
list for film match-back.

See Using the Conform Feature for more information about conforming video.

About the Timecode
When you conform 25 fps video to 24 fps, the clip’s timecode rate is defined as 24 @ 25.

Note: Because the timebase and playback are based on 24 fps, the 25 fps timecode no
longer accurately represents the true passage of time. For example, 38 seconds of video
will actually take 40 seconds to play.

You can see the timecode rate for a clip in the Item Properties window.

To verify a clip’s timecode rate
1 In the Browser, select the clip to be verified.

2 Do one of the following to open the Item Properties window:

• Choose Edit > Item Properties > Logging Info.

• Control-click the clip, then choose Item Properties > Logging Info from the shortcut
menu.

Clips that have been conformed from 25 fps to 24 fps display “24 @ 25” in the TC Rate
row.

About the Sequence Presets
There are two sequence presets designed for 24 fps PAL video:

• DV PAL 48 kHz - 24 @ 25: This preset uses a 24 fps editing timebase and 25 fps timecode
for both the source and record In and Out points, retaining the original source 25 fps
timecode. The DV PAL 24 @ 25 Easy Setup uses this sequence preset. When you export
an EDL, it will be based on 25 fps timecode values. This should be used when you intend
to export a 25 fps EDL and not a cut list.

• DV PAL 48 kHz - 24: This preset uses a 24 fps editing timebase and 24 fps timecode for
both the source and record In and Out points, replacing the original source 25 fps
timecode. This should be used when you intend to export a cut list.
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Displaying Film Information in Final Cut Pro
You can display a variety of film-related information while editing the film’s clips in
Final Cut Pro. There are four areas you can control:

• Item Properties window: The Film tab of the Item Properties window lists the film-related
information for a clip. See Showing Film-Related Information in Item Properties for
details.

• Browser: You can add columns that show film-related information such as key numbers
and telecine film speed (TK Speed). This information also appears in the Item Properties
window. See Showing Film-Related Information in the Browser for details.

• Viewer and Canvas: You can choose to include the keycode and ink numbers with the
timecode values in the overlay. See Showing Film-Related Overlays in the Viewer and
Canvas for more information.

• Timeline, Viewer, and Canvas: You can choose to show the frame count in a “feet and
frames” mode. See Showing Film-Based Frame Counts for more information.

To show film-related information in Final Cut Pro, you must first import the information
from Cinema Tools. There are three ways to do this:

• When you import an XML batch capture list exported from Cinema Tools, the film-related
information is also imported. See Using XML Batch Capture Lists for more information.

• Use Final Cut Pro to import a telecine log file. This adds any film-related information
contained in the log file to the offline clips. See Importing Telecine Logs Using
Final Cut Pro for more information.

• Use the Synchronize with Cinema Tools command, described in the next section,
Synchronizing Final Cut Pro Clips with Cinema Tools.

Important: You do not need to import or show film-related information in Final Cut Pro
to export film lists.

Synchronizing Final Cut Pro Clips with Cinema Tools
You cannot manually update a clip’s film information in Final Cut Pro—the information
must be imported from a Cinema Tools database. Final Cut Pro includes the ability to
synchronize one or more selected clips with a Cinema Tools database. This is especially
useful when you have imported a telecine log and captured the clips: synchronizing the
clips with their database automatically connects the clips to their records. You can also
create a new database, which adds the information for each clip to its record.

Tip: Creating a new database from a group of clips that are already part of another
database allows you to create specialized databases from Final Cut Pro. All of the
film-related information that the clips already contain is automatically added to their
records in the new database.
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To synchronize Final Cut Pro clips with a Cinema Tools database
1 In the Final Cut Pro Browser, select the clips that you want to synchronize with a

Cinema Tools database.

These can be clips that are already in the database and need their information updated,
or they can be clips that are not in the database. In that case, a new record is added to
the database for each clip, with any applicable information added to each record.

2 Choose Tools > Synchronize with Cinema Tools.

A dialog appears that allows you to configure the synchronization process.

The Database field shows the currently selected database.

3 Select the “Add new records” checkbox if you want the database to automatically have
new records added for selected clips that are not already in the database.

This option must be selected when you are synchronizing with a new database.

4 Select the “Auto connect” checkbox if you want the database to automatically connect
the clips to any new records that are created in the database.

5 Do one of the following:

• If the database shown in the Database field is the correct one: Click OK. (The Database
field is updated if you use the New Database or Choose Database button.)

• To create a new Cinema Tools database: Click New Database. This opens a dialog that
allows you to enter a name and location for the database, as well as configure its default
settings. See Settings in the New Database Dialog for information about these settings.
Click Save when finished.
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• To choose an existing database: Click Choose Database. This opens a dialog that allows
you to select an existing database to synchronize with. Click Open when finished.

6 If you used either the New Database or Choose Database button, click OK.

The selected clips are synchronized with the selected database.

Showing Film-Related Information in Item Properties
The Film tab of the Item Properties window contains the film-related information for each
clip.

To see film-related information in the Item Properties window
1 Select the clip in the Browser.

2 Do one of the following:

• Choose Edit > Item Properties > Film.

• Control-click the clip, then choose Item Properties > Film from the shortcut menu.

• Press Command-9 to open the Item Properties window, then click the Film tab.

Note: Comments added to a record in Cinema Tools or a record in a telecine log file
appear in the Take Note row.

Showing Film-Related Information in the Browser
You can add columns to the Browser to show the specific film-related information you
require.

To add columns to the Browser
µ Control-click the heading for the column before which you want to insert the new column,

then choose the column to add from the shortcut menu.

See the Final Cut Pro documentation for more information about arranging columns in
the Browser.

Note: Comments added to a record in Cinema Tools or a record in a telecine log file
appear in the Take Note column.

Showing Film-Related Overlays in the Viewer and Canvas
You can configure the Viewer and Canvas overlays to show a clip’s keycode and ink
numbers in addition to the timecode.

To show film-related overlays in the Viewer and Canvas
1 Click in the Viewer or Canvas to make it active.

2 Choose View > Show Overlays (or press Option-Control-W).
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3 To configure the overlay, choose View > Timecode Overlays to see a list of items you can
display. Click an item to either display or hide it. (Checkmarks appear next to items that
are shown.)

Showing Film-Based Frame Counts
You can set a project’s timecode display format to a Feet+Frame mode, giving film editors
a more familiar way to judge project length. This setting affects the time display along
the top of the Timeline, as well as the timecode fields along the top of the Viewer and
Canvas.

To set a project to display the Feet+Frame mode
1 Select the project’s tab in the Browser.

2 Choose Edit > Project Properties.

The Project Properties window appears.

3 Choose Feet+Frame from the Time Display pop-up menu.

4 Choose the film standard from the Default Film Standard pop-up menu. The film standard
defines how many frames are in a foot.

Important: To ensure that correct film lists are exported, make sure to choose the film
standard set in the Cinema Tools database.

See the Final Cut Pro documentation for more information about the Project Properties
window.

You can also individually control the timecode display of the Timeline, Viewer, and Canvas.

To change the timecode display of the Timeline, Viewer, or Canvas
µ Control-click a timecode field in the window whose timecode display you want to change,

then choose the mode from the shortcut menu.
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For the Viewer and Canvas, this affects both timecode fields along their tops, and in the
case of the Viewer, the timecode fields of its tabs. For the Timeline, this affects the
timecode shown along the top of the window and in the Current Timecode field. The
timecode displays in the Transition Editor and Trim Edit windows are also affected.

Important: The feet and frame values that are shown are not the same as keycode or ink
numbers. The feet and frame values always start at 0000+00 at the beginning of the
sequence or clip.

When using the Feet+Frame timecode display mode, you can enter values in the same
places you can enter timecode values. For example, you can enter a value in the Current
Timecode field of the Viewer to position its playhead. To ensure the number you enter
is correctly interpreted by Final Cut Pro, make sure to use one of the following characters
to separate the feet and frame values: plus sign (+), ampersand (&), period (.), or comma
(,).

Opening Final Cut Pro Clips in Cinema Tools
You cannot directly change any items in a Cinema Tools database while in Final Cut Pro.
However, you can open a clip in Cinema Tools from Final Cut Pro to make changes to
that clip’s database record. Once you have done this, you need to synchronize that clip
so that the changes appear in Final Cut Pro.

To open a clip in Cinema Tools from Final Cut Pro
1 Select a clip or a group of clips in the Browser.

2 Choose View > Open in Cinema Tools.

The clip opens in a Cinema Tools Clip window. If you selected multiple clips, each opens
in its own Clip window. Any changes you make, such as to a camera roll number, are
added to the clip’s database record.

After you have finished making the changes, you can synchronize the clips in Final Cut Pro
with the modified Cinema Tools database. See Synchronizing Final Cut Pro Clips with
Cinema Tools for more information.

Restrictions for Using Multiple Tracks
Final Cut Pro allows you to edit in multiple video tracks and multiple audio tracks. Although
there are advantages to using numerous tracks, there are some restrictions to keep in
mind when you are using Final Cut Pro with Cinema Tools:

• When you export your film lists, you specify the video track to base the list on. If you
have included titles and superimposed images on a second video track, you must export
a second film list to include that information.
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• If you are going to export an audio Edit Decision List (EDL), you need to limit the audio
to the first eight tracks in the Final Cut Pro Timeline. See Exporting an Audio EDL for
more information.

Using Effects, Filters, and Transitions
Final Cut Pro and other Final Cut Studio applications provide extensive effects capabilities
for video, including common film effects such as dissolves, wipes, motion effects, titles,
color correction, and compositing. If your final output uses standard broadcast SD or HD
resolutions, these effects can often be included directly in the final output. However, if
your output is going to be higher-resolution video for digital projection (such as a 2K
DPX image sequence), if the output will be converted to film using a digital film printer,
or if you intend to conform the original camera negative, these effects will generally be
used only to preview the final effect, which will be created at a visual effects facility.

Effects and transitions are usually created for digitally edited film in the following ways
(because of the changing and diverse nature of the industry, your actual experience may
vary):

• Basic transitions, titles, and motion effects for DI workflows: These effects are typically
re-created by a digital visual effects facility. The facility uses a Cinema Tools–generated
film list to either pull the already scanned DPX image sequences for the required video
or have high-quality scans of the original film made, providing final-resolution video
clips to work with. See Special Considerations for Effects in a DI Workflow for more
information.

• Basic transitions, titles, and motion effects for film workflows: These effects are typically
re-created by a facility specializing in optical or contact printing, which uses the
instructions given in a Cinema Tools–generated film list. Certain types of transitions
can be created through contact printing (sometimes called A/B roll printing), where the
emulsion sides of the original camera negative and the print stock are in contact as
the original film is projected onto the print stock. Transitions, titles, and motion effects
can be made through optical printing, where effects are created via a process of
manipulating and projecting the original camera negative onto print stock through
the lens on an optical printer. This process is often called creating opticals. See Contact
Printing vs. Optical Printing for more information about factors to consider when
choosing whether to use optical printing or contact printing.

• Complex effects that involve compositing for all workflows: Effects such as chroma-keying,
animation, and repositioning can be re-created digitally at high resolution at a digital
visual effects facility.

If you are using a DI workflow that uses low-bandwidth versions of the program’s clips,
draft versions of the effects are made and edited into the program, replacing the
temporary placeholder effects (if present). The original high-resolution effects are used
during the finishing process.
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If you are using a traditional film workflow, the effects must be output back to film
using a digital film recorder. This is sometimes called the film-digital-film method. First,
the original camera negative is scanned digitally; then the scanned digital copy is
imported into a digital film workstation, and your special effects are created there
before being recorded back to film. There are digital effects labs that offer this service,
using your film list as a guide in determining the location and duration of motion effects
and of superimposed compositing effects such as blue-screen effects. Although the
film-digital-film method can produce wonderful effects, be aware that it can be more
expensive than optical printing.

• Effects involving filters and color correction: Digital film restoration and artifact removal
are other types of digital manipulation that commonly occur with the film-digital-film
method. This kind of digital manipulation is tracked by the filter effects list, which is
part of the optical list.

In a DI workflow, you can use Color to perform many of these types of digital
manipulation. Color is capable of outputting DPX image sequences, which can be used
to print back to film. In a film workflow, any color correction or filterlike effects in your
finished film are created by a specialist at a film-printing facility or via the film-digital-film
method. You can work directly with a color specialist (often known as a color timer) to
include color correction in your film.

Special Considerations for Effects in a DI Workflow
There are a wide variety of approaches to working with effects when you are using a DI
workflow. There are also an increasing number of third-party applications available that
specialize in the various aspects of the process, such as tracking effect revisions.

Following is a list of issues that you need to be aware of while working on your project:

• If you have not already created high-quality film scans of the parts of the video involved
in the effect, you must do that first. You can use the optical list section of a film list to
identify the film rolls and frames that need to be pulled and scanned. There are many
methods you can use to generate that film list—for example, you can place all effects
in their own track and specify that track when exporting the film list.

• The digital visual effects facility generally provides the final effects using your final
output video format and resolution. Make sure to retain all original metadata such as
key numbers and timecode so the effects can be tracked back to the original film frames.
Otherwise you must manually verify that the correct frames were used to create the
effects, which can be time-consuming.

• You need to create temporary versions of the effects to use in your offline edit of the
program. In some cases, the visual effects facility may provide these. If so, make sure
the facility knows which codec to use and your sequence settings so that the clips will
not have to be reencoded or rendered. These temporary versions of the effects clips
also need to have the same timecode as the original video clips.
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• The effects clips are often not tracked by the Cinema Tools database.

Including Titles, Supers, and Transitions in a Film Workflow
The following workflow shows you how effects, supers (superimposed images or frames),
and transitions might be added to a film that is edited in Final Cut Pro. This is a very basic
workflow, containing steps for including both opticals and contact-printed effects in your
film, though you may have only one or the other.

Important: With the fast-changing, diverse nature of the industry, your best workflow
option may be different from the workflow described here. Make sure you consult your
lab for the most accurate instructions and options for your unique situation.

Stage 1: Confirming Support and Needs with the Lab
Depending on your budget, before you edit you should check with the lab (the optical
house or other facility that will print your effects) to find out what it can offer. Often the
lab has standard effects for you to choose from—custom effects may cost substantially
more or not be available at all. The lab can also educate you about exactly what you need
to provide.

Stage 2: Creating Effects and Transitions in Final Cut Pro
It’s helpful to experiment with styles and durations in Final Cut Pro. That way you’ll be
confident in communicating what you need to your lab.

Because you can export a separate cut list for each video track, you can add titles and
superimposed images to multiple video tracks—for example, as alternative versions—and
choose which to include in the exported film list.

Stage 3: Exporting a Film List
When you’ve finished editing your program, export a film list. See An Introduction to Film
Lists and Change Lists for more information. The film list can contain a number of different
types of lists. The optical list includes descriptions of transition, filter, and motion effects.
You will also need to export a film list for each video track that contains titles or
superimposed images. If you are going to have all of your transitions contact printed
instead of having opticals created, choose “All are cuts” from the Transitions pop-up
menu. See Dividing Transitions Between a Contact and Optical Printer for related
information.
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Stage 4: (Optical Printing) Giving the Film List and Any Appropriate Footage to the
Lab
If you are having effects and transitions created as opticals, your lab uses the specifications
and descriptions in your film list as a guide for creating the opticals. The lab needs relevant
film footage from which to create the opticals. The optical lab may want you to provide
interpositives, or the lab may print the interpositives. The lab may also request a videotape
of your movie to use as a reference. If you’ve made a workprint, you can provide it to the
lab as a reference, or you can give the lab a color copy (“dupe”) of the parts of the
workprint that contain the opticals. Discuss the options with your lab. See About
Interpositives for more information about working with interpositives.

Stage 5: (Optical Printing) Adding the Opticals to Your Project
Transfer the opticals using a telecine, add them to the database, capture them into your
sequence, and export a cut list.

If you are having opticals created for your film, this step is ideal because it provides a cut
list that most accurately documents the opticals, and because it allows you to preview
the opticals in your sequence and see if you like the way they work.

Alternatively, if you have a workprint, the negative cutter may be able to use it as a guide
for cutting the opticals into your film so that you don’t need to transfer them to video
and create a new cut list. Make sure to check with your negative cutter to find out what
is required.

Stage 6: (Optical Printing) Giving the Optical Negative to the Negative Cutter
Assuming you have screened the opticals and are happy with them, give the optical
negative, along with the original camera negative and your entire film list, to the negative
cutter. With the film list (and the workprint if there is one) as a guide, the negative cutter
cuts and splices the effects into your film.

Stage 7: (Contact Printing) Giving the Film List to the Contact Printer
When the conformed negative is ready to be printed by the contact printer, make sure
the contact printer is given a film list that includes information about your titles and
supers and any transitions you want printed into the film.

Note: The negative cutter makes a list of printer cues, including transition needs, and this
list is given to the printer with the cut original camera negative.
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About Interpositives
Because the original footage is negative, the whole film must be printed from negative
images in order to result in a normal, positive film image. This means you want your
opticals to be negative when they are spliced into your original camera negative. The
optical lab typically uses a low-contrast film print (of the relevant parts of the original
camera negative) called an interpositive as the raw source footage from which to assemble
the opticals. After the opticals are assembled from the interpositive, they are printed as
optical negatives that can be spliced into the original camera negative.

Usually, before the final interpositive is created, one or more trial prints are made with
the guidance of a color specialist to find the proper combination of exposure and color
balance.

Note: In some cases, when opticals need a very stable image (as with images behind
text), a registration interpositive is required. Registration interpositive printing minimizes
unwanted lateral film motion in the optical printer gate. The optical lab will tell you when
a registration interpositive is needed.

Contact Printing vs. Optical Printing
Choosing between contact printing and optical printing depends on several factors. The
good news is you can have some effects created one way and others another way. Here
are factors you may want to weigh:

• Saving original footage: Contact printing requires the original camera negative to be
cut and spliced. Optical printing essentially results in a new negative being made, so
the original footage can be used again elsewhere.

• Previewing: If your transitions are printed on a contact printer, you don’t have the
option of seeing the finished transitions before the negative is cut, but if they are
printed optically, you do. After they are printed, transitions and motion effects may not
appear exactly as they did within your digital editing system. If you want to know
exactly how a transition is going to appear in the finished film, have it made optically
before finalizing the cut. Then, transfer the optical to video. You can edit the transferred
optical into your digital program to see how it will look.

• Cost: If you have standard-length transitions and there are a lot of them, it will probably
cost less to have them printed on a contact printer.

Although optical printing has the advantage of resulting in a new negative being made
that you can edit into your digital program to see how it looks and include in your cut
list, the optical’s negative must first be transferred to video at an additional cost.

It’s a good idea to compare quotes for having your transitions printed in different ways.
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• Length: Contact printing requires that the length of the transition be one of a set of
standard lengths, whereas optical printing does not. Cinema Tools identifies the set of
standard lengths for 24 fps or 23.98 fps media as 16, 24, 32, 48, 64, and 96 frames in
duration. Cinema Tools identifies the set of standard lengths for 29.97 fps media as 20,
30, 40, 60, 80, and 120 frames in duration. (Make sure to check with your contact printer
about the standard lengths required for different frame rates.)

Comparing Quotes
To get quotes to compare costs of contact and optical printing, you need to export two
versions of the film list.

To export different film lists to give to the printers for quotes
1 In the Export Film Lists dialog, choose “All are cuts” from the Transitions pop-up menu

to export a film list for a contact printing quote.

Note: See An Introduction to Film Lists and Change Lists for details about the Export Film
Lists dialog.

2 After exporting that list, choose “All are opticals” from the Transitions pop-up menu to
export a film list for an optical printing quote.

Dividing Transitions Between a Contact and Optical Printer
You can have standard-length transitions created by a contact printer and the rest of the
transitions created as opticals.

You do this by exporting a film list in which standard-length transitions are listed as cuts
for printing on a contact printer, and nonstandard-length transitions are listed as opticals.
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To export a film list supporting both contact and optical printing
µ In the Export Film Lists dialog, choose “Std are cuts” from the Transitions pop-up menu.

See Exporting Film Lists Using Final Cut Pro for more information about generating a film
list.

Tracking Duplicate Uses of Source Material
Cinema Tools makes it possible to track multiple uses of the same source material in your
edited sequence. There are two basic reasons to do this:

• If you want to use the same source material more than once in your project: You can export
a duplicate (“dupe”) list and give it to your lab as a part of a duplicate negative order.

• If you don’t want to spend the money required to create a duplicate negative: You need
to be careful not to edit in a way that uses the same source material more than once
because there is only one original camera negative. When editing digitally, it’s so easy
to use the same material twice that you may not even realize that you’ve done it, but
Cinema Tools lets you check for duplicate usages on a regular basis.

In determining whether or not any frames have been used more than once, Cinema Tools
assumes that, because of typical A and B roll film splicing (also called checkerboarding),
at least one-half of a frame will be lost at both the In point and the Out point of each cut
of film. In Cinema Tools, these frames are called cut handles. Some negative cutters may
want to use more than a half-frame on each side of a cut. In the Export Film Lists dialog,
you can specify up to five and one-half frames of cut handles. If you inadvertently include,
in a sequence, frames that are needed as cut handles, Cinema Tools reports them as
duplicate usages in the duplicate list and the double usage warnings.

It’s important to check for duplicate usages before you lock the picture and prepare to
have the original camera negative cut. See Duplicate List and Double Usage Warnings to
find out how to export a duplicate list and include duplicate usage information in a film
list.
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If you are editing your project as multiple sequences (for example, one sequence for each
reel), it’s best to place all the sequences together before exporting a duplicate list. This
way Cinema Tools can find duplicate usages across the entire feature. An easy approach
is to place all the sequences into a nested sequence before generating a duplicate list.

However, when you intend to export a film list, do not nest part of one sequence into
another sequence. Only whole-sequence nesting is supported when you export a
Cinema Tools list. See the Final Cut Pro documentation for information about creating a
nested sequence.

Ensuring Cut List Accuracy with 3:2 Pull-Down or 24 & 1 Video
With 3:2 pull-down NTSC video or 24 & 1 PAL video (also known as 24 @ 25 pull-down
video in Final Cut Pro), a film frame that is matched back from your edits may turn out
to be the one before or the one after your original edit point. (See Frame Rate Basics for
an explanation.)

With 3:2 pull-down NTSC video, you can avoid such match-back inaccuracies by using
the Cinema Tools Reverse Telecine feature or third-party reverse telecine hardware to
reverse the 3:2 telecine pull-down before you begin editing.

If you did not reverse the 3:2 pull-down in NTSC video (or if you are working with 24 & 1
PAL video), you can still avoid cut list inaccuracies through careful editing. Your goal for
each clip is to make sure that the frame showing the slate, or the last frame of the previous
shot, doesn’t end up in the final film:

• When setting edit points for a clip, be careful not to place the In point at the first good
frame in the clip, or the Out point at the last frame. In other words, set the In point at
least one frame after your shot starts and the Out point at least one frame before the
last frame in the shot.

• If you must edit on the first or last frame of a shot, make a note of the key number from
the window burn, and review the cut list later to confirm that the key number is the
same in the cut list.

• Avoid putting In or Out points at frames with two fields that came from two different
frames of the film. For example, don’t place an edit at a BC or CD frame.
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Cinema Tools can create a variety of lists from your edited project.

This chapter covers the following:

• An Introduction to Film Lists and Change Lists (p. 159)

• Choosing the List Format (p. 160)

• Lists You Can Export (p. 161)

• Exporting Film Lists Using Final Cut Pro (p. 166)

• Creating Change Lists (p. 174)

• Working with XSL Style Sheets (p. 189)

An Introduction to Film Lists and Change Lists
When you’ve finished editing and are ready either to have the original camera negative
cut or to conform a workprint, it’s time to export a film list. Using the information in the
database, Cinema Tools translates the edits made in Final Cut Pro into information a
negative cutter can use as a guide. This information is provided in the form of a cut list.
A number of other lists that are useful for film can be exported with the cut list. All of
these lists, including the cut list, are called film lists.

One film list file can contain several related lists, including any of the following:

• Cut list: A list of edits and titling information (also known as an assemble list)

• Missing elements list: A list of any required information that could not be found in the
database

• Duplicate list: A list of duplicate usages of the same source material

• Optical list: A list for the effects printer, describing any transition, filter, and motion
effects

• Pull list: A list to aid the lab in pulling the required negative rolls

• Scene list: A list of all the scenes used in your program and the shots used in the opticals
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You can generate another type of list, called a change list, after an initial cut list has been
created or when you want to compare two XML versions of a Final Cut Pro sequence. In
a film workflow, the change list assumes a workprint has been cut to the specifications
of a cut list (or prior change list) and specifies further changes to make to the workprint,
based on edits you have made to the sequence in Final Cut Pro. See Creating Change
Lists for more information.

Choosing the List Format
Cinema Tools provides three format options for exporting your lists:

• PDF file: A format for easy viewing that contains only the information that you specify

• XML file: A format for use with other software that contains all of the film information
from the sequence

• Style sheet–based file: A format controlled by a style sheet that you choose. You can
use the style sheets provided by Cinema Tools, including a plain text style sheet.

See Exporting Film Lists Using Final Cut Pro for information about creating film lists using
Final Cut Pro and Creating EDL-Based and XML-Based Film Lists for information about
creating film lists using Cinema Tools.

About PDF-Format Film Lists
Exporting a PDF-format film list creates a file that can be opened in Preview or any other
PDF viewer. You can choose which items to include in the list and even set their order.

Tip: Although you cannot directly edit the text in a PDF file when viewing it with Preview,
you can use the Preview annotation tool to add comments. See Preview Help for more
information.

About XML-Format Film Lists
Exporting an XML-format film list creates a file that contains all film-related information
from the Final Cut Pro sequence.

Important: XML-format film lists are not related to the other XML files you can export
from Final Cut Pro.

Unlike PDF-format film list files, which are intended to be printed and read, XML-format
film list files are formatted so that other applications can reliably extract specific data
from the film list. The XML format is intended to be used to exchange information between
software applications. The purpose of XML-format film lists is to provide all of the film
information about a Final Cut Pro sequence in a format that the user can incorporate into
other custom software being used in the film workflow.

Note: You can open an XML-format film list in a text editor, such as TextEdit, to see the
structure and information it contains.
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See XML Film List Basics for more information about the contents of XML film lists.

About Style Sheet–Based Film Lists
Cinema Tools includes support for custom film lists. These film lists are based on Extensible
Stylesheet Language Transformations (XSLT) files, or, as they are referred to in
Cinema Tools, style sheets. Cinema Tools includes style sheets and support for custom
style sheets that you create.

XSLT-based style sheets are commonly used to extract information from XML files. When
you export a style sheet–based film list, Cinema Tools first exports an XML-format film
list and then processes that XML output with the selected style sheet, resulting in exactly
the output items and layout the style sheet specifies.

The Cinema Tools–supplied style sheet files are located in /Library/Application
Support/Final Cut Studio/Cinema Tools/ and all have an .xsl file extension. When you
choose Add Style Sheet from the Style Sheet pop-up menu in the Export Film Lists dialog
to import a custom style sheet, the style sheet is copied to
/Users/username/Library/Application Support/Final Cut Studio/Cinema Tools/.

Note: You can also manually copy your custom style sheets to either of these folders to
have them appear in the Style Sheet pop-up menu without having to use Add Style Sheet
first.

See Working with XSL Style Sheets for information about customizing style sheets to
better match your workflow.

Lists You Can Export
You can export a number of useful lists by using the Export Film Lists dialog. When you
export a film list, one film list file is generated, and that file contains all the lists you
selected in the dialog. Any lists that you did not specifically select are not included in the
exported film list file.

Note: All of the lists you choose to include in the film list are based on the video track
you choose in the Track pop-up menu. You can select a different track and export a
second list if needed. For example, if your sequence contains titles (including any
“supers”—superimposed images or frames) on video track 2, you can export a second
film list that includes the edit information for them. This makes it possible for you to
configure alternative title tracks and export film lists for each version.

Cut List
The first list you can select to export is the cut list. The cut list you export from Final Cut Pro
is the list that contains the instructions for cutting the original camera negative or
workprint to match the digitally edited program. Cut lists are also known as assemble lists.
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Missing Elements List
The missing elements list lists all of the clips in a sequence for which a corresponding
database record either was not found or did not contain all of the necessary information.
It is important that you export and examine a missing elements list to make sure that
there are no elements missing before the negative cutter begins conforming the negative.

For each clip listed in the missing elements list, the element that is missing is specified.
The shot number where that clip appears in the cut list is called out on a separate line.

If any of the following are missing, they are listed in the missing elements list:

• Lab, camera, or daily roll

• Key number or ink number

Additionally, each source clip must be connected to a record, unless you can use the
timecode-based method for cut list generation (see A Potential Database Shortcut for
Camera-Roll Transfers). To use the timecode-based method for cut list generation, each
record must also include these elements:

• Video reel

• Timecode and duration
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Resolving Missing Elements
Resolving a missing element means finding the corresponding database record, if it exists,
and filling in the missing information, or creating a new database record if none exists.
To locate the database record, there are two basic approaches.

If the Name of the Clip Is in the Missing Elements List
You can use the clip name to look for the clip in the List View window. In the List View
window, click Clip to sort the records by clip name. Or, if the clip name includes its scene
identifier, you can use the Find command to search for the clip by the scene identifier.
If no database record is found for the clip, create one and connect the clip to it. Use the
Identify feature in the Clip window to enter the required information.

If the Video Reel and Timecode Appear in the Missing Elements List
You can use the video reel and timecode information to look for an existing database
record for the clip. In the List View window, choose Video from the pop-up menu at the
top of the window. Click Reel or Timecode to sort the records by the video reel or
timecode. Look for the missing video reel or timecode value (or a similar timecode
value). Keep in mind that the timecode value given in the missing elements list is not
likely to match the database record exactly because the timecode value in the database
corresponds to the first frame of the clip. You know it’s a match if the timecode value
in the missing elements list occurs before the end of the timecode duration specified
in the database record.

Note: Remember that the video reel name must appear exactly as it appears in the
missing elements list. For example, reel “001” does not match reel “0001.”

• If you find the timecode value, but the video reel name doesn’t match the one listed in the
missing elements list: Update the reel name in the database record or change it in
Final Cut Pro.

• If the reel name matches one or more records in the database, but the missing elements
list tells you that the database record is missing: The timecode is incorrect. The best
way to resolve this is to create a new database record and connect the source clip to
it. Then you can use the Identify feature to determine and enter the edge code and
timecode information for the clip. If you create a new database record, delete the
incorrect record that the new record replaces. Alternatively, you can update the Video
Timecode or the Video Duration field in the database record, but then you also have
to update the Key and Ink fields.
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Duplicate List and Double Usage Warnings
When editing digitally, it’s easy to include a clip or part of a clip more than once in the
edited program. When this happens, you either have to create a duplicate negative or
reedit the program to remove the duplicate usages, because the footage exists only once
on the original camera negative. But first you have to know where the duplicate usages
are, and that is the purpose of the duplicate list and double usage warnings.

Duplicate List
The duplicate list is what you give to your lab if you want the lab to pull specific shots
from your negative rolls and make duplicate negatives for you. It documents every shot
for which there is one or more duplicate usages.

Note: Content that is part of an optical is not counted as a duplicate usage. However,
placing a dissolve transition between two clips that have no other source footage available
between them (such as two clips that were originally one clip) results in a duplicate usage.

Double Usage Warnings
If you choose Warn from the Duplicates pop-up menu in the Export Film Lists dialog, a
warning message appears where duplicate usages occur in the cut list. The message tells
you exactly which frames have been used more than once and exactly where in your
editing project they are used. All of these messages also appear in a double usage warning
list.

Optical List
The optical list serves as a master list for transition, filter, and motion effects. If there is a
series of connected transition and motion effects, the optical list combines them and
describes them as a single optical. You give the optical list to the optical house to outline
how the effects shots are to be assembled.

Note: Titles, which are another kind of optical, use a second video track and are not part
of the optical list. You can export a separate cut list for the track that contains the titles.

See Using Effects, Filters, and Transitions for more information.

An optical list actually consists of up to four separate lists:

• Optical list: This list contains an entry for each cut list event that uses an optical effect.
Based on the type of optical effect, each entry links to one of the three effects lists
(described next) that are also included with the optical list. These effects lists include
the actual details of the optical effect.

• Transition effects list: This list contains an entry for each optical list entry that contains
a transition effect, such as a cross dissolve or wipe. See Transition Effects List for more
information.

• Filter effects list: This list contains an entry for each optical list entry that contains a filter
effect, such as a blur or color correction. See Filter Effects List for more information.
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• Motion effects list: This list contains an entry for each optical list entry that contains a
motion effect, such as a time remapping speed change. See Motion Effects List for more
information.

How the List Entries Are Linked
If an optical list entry contains multiple types of effects, such as a transition, a filter, and
a motion effect, the optical list entry only links to one of the effects lists.

• If the optical list entry includes a transition effect: The optical list entry links to an entry
in the transition effects list. If the optical list entry also includes a filter effect, the
transition effects list entry links to a filter effects list entry, which links to a motion
effects list entry if a motion effect is also included.

• If the optical list entry contains only a filter and a motion effect: The entry links to a filter
effects list entry, which links to a motion effects list entry.

• If the optical list entry contains only a motion effect: The entry links directly to a motion
effects list entry.

Each entry in the effects lists includes the original optical list entry number and the original
cut list event number the entry applies to, making it easy to relate the different lists to
each other.

Transition Effects List
The transition effects list contains information about the fades, dissolves, and other
transitions from your edited program. Transitions can be treated as cuts or as opticals,
based on what you choose from the Transitions pop-up menu in the Export Film Lists
dialog. If you choose to treat all transitions as cuts, the transition effects list is empty, and
the transitions are listed as cuts in the cut list.

Filter Effects List
The filter effects list contains information, including the actual filter name and its category,
related to any filter effects applied to the sequence.

Motion Effects List
If a shot has a speed other than the normal forward speed of 24 fps, an entry is made in
the motion effects list, and the optical list refers to the motion effects list for that shot.

A digital editing system can assign almost any arbitrary speed to a clip to create a motion
effect digitally, but neither videotape nor film can perfectly reproduce every speed that
the digital editing system can assign. Therefore, be aware that the optical negative that
is made is not necessarily going to look exactly the way the motion effect looked in the
editing system.
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Important: Because of the frame rate changes involved in motion effects, key numbers
that are reported in the motion effects list are not guaranteed to be accurate. If you have
a window burn of the key numbers, you should check to make sure that the key numbers
in the motion effects list are accurate and correct them when necessary.

Pull List
The pull list is the same as the cut list, except that the shots appear in the order in which
they can be found on the negative rolls. The lab can refer to the pull list when going
through your negative rolls to find the shots that will be cut into the film. Each item in
the pull list displays the shot number from the cut list.

Scene List
The scene list lists all of the shots that are used in the cut list, with each shot listed only
once. You can use the scene list to order prints of the shots in your program so that you
can conform a workprint before the negative is cut.

Optical Scene List
If you select “Optical list” and “Scene list” in the Export Film Lists dialog, an optical scene
list is generated along with the scene list. The optical scene list is a list of all the shots
used in all the opticals and motion effects, with each shot listed only once. The lab can
use this list to pull the footage needed to make the opticals.

Exporting Film Lists Using Final Cut Pro
In most situations you will use Final Cut Pro to export any of the lists described in the
previous sections. As long as you have an EDL or XML file based on a Final Cut Pro
sequence, you can also export film lists directly from Cinema Tools. See Creating EDL-Based
and XML-Based Film Lists for more information.

In either case, one film list file is generated, and that file contains all the lists you selected
in the export dialog.

Exporting the Film Lists
Exporting film list files works similarly for PDF-format, XML-format, and style sheet–based
film lists.

To export a film list file
1 In the Final Cut Pro Browser or Timeline, select the sequence for which you want to create

a list.

2 Choose File > Export > Cinema Tools Film Lists.

A dialog appears so you can choose the format of the list.

3 Choose the format of the list from the List Format pop-up menu.

166 Chapter 10 Generating Film Lists and Change Lists



The options are PDF, XML, and With Style Sheet. See About PDF-Format Film Lists, About
XML-Format Film Lists, and About Style Sheet–Based Film Lists for information about
these formats.

4 If you chose With Style Sheet from the List Format pop-up menu, choose a style sheet
from the Style Sheet pop-up menu.

5 Click Continue.

The Export Film Lists dialog appears. The settings in the dialog vary based on the format
you chose in the List Format pop-up menu. Following is the dialog for the PDF list format.

Following is the dialog for the XML and With Style Sheet list formats.

6 Configure the settings in the dialog.

See Settings the Export Dialogs Have in Common for settings information.
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If you expect to make changes to this Final Cut Pro sequence and want to export a change
list later, make sure to select “Save a Cinema Tools program file.” You can use that program
file to export a change list that compares this version of the sequence to another version.

Note: You can use a Final Cut Pro XML file of the sequence in place of the Cinema Tools
program file when you export a change list.

7 Click Export.

8 If you selected “Save a Cinema Tools program file,” enter a filename and location for the
file in the dialog that appears.

Important: Give the program file a name that clearly identifies the sequence and the
version, so that you can easily locate it later when you need to export a change list that
compares this sequence to a newer version.

9 In the next dialog that appears, enter a filename for the film list, choose a location, and
click Save.

10 In the dialog that appears, select the database file that Cinema Tools should use to produce
the lists that you have selected. (Select the database you created for source media used
in this sequence.)

A film list is generated as a file that contains all of the lists you have selected. If you
exported a PDF-format list, it automatically opens in Preview (or the application you have
set as your default for opening PDF files).

After exporting a film list, you should compare the edge code (key numbers or ink
numbers) in the film list to the edge code in the window burn at the In point frame of
each edit. Although it can be time-consuming to go through all of the edits and compare
the edge code numbers, it prevents the loss of time and money caused by incorrect cuts.
It’s particularly important to check the edge code numbers if you are not conforming a
workprint before cutting your negative.
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Settings the Export Dialogs Have in Common
The settings available in the export dialogs vary depending on which output format you
choose from the List Format pop-up menu, but all versions have the same basic settings.
The dialog that appears when you choose PDF from the List Format pop-up menu contains
additional formatting settings. See PDF Configuration Settings in the Export Film Lists
Dialog for more information about configuring PDF film lists.

The export dialogs have these settings in common:

• List Title: Enter a name for the film list file you are going to export.

• Film Standard: Choose the film standard that matches the type of film you are using.
This should be the same as the film standard setting you used when you created the
project database. Cinema Tools uses the film standard that you choose here to calculate
footage counts in the cut list.

• Telecine Speed: Select the speed at which the film was transferred:

• If you are working with NTSC video: You would typically choose 24 fps, though the
actual speed of the film in the telecine was approximately 23.98 fps.

• If you edited NTSC video that was transferred at 29.97 fps: Choose 30 fps.

• If your film was transferred to video at 24 fps: Choose 24 fps.

• If your film was transferred to video at 25 fps: Choose 25 fps.

• Duplicates: Choose whether you want to be notified when duplicate usage of source
material is found. If you choose Warn, a warning message appears in the cut list every
time a duplicate usage occurs. The message tells you exactly which frames have been
used more than once and exactly where in your editing project they are used. All of
these messages also appear in a double usage warning list. If you choose Ignore, these
double usage warnings do not appear.
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• Transitions: Choose how transitions should be listed in the film list. See Contact Printing
vs. Optical Printing for more information.

Note: Cinema Tools identifies the set of standard lengths for 24 fps or 23.98 fps media
as 16, 24, 32, 48, 64, and 96 frames in duration. Cinema Tools identifies the set of
standard lengths for 29.97 fps media as 20, 30, 40, 60, 80, and 120 frames in duration.
(Make sure to check with your contact printer about the standard lengths required for
different frame rates.)

There are three choices for how transitions are listed in a film list:

• All are cuts: All transitions are represented by a cut in the middle of the transition,
regardless of whether or not the transitions are of standard length. Choose this option
if you are exporting a list for use in conforming a workprint. Cinema Tools also inserts
notes to indicate where the start and end of the transition should be for both the
outgoing and incoming clips. These notes can be used as a guide in marking the
transitions on the conformed workprint.

• Std are cuts: Those transitions that are of standard length are listed as cuts, and those
that are of nonstandard length are described as opticals. This is the option that you
choose if you’re going to have your transitions printed on a contact printer. If you
choose this option, standard-length transitions appear in the cut list, not the optical
list, and are shown as a cut in the middle of the transition. The starting and ending
points of the transition also appear in the cut list as three lines for a dissolve and two
lines for a fade. The cut list contains all of the information that the negative cutter
requires to prepare the A and B rolls for these transitions.

• All are opticals: All clips that are part of a fade or dissolve are listed in the optical list.
Choose this option if you want all of your fades and dissolves to be printed optically,
regardless of their length.

• Handles: Your negative cutter or optical printer may want to have some spare frames
on either side of a transition. These extra frames are called transition handles. Enter a
number between 0 and 32. When checking to see if any frames are used more than
once, Cinema Tools adds this number of frames plus one-half to the head of the
incoming shot and the tail of the outgoing shot for each transition. (The setting you
choose for cut handles does not apply to transitions.)

• Cut Handles: In determining whether or not any frames have been used more than
once, Cinema Tools assumes that at least one-half of a frame is destroyed at both the
In point and the Out point of each cut. Some negative cutters may want to use more
than a half-frame on each side of a cut. You can specify up to five and one-half frames
of cut handles. If you inadvertently include, in a sequence, frames that are needed as
cut handles, Cinema Tools reports them as duplicate usages in the duplicate list and
the double usage warnings.

• Track: You can choose the video track to base the exported list on.
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• Starting Footage: Enter a starting number to use for the film list’s “Feet & frames” value.
The default value is 0000+00.

Following are some tips for how to use the “Starting” entries:

• If you are generating a cut list for conforming the negative: You typically want to start
at zero.

• If you are editing your film by scene or by reel: You may want to enter a starting point
in the “Starting” fields that is the same as the ending point of the preceding scene
or reel. This field is automatically filled in with the sequence starting point you have
set in the Final Cut Pro Timeline.

• If you want to generate a cut list with timecode so that you can compare events in the
list with edits in Final Cut Pro or in the EDL: Start the cut list at the same timecode value
as the Timeline sequence or the EDL start time.

• Starting Time: Enter a starting timecode number for the film list’s Time value. The default
value is the sequence’s starting timecode value.

• Starting Count: Enter a starting frame count number for the film list’s Count value. The
default value is 0000.

• Save a Cinema Tools program file: A program file can be used if you want to later create
a change list for this sequence, reflecting any edits you make after this point.

Note: You can also use a Final Cut Pro XML file for this sequence to create a change
list. See About Exporting Change Lists for more information.

A program file is also needed if you want to export an audio EDL from Cinema Tools.
Exporting an audio EDL from Final Cut Pro is more automated and does not require a
Cinema Tools program file. See Exporting an Audio EDL for more information.

• Start with 8 seconds of leader: Choose whether or not to start the cut list with 8 seconds
of leader. Eight seconds is the standard length of Academy or SMPTE leader. If you
select this option, 8 seconds of leader is inserted at the beginning of the cut list. If you
have already included a leader clip at the beginning of the sequence, do not select this
checkbox. (It’s better to use a leader clip in your sequence instead of selecting this
option in the cut list because the timecode in the digital sequence will not match the
timecode in the cut list unless a leader clip actually exists in the sequence.)

Note: The Extras folder on the Final Cut Studio installation disc contains a folder with
head leader clips and a document explaining how to use them.

• Film list checkboxes: Select the list types to include in the exported film list.

• Cut List: Select to include a cut list. See Cut List for more information.

• Dupe List: Select to include a duplicate list. See Duplicate List and Double Usage
Warnings for more information.

• Optical List: Select to include an optical list. See Optical List for more information.

• Pull List: Select to include a pull list. See Pull List for more information.
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• Scene List: Select to include a scene list. See Scene List for more information.

• Missing Elements List: Select to include a missing elements list. See Missing Elements
List for more information.

PDF Configuration Settings in the Export Film Lists Dialog
When exporting a PDF-format film list, you can control which items appear in the list and
their order. This allows you to create a film list that includes exactly the information you
require.

To add items to the PDF film list
µ Drag items from the left column to the right column.

The right column lists
the items in the order 
that they will appear
in the PDF film list.

The left column lists
all of the possible items 
that can appear in the 
PDF film list.

To remove items from the PDF film list
µ Select items in the right column and press Delete.

To set the order of the items in the PDF film list
µ Drag items up and down in the right column.

The width of the PDF film list is limited, and it is possible to add more items than will
actually appear in the list. By using the settings in the Layout Options area of the Export
Film Lists dialog, you can customize the PDF page layout and font size so that more
selected columns will fit.
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To customize the PDF page layout
1 Choose Portrait or Landscape from the Orientation pop-up menu.

2 Choose a font size from the Font Size pop-up menu.

You can save and load settings files that include the column configuration and the
Orientation and Font Size settings. Additionally, most of the other settings in the dialog
are also saved as part of the settings file. The exceptions are the Track, Starting Footage,
Starting Time, and Starting Count settings.

Being able to save and load settings files for this dialog makes it easy to configure multiple
Cinema Tools systems to export lists with the same configuration.

Note: The dialogs you use to export film lists and change lists automatically remember
the last settings you used and will use those settings the next time the dialog appears.

To save the current settings
1 Click the Save Settings button.

2 Enter a filename and location for the settings file in the dialog that appears.

3 Click Save.

To load a settings file
1 Click the Load Settings button.

2 Select the settings file and click Open.

Following is a list of the items you can choose to include in your exported PDF film list.

ShowsPDF nameItem name

Running footage count starting with the Starting
Footage value

FootageFeet & frames

Running timecode starting with the Starting Time
value

TimeTime

Running frame count starting with the Starting
Count value

CountCount

Length of each event in feet and framesLengthFootage length

Length of each event in timecodeLengthTime length

Length of each event in framesLengthCount length

Starting source key number of each eventPrefix and KeyKey numbers

Starting source ink number of each eventPrefix and InkInk numbers

Source reel numberReelSource reel

Starting source timecode value of each eventSrc TimeSource time

Starting and ending source frame countsSrc CountSource count

Camera roll numberCam RollCamera roll
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ShowsPDF nameItem name

Lab roll numberLab RollLab roll

Daily roll numberDly RollDaily roll

Source clip nameClip NameClip name

Scene and take settingsScene and TakeScene & take

Starting and ending frame DPX filenamesDPX FrameDPX frame

Creating Change Lists
A change list reports the differences between two versions of a sequence edited in
Final Cut Pro. For film-based projects, the purpose of the change list is to describe the
changes that need to be made to the workprint or negative since it was conformed to a
prior version of the sequence. For DI projects, change lists are used to let other
departments, such as the sound department or closed captioning department, know the
details about changes you have made to the sequence.

When you export a change list, you can also choose to include in the change list file a
change pull list, which lists film rolls in the order in which they need to be pulled to add
any new film to the workprint, and a discard list, which lists any sections that need to be
removed.

When you export a change list file from Final Cut Pro, you can also export a new cut list
(and other standard film lists) for the sequence.

When creating the change list, Cinema Tools uses a variety of methods to match up the
original and new edits to generate the change list. Following is a list of the methods in
order from most reliable to least reliable:

• Each clip’s unique identifier

• The reel number and timecode values

• Keycode (key numbers or ink numbers)

• Clip name
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When Are Change Lists Used in a Film Workflow?
Change lists are typically used in a cyclical workflow that involves digital editing, sound
conforming, and workprints.

Workprint
screening

Create
workprint

Conform original
camera negative to latest

cut list and workprint

Transfer
to video

Export cut list

Yes No

Export
change list
and cut list

21

More changes
required?

Final Cut Pro with
Cinema Tools database

Edit sequence

Conform
workprint to
change list

Conform
workprint to

cut list

Following is a typical workprint-based change list workflow.

Stage 1: Making a Workprint Video
Make a workprint from the original camera negative, with ink numbers applied to the
edge, and make a telecine transfer video of the workprint.

Stage 2: Exporting a Cut List of the Edited Workprint Video
Edit the workprint video in a digital editing system and export a cut list (usually based
on ink numbers) to use as a guide to conform the workprint, as well as either a
Cinema Tools program file or a Final Cut Pro XML file from the sequence to use when
exporting the change list.

Stage 3: Projecting the Cut Workprint
Project the cut workprint for screenings, and make decisions to cut or add to the movie.

Stage 4: Making Changes in the Editing System
Make any changes to the movie in the digital editing system.

Stage 5: Exporting a Change List to Conform the Workprint to the Changes
Export a change list, which provides instructions for modifying the workprint to conform
to the new version of the movie.

Stage 6: Conforming the Workprint Using the Change List
With the change list as a guide, conform the workprint to match the new version of the
movie.
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Stages 3 through 6 are repeated until it is decided that the picture is locked. Finally, the
original camera negative is cut to match the final workprint and cut list.

When Are Change Lists Used in Other Workflows?
Change lists can be used in a variety of other workflows, including those that do not
involve film at all. These include digital intermediate, sound conforming, and closed
caption workflows—any workflow where you need to know what has changed between
two edited versions of a program.

The key to being able to export a change list is to have available either a Final Cut Pro
XML file or a Cinema Tools program file that represents the previous version of the
sequence. If you export the change list using Final Cut Pro, the file representing the
previous sequence version is compared against the current sequence. If you choose to
export the change list using Cinema Tools, you will need a second Final Cut Pro XML file
or a Cinema Tools program file that represents the current sequence. See About Exporting
Change Lists for details to help you choose how to export your change lists.

21

Change list (for sound
conforming, and so on)

More changes
required?

Screen
program

Exported
XML for

second edit

Exported
XML for

initial edit

Final Cut Pro

Edit
sequence

Cinema Tools

Export
change list

Yes

Following is a typical workflow for using Final Cut Pro XML files to export a change list
for use in a nonfilm project.

Stage 1: Completing the Initial Edit of the Program
Edit your program using Final Cut Pro as usual.
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Stage 2: Exporting an XML File of the First Version of the Program
After you have finished the initial edit of your program and are ready to screen it and
have other departments such as sound conforming and closed captioning begin working
on it, you need to export a Final Cut Pro XML file for the program’s sequence. This XML
file provides a snapshot of the current state of the project. It is required if you end up
making changes to the project later and want to export a change list.

Note: An alternative approach is to save a copy of the initial sequence. You can later
export the Final Cut Pro XML file by opening that saved initial sequence.

Stage 3: Screening the Program and Making Changes
After you screen your program, you may find that you need to make some changes to it.
Make the changes as needed.

Stage 4: Exporting an XML File of the Revised Program
After you have finished the second edit of the program and are again ready to screen it,
you can either export the change list directly from Final Cut Pro or export a new
Final Cut Pro XML file and use Cinema Tools to export the change list.

Note: If there is a chance of additional revisions, you should export a new Final Cut Pro
XML file even if you are going to generate the change list using Final Cut Pro, because
the XML file will be needed to generate future change lists.

Stage 5: Exporting a Change List
The biggest difference between exporting a change list using Final Cut Pro and exporting
one using Cinema Tools is that with Final Cut Pro you can choose to include any of the
other traditional film lists along with the change list. There are other potentially significant
differences discussed in About Exporting Change Lists.

• To export a change list from Final Cut Pro: You select the first version’s XML file
(Final Cut Pro assumes you want to compare this with the current sequence, so the
second XML file is not used) and choose the type of list to export (PDF-format,
XML-format, or style sheet–based).

• To export a change list from Cinema Tools: You simply select the two XML files to compare
and choose the type of list to export (PDF-format, XML-format, or style sheet–based).

Stage 6: Using the Change List
How you use the change list depends on the style of change list you chose to output
(PDF-based, XML-based, or a custom output based on a style sheet) and who the list is
intended for. A PDF version of the change list might be used by the sound department
to manually adjust the parts of the program the sound editors are working with, or an
XML version might be part of an automated process providing the closed captioning
department with new video clips to work on.
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About Exporting Change Lists
You can export change lists from either Final Cut Pro or Cinema Tools. This section
describes the differences between the two methods. See Exporting Change Lists Using
Final Cut Pro and Exporting Change Lists from Within Cinema Tools for details about the
change list export process.

This section also describes the differences between using Final Cut Pro XML files and
Cinema Tools program files when exporting change lists.

Exporting from Final Cut Pro
When you export a change list from Final Cut Pro, the following rules apply:

• In addition to the change list–specific change pull list and discard list, you have the
option to include all of the standard film lists such as a cut list, a duplicate list, and so
on.

• The change list’s frame rate is determined by the Telecine Speed setting in the Export
Change List dialog. If you choose a Cinema Tools program file to represent the original
edit, the program file must be based on the same telecine speed. This means that you
can only export a change list from Final Cut Pro that uses a frame rate supported by a
Cinema Tools database (24 fps, 25 fps, or 30 fps). However, you can export a change
list from Cinema Tools that is based on nonsupported frame rates such as 50 fps or
59.94 fps.

• You must select a Cinema Tools database. If you are not concerned about film-based
settings such as key numbers or camera rolls, you can select any database, or even
create an empty database in Cinema Tools to be used for this purpose.
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The following diagram shows the basic process when exporting a change list from
Final Cut Pro. After you finish the initial edit of the program, you export a Final Cut Pro
XML file (or a Cinema Tools program file if you are using a film-based workflow) and
screen the program. If changes are required, you make the edits in the sequence and
then export a change list that compares the file representing the initial edit with the
current sequence.

Yes

Change list (for sound
conforming, and so on)

21

Exported
XML for

initial edit

Final Cut Pro

Edit
sequence

Export
change list

More changes
required?

Screen
program

Exporting from Cinema Tools
When you export a change list from Cinema Tools, the following rules apply:

• You must have two files: one that represents the original sequence and another that
represents the new sequence.

• You can use a mixture of Final Cut Pro XML files and Cinema Tools program files as the
original and new sequences.

• The frame rates of the original and new files must be the same.

• By using Final Cut Pro XML files for the original and new versions of the sequence, you
can output a change list with a frame rate that is not actually supported by a
Cinema Tools database, such as 59.94 fps or 50 fps. This can be useful in nonfilm-based
DI workflows. (Cinema Tools program files always use a frame rate supported by
Cinema Tools databases.)

Note: Change lists exported from Final Cut Pro are always based on
Cinema Tools–supported telecine speed (TK Speed) frame rates, as specified in the
Export Film Lists dialog. These frame rates include 24 fps, 25 fps, and 30 fps.
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• You cannot export any of the standard film lists, such as a cut list or a duplicate list,
along with the change list, as you can from Final Cut Pro. You can include the change
list–specific change pull list and discard list.

The following diagram shows the basic process when exporting a change list from
Cinema Tools. After you finish the initial edit of the program, you export a Final Cut Pro
XML file (or a Cinema Tools program file if you are using a film-based workflow) and
screen the program. If changes are required, you make the edits in the sequence and
then export a new Final Cut Pro XML file. In Cinema Tools, you export the change list by
comparing the file representing the initial edit and the file representing the current edit.
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Should You Use XML or Program Files?
There are a few differences between using a Final Cut Pro XML file and a Cinema Tools
program file when exporting a change list. These differences can help you decide which
approach is the best for you to take.

• When you export a Cinema Tools program file, you must also export a film list. If you
do not need a film list, exporting a Final Cut Pro XML file is simpler. If you do need a
film list, it is easy to add a Cinema Tools program file to that process and avoid having
to go through a second export process to create the Final Cut Pro XML file.
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• Cinema Tools program files must use a valid telecine speed (24 fps, 25 fps, or 30 fps)
as the frame rate. If you are not working on a film project and are using a frame rate
other than the supported telecine speed frame rates, exporting a Final Cut Pro XML file
retains the sequence’s frame rate. This frame rate is maintained if you export the change
list using Cinema Tools.

Exporting Change Lists Using Final Cut Pro
Exporting a change list is similar to exporting a cut list. Take note of the following before
you start:

• Only one video track is compared: A change list describes the difference between a
selected video track in one sequence and a selected video track in another sequence.
It does not describe any other video or audio tracks.

• Avoid modifying the Cinema Tools database between exporting change lists: When a
database is altered after the previous list was exported, the new change list may not
be reliable. However, if you did alter the database after you exported the previous list,
you can eliminate this risk by exporting a new cut list for the previous sequence and
saving a new program file. Then, use that program file when you export the change
list.

• If you have each reel in a separate sequence in Final Cut Pro, and you want to do some reel
balancing: Perform the reel balancing edits after any other changes. See If You Need
to Reel Balance for more information.

See Exporting Change Lists from Within Cinema Tools for information about exporting
change lists using Cinema Tools. See About Exporting Change Lists for information about
how the change list export process differs between Final Cut Pro and Cinema Tools.
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About Change Lists, Effects, Gaps, and Soundtracks
If you add motion effects to a program, an optical will have to be made, and the length
of that section of film changes, affecting the sync. The film assistant who conforms the
workprint needs to know where to put in slug (fill leader or substitute footage) in order
to preserve synchronization while the optical is being made. For this reason, Cinema Tools
lists motion effects in the change list similarly to the way it displays leader information.
For motion effects, “Insert Leader” appears in the Do This column, and “Effect” is displayed
under the First/Last Key column. Gaps in a sequence are also described as leaders in
change lists.

A change list does not provide information about transitions, superimposed titles
(“supers”), filters, or soundtracks. However, to see whether or not any transitions or
supers were changed or added, you can export a cut list and an optical list for each of
the sequences and compare the lists. Or, if you are marking the transitions on the
workprint, you can export a cut list with the change list and run the conformed workprint
through the synchronizer, noting where the transitions start or end at different places
in the cut list.

To export a change list using Final Cut Pro
1 In Final Cut Pro, select the new version of the sequence, then choose File > Export >

Cinema Tools Change List.

2 In the dialog that appears, click Choose to bring up a dialog to choose either the
Cinema Tools program (.pgm) file that you saved when you exported a film list for the
previous version of the sequence or the Final Cut Pro XML file you exported for the
previous version of the sequence. (They contain needed information about the previous
sequence.)

3 If you chose a Final Cut Pro XML file, choose the track number to compare from the
Original Track pop-up menu.

4 Choose the type of list to output from the List Format pop-up menu.

The choices are PDF, XML, and With Style Sheet. See About PDF-Format Film Lists, About
XML-Format Film Lists, and About Style Sheet–Based Film Lists for information about
these formats.

5 If you chose With Style Sheet from the List Format pop-up menu, choose a style sheet
from the Style Sheet pop-up menu.
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6 Click Continue.

There are two different dialogs that can appear: one for PDF output and one for XML and
With Style Sheet output. The differences are similar to those between the Export Film
Lists and Export XML Film Lists dialogs.

7 In the Export Change List dialog that appears, configure the settings, then click Export.

See Settings in the Export Change List Dialog for details.

These lists provide 
information about
the entire sequence.

These lists provide 
information about

the changes.

When you select film list options such as Cut List and Pull List in the Settings area of the
Export Change List dialog, the change list file includes (in addition to the selected change
list options) the same content you would get if you exported those lists from the Export
Film Lists dialog.

Note: Keep in mind that the following settings should be the same for the two sequences
you are comparing: Film Standard, Telecine Speed, whether key numbers or ink numbers
are in the Included Columns area, and whether the “Start with 8 seconds of leader”
checkbox is selected. The two sequences must also have the same editing timebase (set
in Final Cut Pro).

8 In the dialog that appears, enter a filename and choose a location.

9 Click Choose Database to choose the database associated with the clips in the sequences
you are comparing. (Make sure you select the same database that was used when the
previous list was exported.)
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10 Click Save.

11 If you selected “Save a Cinema Tools program file,” enter a filename and location for the
file in the dialog that appears, then click Save.

Give the program file a name that clearly identifies the sequence and the version, so that
you can easily locate the file later if you need to export another change list.

A change list file is generated that contains all the lists you selected in the Export Change
List dialog.

If You Need to Reel Balance
In reel balancing, heads and tails of reels are reapportioned to make sure the length of
each reel is in the right range.

If you want to do any reel balancing in Final Cut Pro, perform the reel balancing edits
separately from any other changes. For instance, to move a scene from the head of one
reel to the tail of another, first conform the two reels to the change lists exported from
their associated sequences. Then, in Final Cut Pro, cut the scene from the head of the
sequence for reel 1 and paste it at the tail of the sequence for reel 2. Finally, export new
change and cut lists for both sequences and use those lists as a guide for balancing the
two reels. Note that shots deleted from one reel should be exactly the same length as
the shots added to the other reel.
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Settings in the Export Change List Dialog
The Export Change List dialog that you access from within Final Cut Pro contains the
same settings as the Export Film Lists dialog (described in Settings the Export Dialogs
Have in Common) and, if you chose PDF from the List Format pop-up menu, the same
PDF column options (described in PDF Configuration Settings in the Export Film Lists
Dialog), with the exceptions and additions described below.

The Export Change List dialog contains these settings that are either not available in the
Export Film Lists dialog or are used differently:

• Transitions: The best choice for handling transitions when you export a change list is
“All are cuts,” in which transitions are represented by a cut in the middle of the transition,
regardless of whether or not the transitions are of standard length. Cinema Tools inserts
notes in the cut list (exported with the change list) to indicate where the start and end
of the transition should be for both the outgoing and incoming clips. These notes can
be used as a guide in marking the transitions on the conformed workprint. See Settings
the Export Dialogs Have in Common for information about the other settings.

• Change List Options: The following options control what is included in change lists:

• Pull List: Select to include a change pull list, which lists any film that needs to be
newly added to the workprint.

• Discard List: Select to include a discard list, which lists only clips that need to be
removed from the workprint.

• Show only changes: If this option is selected, the change list displays entries for new
edits only. Unchanged footage is not listed. (However, if the Cut List checkbox is
selected, a cut list is included in the change list file, listing all the footage in the
sequence, including the unchanged footage.)
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• Combine deletions: If this option is selected, footage deletions that are contiguous
are listed as one deletion rather than individual deletions. This instructs the film
assistant to cut them as a lift, a series of pieces removed as one piece and stored
intact, rather than as individual pieces. Film assistants tend to prefer seeing and
performing the series as one deletion because it saves time and effort.

About the PDF Items and Change Lists
Unlike cut lists, for the most part change lists cannot be customized. Change lists provide
specific information and must have the columns to support that information. However,
the items you drag to the right column in the Export Change List dialog can affect the
type of data that appears in those columns. You need to add one item from each of these
four categories:

• Time measurement: “Feet & frames,” Time, or Count

• Name identifier: “Scene & take” or “Clip name”

• Roll number: “Camera roll,” “Lab roll,” or “Daily roll”

• Edge code: “Key numbers” or “Ink numbers”

Important: If you add multiple items of one type (for example, if you add both “Key
numbers” and “Ink numbers” to the right column in the Export Change List dialog), the
one that appears first in the right column is used by the change list.

If you choose to include a cut list with your change list, you can add additional items to
the right column and arrange them in the order in which they should appear in the cut
list.

Note: Although XML output contains all change list information, the style sheet you
choose for the Style Sheet output format determines which information appears in the
output. If you use the supplied Plain Text style sheet, the information included in the
output depends on how the last PDF-format style sheet was output. In other words, what
you choose for the above four categories when you output a PDF-format change list also
affects the Style Sheet output when you choose the Plain Text style sheet.

Exporting Change Lists from Within Cinema Tools
If the most recent version of a sequence is not available or conveniently accessible, or if
it is damaged, you can still create a change list as long as you have the exported program
(.pgm) files or XML (.xml) files for the two sequences you need to compare. You can export
the change list from Cinema Tools using the program or XML files instead of exporting
the change list from Final Cut Pro (where you need to select a sequence).
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When you export a change list from within Cinema Tools, you cannot include a cut list
or any of the other film lists that you can export using the Export Film Lists dialog; you
can only export lists and information specific to change lists. See About Exporting Change
Lists for information about how the change list export process differs between Final Cut Pro
and Cinema Tools.

To open the Export Change List dialog in Cinema Tools
1 Choose File > Export > Change List.

2 In the dialog that appears, choose the original and new program or XML files to be
compared.

You can use a mix of program and XML files if necessary.

3 Choose the output format of the change list from the List Format pop-up menu.

The choices include PDF, XML, and With Style Sheet. See About PDF-Format Film Lists,
About XML-Format Film Lists, and About Style Sheet–Based Film Lists for information
about these formats.

4 If you chose With Style Sheet from the List Format pop-up menu, choose a style sheet
from the Style Sheet pop-up menu.

5 Click Continue.

6 Configure the settings in the Export Change List dialog that appears, then click Export.

Note: The settings in the dialog change based on the output format you chose from the
List Format pop-up menu. See Settings in the Cinema Tools Export Change List Dialog
for details about the settings you see in this dialog.

Settings in the Cinema Tools Export Change List Dialog
The settings available in the Export Change List dialog when exporting from Cinema Tools
change based on the output format you chose from the List Format pop-up menu.
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Settings Common to All Output Formats
Following are the settings that appear in all versions of the Export Change List dialog
when exporting a change list from Cinema Tools.

• Original Track: Choose the video track to compare from the original sequence.

• New Track: Choose the video track to compare from the new sequence.

• Pull List: Select to include a change pull list, which lists any film that needs to be newly
added to the workprint.

• Discard List: Select to include a discard list, which lists only clips that need to be removed
from the workprint.

• Show only changes: If this option is selected, the change list displays entries for new
edits only. Unchanged footage is not listed.

• Combine deletions: If this option is selected, footage deletions that are contiguous are
listed as one deletion rather than individual deletions. This instructs the film assistant
to cut them as a lift, a series of pieces removed as one piece and stored intact, rather
than as individual pieces. Film assistants tend to prefer seeing and performing the
series as one deletion because it saves time and effort.

Settings Only in the PDF Output Format
The following settings appear only if you chose PDF from the List Format pop-up menu.

Settings available
only for PDF-format
change lists
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Note: Although XML output contains all change list information, the style sheet you
choose for the Style Sheet output format determines which information appears in the
output. If you use the supplied Plain Text style sheet, the information included in the
output depends on how the last PDF-format style sheet was output. In other words, the
settings for the two Show pop-up menus that appear when you output a PDF-format
change list also affect the Style Sheet output when you choose the Plain Text style sheet.

• Show (upper): Choose the time measurement to use. The choices are Feet & Frames,
Time, and Count.

• Show (lower): Choose how to identify each event. The choices are Scene & Take and
Clip Name.

• Orientation: Choose Landscape or Portrait for the PDF output. Using Portrait allows
you to use a larger font.

• Font Size: You can choose a font size for the output.

Working with XSL Style Sheets
If you have no prior experience working with Extensible Stylesheet Language (XSL) style
sheets but are reasonably comfortable looking at XML data, you can create your own
custom style sheets. There are many books and Internet resources available to help you
learn about working with XML data using XSL style sheets.

Important: The following information is intended to give you a basic understanding of
the process and is not a complete reference guide.

A good place to start is to export an XML film list and look at it in a text editor. TextEdit
can be used to view and edit XML and XSL files, although if you find yourself frequently
working with these file types, you should get a specialized application with built-in tools
specifically for working with these sorts of files, such as Oxygen or BBEdit.

XML Film List Basics
XML film lists begin with a list of items showing the settings in the Export Film Lists dialog.
This is followed by sections for each type of list you included in the film list, such as a cut
list and pull list. Each of these list sections include the appropriate events, and each event
includes a complete list of the items that Cinema Tools tracks. Following is a simplified
example of this structure.
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<ctlists>

   Settings from the Export Film Lists dialog

   <cutlist>

      <items>

         First event

            Items in this event

         Second event

            Items in this event

      </items>

   </cutlist>

   <pulllist>

      <items>

         First event

            Items in this event

         Second event

            Items in this event

      </items>

   </pulllist>

</ctlists>

When you set up a style sheet, you generally start by defining the list information you
want to output (cut list, pull list, and so on). You then define the specific items in that
list’s events that you want included in the output, such as key numbers and source
timecode start and end points.

Pull List Style Sheet Example
A simple style sheet to start out with is the supplied Pull List style sheet. Make a copy of
the file (see About Style Sheet–Based Film Lists for details about where to find the file)
and give it a name you can easily recognize.

When you open the copy of the Pull List style sheet in a text editor, there are two main
sections that appear, with these lines at their head:

• <xsl:template match="ctlists/pulllist/items">: This section lists the column headings for
all of the items that are included in the list. The path that is listed,
ctlists/pulllist/items, directs this section to the events in the pull list area of the
film list.

• <xsl:for-each select="pull">: This section lists the specific items in each pull list event
to output. (Each event in a pull list is wrapped by a pull element.)

If you want to add or remove an item from the pull list output, you need to make a change
to both sections—the first section that controls the column headings and the second
section that specifies the data to put under those headings.
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For example, if you want this style sheet to output ink numbers and not key numbers,
you would make the following changes:

• In the heading section: Modify the following three lines:

• Change <xsl:text>Key Prefix</xsl:text>&tab; to <xsl:text>Ink

Prefix</xsl:text>&tab;

• Change <xsl:text>First Key</xsl:text>&tab; to <xsl:text>First

Ink</xsl:text>&tab;

• Change <xsl:text>Last Key</xsl:text>&tab; to <xsl:text>Last

Ink</xsl:text>&tab;

If other names better suit your workflow, you can enter whatever text you like into the
data part of these lines. Additionally, if you want to leave the original lines as they are
and just add new lines for the ink numbers, you can do that, but keep in mind that this
will make the output wider, which could make the output file difficult to print if that’s
your final goal.

Another option is to change the key number–based lines into comments by preceding
each line with <!-- and following each with -->. For example, <!--<xsl:text>Key
Prefix</xsl:text>&tab;--> is treated as a comment and is ignored when the file is
used to process the XML film list.

• In the item selection section: Modify the following three lines:

• Change <xsl:value-of select="keyprefix"/>&tab; to <xsl:value-of

select="inkprefix"/>&tab;

• Change <xsl:value-of select="keynumstart"/>&tab; to <xsl:value-of

select="inknumstart"/>&tab;

• Change <xsl:value-of select="keynumend"/>&tab; to <xsl:value-of

select="inknumend"/>&tab;

If you added or removed lines in the heading section, you must add or remove lines
in this section as well. The values you use here, such as inkprefix, must exactly match
the way they appear in the film list XML file. The order of the items is important as well,
because that order determines how the items match the heading names.

After you have modified the Pull List XSL file, you can try it out and verify that you get
the correct output.
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After you’ve edited your project, you may want to export to videotape, export the audio,
or export an audio EDL based on the edited project.

This chapter covers the following:

• About Common Items You Can Export for Your Project (p. 193)

• Considerations When Exporting to Videotape (p. 194)

• Considerations When Exporting Audio (p. 194)

• Exporting an Audio EDL (p. 195)

About Common Items You Can Export for Your Project
The primary goal of using Cinema Tools is to generate an accurate cut list. For most
projects, you may also want to create other helpful items from your edited program:

• A videotape of the program: This may be useful so that you can show the program to
others or provide a visual guide to the negative cutter. There are a number of
considerations to take into account, such as the editing frame rate and any required
specialized hardware. See Considerations When Exporting to Videotape for details.

• A file containing the program’s audio: You usually create this file if you want to use the
program’s audio but finish it using a specialized application or an audio post-production
facility. There are a couple of approaches you can take to do this, and several issues
you must be aware of. See Considerations When Exporting Audio for details.

• An audio EDL: This is required when you intend to recapture the audio using specialized
equipment and reedit it using the audio timecode from the edited program. See
Exporting an Audio EDL for details.
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Considerations When Exporting to Videotape
You may want to make a videotape of your edited program, either to make it easier to
view the program or to provide a visual reference for the negative cutter. There are a few
ways to create a videotape from an edited sequence, and these methods are explained
in the Final Cut Pro documentation. However, if you edited video at 24 fps and you want
to create a PAL or NTSC videotape, there are additional considerations explained here.

When you make a videotape from a 24 fps sequence, some video output devices create
an NTSC or PAL signal by inserting extra fields as needed to go from 24 fps to 25 fps or
29.97 fps. Such a tape is generally fine for viewing, but not as accurate as it should be if
it is to be used as a visual reference in cutting the negative. Make sure to let your negative
cutter know if there are issues with the videotape (for example, if the video occasionally
displays the wrong frame).

Considerations When Exporting Audio
Depending on your project’s needs, you may be able to use the edited audio from
Final Cut Pro directly in the film’s release print. More often you will want to finish the
edited audio using a specialized application or a facility specializing in audio finishing.
This is typically where sound effects, music, and any dialogue are added or enhanced.

There are a couple of items to consider when exporting audio:

• The type of audio file required: You can export an Open Media Framework (OMF) or
Audio Interchange File Format (AIFF) file.

• The audio speed: Depending on how the video was transferred, you may have slightly
altered the speed of the audio to maintain synchronization.

If you decide to recapture and reedit the audio at an audio post-production facility, see
Exporting an Audio EDL for details.

OMF Files
An OMF file contains not only the audio, but also a description of the audio edits. Digital
Audio Workstations (DAWs) that can import OMF files can take advantage of having the
edit In and Out points along with other information, such as cross fades, enabling them
to make small changes. OMF files typically contain all of the audio tracks used in the
program (other export formats have limits).

Another advantage of OMF files is that they can contain the audio and edit information
from non-timecode-based sources, such as audio CDs. (Audio EDLs describe only edits
using timecode-based sources and do not include any references to sources such as audio
CDs.)

See the Final Cut Pro documentation for information about exporting OMF files.
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AIFF Files
An AIFF file contains only the audio and cannot be easily changed. You must export a
separate file for each audio track. As with OMF files, AIFF files can contain the audio from
non-timecode-based sources, such as audio CDs. (Audio EDLs describe only edits using
timecode-based sources.)

See the Final Cut Pro documentation for information about exporting multiple tracks as
AIFF files.

Audio Speed
Often the playback speed of the edited audio is slightly different from what it was when
it was originally recorded (its natural speed). This compensates for film speed changes
made during the telecine transfer. Anytime you are editing at 29.97 fps or 23.98 fps, the
audio is running 0.1 percent slower than its natural speed. If you are editing at 25 fps and
the telecine transfer film rate was 25 fps, the audio is 4 percent faster.

This speed difference is maintained when you export an AIFF or OMF file. Make sure to
find out the requirements of your audio post-production facility with regard to audio
speed issues before you export the files.

Exporting an Audio EDL
Just as the final edited video from Final Cut Pro is not generally used when conforming
the negative, the edited audio might not be used. If you intend to recapture and reedit
your audio at an audio post-production facility, you need an audio Edit Decision List (EDL)
indicating how the audio clips are used in the edit.

Although the Final Cut Pro EDL contains both video and audio information, it may not
contain references to the timecode and roll numbers from the original production sound
rolls, depending on how the clips were captured and how the video was synced to the
audio. A Cinema Tools database makes it possible to generate an audio EDL with the
original production audio timecode and sound roll information.

Where’s the Audio Timecode?
Film productions use dual system recording (separate camera and audio deck) for capturing
the pictures and sound. You must sync the two of them together, either during the
telecine transfer or before capturing the clips with Final Cut Pro.
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If your audio is synced during the telecine transfer and recorded onto the audio tracks
of the videotape, the timecode and roll number of the original sound roll is no longer
part of the clip, and all edits within Final Cut Pro refer only to the video timecode and
reel number. Fortunately, the telecine log created during the transfer usually contains
the audio information and adds it to the database when you import the log into
Cinema Tools. You can also manually enter the audio information if no telecine log is
available.

Using Cinema Tools to Export an Audio EDL
Cinema Tools can export an audio EDL as long as its database contains accurate audio
information (an audio timecode number that corresponds to the first video frame of the
clip and the sound roll number) in each record. Because of the way audio is recorded
during the production (using dual system recording—a separate sound recorder that is
started and stopped independently of the camera), the Cinema Tools Export Audio EDL
function is applicable only when the project database has a record for each take (as with
scene-and-take transfers).

It is critical that the value in the Sound Timecode field correspond directly to the first
video frame of the clip. This is typically the case when you import the audio information
from a telecine log. Use the Clip window’s Identify feature to enter (or verify) the audio
timecode value for a known point in the clip (most often at slate close). Based on this
value, Cinema Tools calculates the timecode for the first frame. See Using the Identify
Feature to Calculate Database Information for more information.

After you have finished editing and have added the audio timecode and sound roll
information to the database, you are ready to export the audio EDL.

You generally open the Export Audio EDL dialog from within Final Cut Pro. You can also
open it from within Cinema Tools if necessary, although additional steps are required,
including the creation of a program file in the Export Film Lists dialog. See Using the
Export Audio EDL Feature from Cinema Tools for more information.

To export an audio EDL from Final Cut Pro using Cinema Tools
1 In the Final Cut Pro Timeline or Browser, select the sequence from which you want to

export an audio EDL.

2 Choose File > Export > Cinema Tools Audio EDL.
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Cinema Tools opens and its Export Audio EDL dialog appears.

3 Enter and select settings in the Export Audio EDL dialog, then click OK. See Settings in
the Export Audio EDL Dialog for settings information.

4 In the dialog that now appears, select the Cinema Tools database file to use, then click
Choose.

Once you select the database, Cinema Tools starts matching events in the sequence to
it:

• For each edit involving a track enabled in the Export Audio EDL dialog, Cinema Tools
searches the database to see if that edit’s video clip is connected to any database
records. If not, it uses the edit’s video reel number to try to locate a record that includes
the edit’s timecode In and Out points. See Audio Track Usage for more information
about audio tracks.

• If Cinema Tools finds a suitable record, it checks whether that record includes audio
information (audio timecode and sound roll number). If so, an entry is added to the
EDL and Cinema Tools moves on to the next edit.

• Cinema Tools may not be able to match all audio edits within the sequence. This may
be due to incomplete database records or the use of audio from sources other than
the logged sound rolls. For those edits that cannot be matched back to the database,
an entry is added to the EDL using the sound roll and audio timecode information from
the sequence, with an asterisk placed by the roll name. A comment stating that no
matching database record was found is also added to the EDL entry.

Cinema Tools creates two files during the export: a CMX 3600 EDL format file and a text
file containing information about the EDL export:

• The CMX 3600 EDL format is widely used as a standard for EDL interchange and should
be acceptable at virtually all facilities.
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• The text file created along with the EDL file uses the EDL’s filename with a .txt extension.
The file contains information regarding the sequence used and all the settings of the
Export Audio EDL dialog, including the number of tracks and their mapping. It also lists
any errors that occurred during the export.

Settings in the Export Audio EDL Dialog
Cinema Tools uses information from the sequence to fill in several fields in the top part
of the Export Audio EDL dialog.

• File: The name of the Cinema Tools program file just opened. This is used only when
exporting an audio EDL directly from Cinema Tools. See Using the Export Audio EDL
Feature from Cinema Tools for more information.

• Audio Tracks: The number of audio tracks used in the edit.

• Project name: The name of the Final Cut Pro sequence on which the file is based.

• Project timebase: The frame rate of the sequence in the Timeline.

• Start time: The sequence start time as assigned in the Final Cut Pro Audio/Video Settings
window.

• EDL Title: The name of the EDL. By default, it is the same as the project name from the
sequence.

• EDL start time and timecode format: The start time for the EDL and the timecode format
to be used. By default, the start time is the same as the start time from the sequence.
This should not be changed unless your audio post-production facility has a specific
requirement.
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• Audio Mapping: Use these pop-up menus to assign each of the eight possible sequence
audio tracks to the four audio EDL tracks (the maximum supported by audio EDLs). See
Audio Track Usage for details about configuring these settings.

• Include clip comments: When this option is selected, the audio EDL includes the name
of the clip file (if known) as a comment for each event in the list.

• Include scene and take comments: When this option is selected, the audio EDL includes
the scene and take numbers as comments for each event in the list.

• Open in text editor: When this option is selected, the exported audio EDL opens in the
text editor specified in the pop-up menu. Because the audio EDL is actually a text file,
the TextEdit application is typically used.

Audio Track Usage
Although Final Cut Pro supports many audio tracks, the Cinema Tools Export Audio EDL
feature includes only the first eight, and audio EDLs support a maximum of four. The
Export Audio EDL dialog provides settings for each of the eight possible audio tracks,
allowing you to map them to the four EDL tracks.

The track configuration pop-up menus are active for those tracks included in the
sequence—all others are unavailable. Although it is possible to map multiple tracks to a
single EDL track, this frequently results in errors and confusion in the resulting EDL.

Because there is no way to fit the eight audio tracks into the four EDL tracks, you must
export two EDLs—one EDL with tracks 1 through 4 enabled (and the others off ), and the
other EDL with tracks 5 through 8 enabled. Be aware that some sound editors may prefer
a single track per EDL, requiring you to export multiple audio EDLs. Make sure to consult
with your sound editor before you export the audio EDL.

Using the Export Audio EDL Feature from Cinema Tools
You will most often use the Cinema Tools Export Audio EDL feature from within
Final Cut Pro. You can use this feature from within Cinema Tools, but because Cinema Tools
does not have the edited sequence directly available, an additional step is required to
create a Cinema Tools program file.
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Final Cut Pro creates a Cinema Tools program file if you select “Save a Cinema Tools
program file” in the Export Film Lists dialog. A Cinema Tools program file contains
information about the edit sequence in a format that can be used by Cinema Tools to
create the audio EDL. Other settings within the Export Film Lists dialog, such as whether
or not the various available lists are included, have no effect on the program file.

To open the Export Audio EDL dialog from within Cinema Tools
1 In Cinema Tools, choose File > Export > Audio EDL from Program DB.

2 In the dialog that appears, select the program file to use, then click Open.

The Export Audio EDL dialog appears.
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You can use Cinema Tools to work on projects started on other systems.

On occasion you may find that you want to create film lists, including a cut list, based on
edits from an editing system other than Final Cut Pro, or from a Final Cut Pro installation
on a different computer. For this reason, Cinema Tools lets you generate film lists based
on Edit Decision Lists (EDLs) created with Final Cut Pro and other systems, as well as film
lists based on Final Cut Pro XML files.

Cinema Tools also lets you import and export Avid Log Exchange (ALE) files. These files
contain most of the film, video, and audio information in a Cinema Tools database, in a
format supported by most film-based editing systems. ALE files do not contain any
edit-based information (as is found in an EDL).

This chapter covers the following:

• Creating EDL-Based and XML-Based Film Lists (p. 201)

• Working with ALE Files (p. 206)

Creating EDL-Based and XML-Based Film Lists
The same considerations you have to take into account when creating film lists from
within Final Cut Pro apply to other video editing applications. You must:

• Have a complete and accurate Cinema Tools database that includes the film and
timecode information

• Have video timecode and reel numbers in the EDL or XML file that exactly match those
in the Cinema Tools database

• Be prepared to deal with audio speed issues that may affect synchronization with the
picture

All of the considerations related to the telecine transfer, including whether the
scene-and-take or camera-roll method was used, apply as well. The telecine log from a
scene-and-take transfer is still the best way to build your Cinema Tools database. See
Creating a Cinema Tools Database for information about building a Cinema Tools database.
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Important: When you export film lists from an EDL or XML file, Cinema Tools has to use
the timecode-based method of film list creation. For this reason, you must be careful to
have accurate video timecode values in the database, because they alone, and not the
actual clips, provide the edit information for generating the lists.

There are two ways you can generate film lists from an EDL:

• Use the Cinema Tools Export commands: This is the easiest approach. See Before You
Use the Cinema Tools Export Commands for more information.

• Import the EDL into a Final Cut Pro sequence: This method requires a bit more effort but
displays the edit points in a timeline fashion (with no video or audio if the clips are not
available). If the clips are available, it is possible to actually play and modify the sequence
before you export the lists. For information about importing an EDL, see the Final Cut Pro
documentation. See An Introduction to Film Lists and Change Lists for details about
generating film lists from within Final Cut Pro.

Before You Use the Cinema Tools Export Commands
In addition to the Cinema Tools database, a suitable EDL or XML file is required to create
film lists from within Cinema Tools.

EDL Requirements
Cinema Tools supports EDLs that comply with the CMX 3600 and GVG formats. As a
general rule, any options to include “pre-read” or “B-reels” should be disabled, because
these apply directly to tape-based editing. If necessary, Cinema Tools can work with
pre-read events, but the name of the pre-read reel must be PREREAD. Make sure that
comments are included, because these can display the clip, transition, and effects names.
They will be recognized by Cinema Tools and included in the cut list comments.

The reel names that appear in the EDL must match those used in the Cinema Tools
database. Even a slight difference, such as an added space or an extra leading “0” (“001”
instead of “0001”) can cause problems.

Be aware that some editing systems modify the reel names when exporting an EDL. The
CMX 3600 format allows a maximum of eight characters with only numbers and uppercase
letters (no spaces). Often a reel conversion list is appended to the end of the EDL to make
it easier to resolve any naming issues that occur.

You can use the Cinema Tools Change Reel command to change all occurrences of a
particular reel name in the database to match the EDL (for example, you can change all
instances of reel Tape 004 to TAPE004). See Changing All Reel or Roll Identifiers for more
information.

Note: To reduce the chance of issues with the EDL file, select Generic Edits in the Reel
Conflicts section of the EDL Export Options dialog.
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EDL Video Standards
EDLs are built on references to video timecode points. This means that EDLs have a frame
rate, typically either 29.97 fps (NTSC), 25 fps (PAL), or 24 fps or 23.98 fps (based on either
the film rate or the 24p video rate). Additionally, NTSC EDLs must contain a line near the
beginning that starts with “FCM.” This comment specifies whether the timecode is drop
frame or non-drop frame. PAL and 24 fps timecode are always non-drop frame and do
not require the FCM line (although it may appear as non-drop frame).

When you use an EDL file to generate a film list, you must identify the EDL’s frame rate
in the selection dialog. See Exporting Film Lists from Cinema Tools for more information.

XML Requirements
Cinema Tools supports Final Cut Pro XML files. Because XML files contain a lot more
information about an edited sequence than an EDL file, XML is the preferred format to
use when exporting film lists using Cinema Tools.

Exporting Film Lists from Cinema Tools
In Cinema Tools, the processes for exporting film lists based on EDL files and film lists
based on Final Cut Pro XML files are nearly the same. In both cases you can choose to
export a PDF-format, XML-format, or style sheet–based film list.

To generate film lists using the Cinema Tools Export command
1 Open the Cinema Tools database corresponding to the EDL or XML file you will use to

create the film lists.

This ensures that the frame rate of the list and the database match.

2 Do one of the following:

• To export a film list based on an EDL file: Choose File > Export > Film Lists from EDL.

• To export a film list based on an XML file: Choose File > Export > Film Lists from XML.

3 Select the EDL or XML file in the dialog that appears.

4 If you are using an EDL file, choose the list’s frame rate from the EDL Frame Rate pop-up
menu.

XML files contain a parameter that defines their frame rate.

5 Choose the output format of the film list from the List Format pop-up menu.

The choices are PDF, XML, and With Style Sheet. See Choosing the List Format for more
information about these formats.

6 If you chose With Style Sheet, choose a style sheet from the Style Sheet pop-up menu.

7 Click Continue.
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A dialog appears in which you can configure the information in the output file. The
settings in the dialog vary depending on the output format you chose from the List
Format pop-up menu. See Settings the Export Dialogs Have in Common and PDF
Configuration Settings in the Export Film Lists Dialog for details about the settings.

8 Click Export.

9 Choose a location and name for the film list file to be created, then click Save.

10 If you chose to have a Cinema Tools program file created in the Export Film Lists dialog,
choose a location and name for the file, then click OK.

The film list is generated.

Note: If Cinema Tools has any problems processing the EDL file, a “parsing error” message
appears that includes the line number that caused the problem. See What Actually
Happens to the EDL for more information.

What Actually Happens to the EDL
Once you start the film list export, Cinema Tools first processes the EDL file and creates
a version for its own internal use. During this processing, Cinema Tools looks for errors
that would make the EDL unsuitable to use for creating a film list. If it encounters
nonstandard or unexpected text, the export is halted and an error message appears listing
the line number where the processing failed. This is referred to as a parsing error.

Problems in an EDL can often be repaired by manually editing its contents. Because EDLs
are actually plain text files, they can be opened in TextEdit. Be careful: often the line
number listed is not the actual problem; the real issue may be with the line before.
Experiment with deleting lines and comparing them to similar ones that occur previously
in the EDL to help determine the problem. See Using TextEdit to Make Changes to an
EDL for more information.
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Cinema Tools also looks for conflicts within the EDL, such as when two edits overlap
(known as a dirty list). Cinema Tools cleans these edits, removing any portions that would
be recorded over by any edits that follow. Any transitions or supers that are completely
overlapped by a following edit are removed. If the transition or super is only partly
overlapped by a following edit, it is flagged as a conflict, the later edit is removed, and
an entry is added to the cut list indicating that this was done.

When Cinema Tools successfully processes an EDL, it places an entry in the messages
section of the film list showing a summary of events that it processed. This entry lists how
many of each type of event occurred (cut, dissolve, wipe, and key). The number of events
in the list should match the number of events in the EDL.

About Using EDLs with DPX Image Sequence Media
A common DI workflow involves editing your program using offline media files, exporting
an EDL of the program, and then using that EDL to export a film list based on a
Cinema Tools database connected to the original DPX image sequence media. In this
case, Cinema Tools tries alternative methods to match edits to database records if the
preferred methods don’t work.

Important: Although these alternative methods may help you export a film list in cases
where there is incomplete information, they also increase the chances of matching an
edit to an incorrect record. Be sure to carefully review the resulting film list to ensure its
accuracy.

Following are the differences in how Cinema Tools matches edits to database records if
the records are connected to DPX image sequence media:

• If Cinema Tools fails to find a match based on the timecode extracted from a DPX image
sequence: It attempts to interpret the image sequence filenames as timecode values
and use those values instead.

• If Cinema Tools fails to find a match based on using the name of the folder that contains
the DPX image sequence files as the reel name: It tries to match edits to records based
on the timecode alone.

Important: To prevent issues with DPX image sequence reel names, you should never
rename the folder that contains the image sequence files, and you should never move
the files from the folder or change their names.

Using TextEdit to Make Changes to an EDL
By default, TextEdit saves files in the Rich Text Format (RTF), but the EDL needs to be a
plain text file. Follow these steps to edit an EDL in TextEdit and save it in a plain text
format.
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Warning: Use great care when editing an EDL file—some items that appear meaningless
can be very important. Make sure you have a backup copy available in case you alter
your working copy beyond usability.

To edit an EDL file in TextEdit
1 Open TextEdit.

2 Choose File > Open, then locate the EDL file and click Open.

3 Choose Format > Make Plain Text, then click OK in the dialog that appears.

The font changes to Monaco, a fixed-width font that ensures the text columns line up
properly. The name changes to Untitled.

4 Make your text edits, then choose File > Save.

By default, the name is Untitled, and a .txt extension is appended to it.

5 Enter a name for the file and replace the .txt extension with .edl (or whatever was used
in the original file), then click Save.

A dialog appears asking if you want to have .txt appended to the end of your filename.

6 Click “Don’t append.”

If you often find yourself editing plain text files, you may want to configure TextEdit
preferences to make it easier.

Note: Double-clicking a filename with an .edl extension opens it in a read-only window
in Final Cut Pro.

Working with ALE Files
The Avid Log Exchange (ALE) file format was created so that the contents of film-based
databases could be transferred between systems. Cinema Tools supports importing and
exporting ALE files, making it possible to share databases with other systems.

As with EDL files, ALE files are plain text files that can be opened and edited with any text
editor. A difference is that they are tab-delimited, making them a bit more difficult to
read. Although it is possible to edit the contents with a text editor, you must use great
care to avoid corrupting the file by accidentally deleting a tab character.

Supported ALE Fields
Each line in an ALE file corresponds to one database record. Cinema Tools supports the
following ALE fields.

Film-Related Fields
• Camroll: Contains the number used for the Cam Roll field.

• Labroll: Contains the number used for the Lab Roll field.
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• Daily roll: Contains the number used for the Daily Roll field.

• Ink number: Contains the Ink field values.

• KN Start: Contains the Key field values.

Video-Related Fields
• Tape: Contains the Video Reel field value.

• Start: Contains the Video Timecode field value.

• End: Within Cinema Tools, this is a calculated value created by adding the Video Duration
field to the Video Timecode field.

• Duration: Contains the contents of the Video Duration field.

• TC 24: Contains a 24 fps–based Video Timecode value that is used in place of the Start
value if the database you are importing this file into is set for 24 fps timecode.
Additionally, if the ALE file does not include a Sound TC column, the TC 24 column
values are added to the database as the Sound Timecode values.

Audio-Related Fields
• Tracks: Cinema Tools inserts “VA1” into this field during export.

• Soundroll: Contains the contents of the Sound Roll field.

• Sound TC: Contains the contents of the Sound Timecode field, representing the timecode
value of the first frame.

General Fields
• Name: When exporting, contains the filename of the connected clip (if there is one),

or a Cinema Tools–created name combining the scene and take numbers (if they have
been entered), or, as a last resort, the video reel and timecode values separated by a
hyphen.

• Scene: Contains the Scene field contents.

• Take: Contains the Take field contents.

• Notes: Contains any notes you may have included in the database record.

Importing an ALE File
You import an ALE file with the Import Telecine Log command. You can import an ALE
file into an existing Cinema Tools database or into its own new database. It’s recommended
that you import into a new database—you can always import that database into another
one later. You can also import the ALE file using either Final Cut Pro or Cinema Tools.

See Importing Database Information from a Telecine Log or ALE File for more information
about importing ALE and telecine log files using either Final Cut Pro or Cinema Tools.
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Exporting an ALE File
Cinema Tools exports an ALE file based on the current found set. To avoid problems,
make sure all of the records are complete and accurate prior to exporting.

To export an ALE file
1 Create a found set that contains the records you want to export. (See Finding and Opening

Database Records for details about creating a found set.)

2 In Cinema Tools, choose File > Export > Avid Log Exchange.

3 Enter a name and location for the new file. It’s recommended that you add an .ale
extension to the filename.

4 Click Save to export the file.
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Cinema Tools provides several tools that are useful when editing 24p video.

The proliferation of high definition (HD) video standards and the desire for worldwide
distribution have created a demand for a video standard that can be easily converted to
all other standards. Additionally, a format that translates well to film, providing an easy,
high-quality method of originating and editing on video and finishing on film, is needed.

24p video provides all this. It uses the same 24 fps rate as film, making it possible to take
advantage of existing conversion schemes to create NTSC and PAL versions of your project.
It uses a progressive scanning scheme and usually an HD image to create an output well
suited to being projected on large screens and converted to film.

Additionally, 24p video makes it possible to produce high-quality 24 fps telecine transfers
from film. These are very useful when you intend to broadcast the final product in multiple
standards.

Note: Several of the features mentioned here are included with Final Cut Pro and do not
require Cinema Tools; however, these features are described here because they relate to
working with 24p video, which is of specific interest to many filmmakers.

This chapter covers the following:

• Considerations When Originating on Film (p. 210)

• Editing 24p Video with Final Cut Pro (p. 211)

• Adding and Removing Pull-Down in 24p Clips (p. 217)

• Using Audio EDLs for Dual System Sound (p. 227)
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Considerations When Originating on Film
When editing 24p material that originated on film, you need to be aware of a number of
special circumstances.
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Cinema Tools (offline edit)
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Export 24 fps EDL

Create
database

Cinema Tools

• If you intend to conform the film to match the edited video, you must have its edge
code tracked by a Cinema Tools database. (See Film Edge Code for details about edge
code.)

• The film must be transferred to video using a telecine. Typically the offline telecine
video output contains burned-in video and audio timecode, as well as key numbers.
These burned-in values (known as window burn) are invaluable when you intend to
later conform the film. Unfortunately, their visibility is a problem if you also intend to
use the 24p video to produce a video version of the program. For this reason, if you
intend to produce both a conformed film and an edited video version of the project,
you might have the telecine run on two decks simultaneously, one with the window
burn and the other without.

• Whether you’re shooting film or 24p video, sound is almost always recorded separately
from the picture, with a separate sound recorder. This is often referred to as recording
dual system sound. Although 24p productions can record the sound on the 24p video
recorder, providing synced audio that is easily captured with Final Cut Pro, film
productions do not have the option of recording sound on the film, so the audio must
be synced to the picture at some point later in the process. The preferred workflow is
to synchronize the audio during the telecine transfer. This makes it easy to capture the
audio along with the video clips for editing with Final Cut Pro. The Cinema Tools
database can track the original sound roll numbers and audio timecode and generate
an audio EDL that can be used to recapture and edit the audio at an audio
post-production facility.

See Telecines for information about telecine transfers. See Exporting an Audio EDL for
information about exporting audio EDLs.
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Editing 24p Video with Final Cut Pro
The excellent quality of 24p video presents a challenge when it comes to editing—the
bandwidth and storage space it requires. Editing minimally compressed 24p video directly
in Final Cut Pro requires that you have a system with a large, fast hard disk and specialized
capture hardware. Even with a properly configured system, you may be able to capture
only the video you actually intend to use, not the typical 20 to 100 hours you may have
shot.

The typical approach to editing 24p video with Final Cut Pro involves two steps: an offline
edit, using compressed 24p clips or downconverted (to standard definition NTSC) and
compressed clips, followed by an online edit with recaptured, uncompressed clips.

What Is Downconverted Video?
It is often necessary to use HD video, such as 24p, in systems designed for standard
definition (SD) NTSC video. The process of converting HD video to SD video is called
downconverting. Most HD VTRs have an option that provides SD video outputs. Several
specialized hardware downconverters are also available. See Understanding Aspect
Ratios for information about dealing with the aspect ratio differences between the
standards when downconverting.

Using a Final Cut Pro System for 24p Offline and Online Editing
Using the same Final Cut Pro system for both offline and online editing makes the process
as simple and error-free as possible. The workflow when using the same system for both
purposes is outlined below.

Stage 1: Capturing Your 24p Video as Compressed Clips
Capturing your 24p video using a lower-resolution codec makes it easier to capture and
edit the video without running into storage or performance issues.

Stage 2: Performing an Offline Edit of the Clips
Edit the program using the lower-resolution video clips.

Stage 3: Creating a Duplicate Project That Uses Only Needed Video
You can use the Final Cut Pro Media Manager to create a duplicate project containing
only the video actually used in the program. This is usually much less than half of the
originally captured video.

Stage 4: Deleting the Original Clips
Because the next step is to recapture the video using its native codec, you can delete the
original lower-resolution video clips.

Stage 5: Recapturing the Material in the Duplicate Project
Now that you know exactly which video clips your project needs, you can recapture the
video at its native resolution.
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Even if your Final Cut Pro system is not configured to edit uncompressed 24p video, it
can serve as an offline editor and export a 24 fps EDL to be used by a 24p online editing
system. Even better, if your 24p online editing system uses Final Cut Pro, you can simply
copy the project from the offline system, allowing you to preserve far more information
about the edit than with an EDL alone.

See Using Final Cut Pro as a 24p Online Editor and Using Final Cut Pro as a 24p Offline
Editor for more information about each option.

Using 24p Video with Final Cut Pro and Cinema Tools
Final Cut Pro and Cinema Tools give you the ability to handle various situations related
to editing 24p video:

• Importing 24 fps EDLs: Use for performing an online edit of 24p material that has been
offlined on another system. See Using Final Cut Pro as a 24p Online Editor for more
information.

• Exporting 24 fps EDLs: Use for performing an offline edit of 24p material with a 24 fps
editing timebase. See Using Final Cut Pro as a 24p Offline Editor for more information.

• Converting an EDL to or from 24 fps: Use for performing an offline edit of 24p material
using an NTSC editing timebase or for doing an online edit of 24p material that has
been offlined on an NTSC system. See Using Final Cut Pro as a 24p Offline Editor for
more information.

• Removing 2:3:3:2 or 2:3:2:3 pull-down: Use if you are capturing your source clips from a
digital video camcorder that applied 2:3:3:2 or 2:3:2:3 pull-down to 24p video. This
feature cleanly eliminates the redundant frame fields created by the pull-down, without
any recompression, so you can edit at 23.98 fps or 24 fps. See Working with 2:3:3:2
Pull-Down for more information.

• Adding pull-down: Use to output 23.98 fps video in a format that you can play on an
NTSC device, such as an NTSC monitor, and to record it as 29.97 fps video. This feature
lets you output 23.98 fps video via FireWire at the NTSC standard of 29.97 fps video.
See Pull-Down Patterns You Can Apply to 23.98 fps Video for more information.

• Creating an audio EDL when using dual system sound: Use if you intend to recapture the
audio elsewhere for final processing. See Using Audio EDLs for Dual System Sound for
more information.

Using Final Cut Pro as a 24p Online Editor
An important consideration when using Final Cut Pro as your online editor is how to
import the offline edit information. When using a separate system as the offline editor,
there are three methods you can use to get edit information from the offline system
(presented in order of preference):

• Copy the project: Can be used when a separate Final Cut Pro system is the offline system
and you used a 24 fps editing timebase for the offline edit.
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• Import a 24 fps EDL: Can be used when your offline system supports exporting 24 fps
EDLs.

• Import an NTSC EDL: Can be used when your offline system can only edit downconverted
NTSC versions of the 24p video and export an NTSC EDL.

Copying the Project
Copying the project from an offline Final Cut Pro system to the online Final Cut Pro system
provides not only the edit In and Out point information but also all other information
related to the project, such as filter and effects usage. To use this method, you must have
edited using a 24 fps timebase on the offline system.

About Importing EDLs
When using non–Final Cut Pro offline systems (or a Final Cut Pro system editing
downconverted NTSC versions of the 24p video), you must import an EDL. Final Cut Pro
provides both 24 fps EDL import and NTSC–to–24 fps EDL conversion.

Offline EDL
(24 fps or NTSC)

24p
source
video

Edited
24p 
video

Final Cut Pro with Cinema Tools

Online edit
24p video

Process EDL
(if necessary)

Export
Final Cut Pro

movie

Capture
uncompressed

24p video

Important: Before importing any EDL into Final Cut Pro, make sure that the editing
timebase for the sequence is the same frame rate as the EDL. If the frame rate of the EDL
is different from the editing timebase of the sequence, the EDL will not be imported
correctly.

Importing 24 fps EDLs
Whenever the offline editor is not a Final Cut Pro system, the best way to import
information about the offline edit is to provide an EDL. EDLs contain only the basic
information about an editing project: the In and Out edit points for the first two video
tracks and the first four audio tracks, information for simple transitions, and any notes
you have added.

To import a 24 fps EDL into Final Cut Pro
1 Open an existing Final Cut Pro project or create a new one.

2 Choose File > Import > EDL.

3 Configure the Import Options dialog, then click OK.
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Note: If the dialog does not allow you to choose 24 fps as the editing timebase, it’s
probably because the Easy Setups included with Cinema Tools are not installed. If they
are not installed, reinstall Cinema Tools.

4 Select the name and location of the EDL file, then click Choose.

A new sequence opens in the project, containing the edits of the EDL, all indicating that
the media is offline. The Browser contains a list of the media used in the edit. You can
then use the Final Cut Pro Media Manager to capture the clips for the online edit. See the
Final Cut Pro documentation for details about capturing clips, importing EDLs, and
configuring the Import Options dialog.

Importing NTSC EDLs
You can perform an offline edit of your downconverted 24p video on an NTSC system
and export an EDL that can be converted and used by an online Final Cut Pro system. To
import an NTSC EDL for use with a 24p project, you first need to convert the NTSC 29.97 fps
EDL to 24 fps (or, most often, to 23.98 fps).

Note: Cinema Tools does not support converting PAL EDLs to 24 fps.

See Converting NTSC EDLs to 24 fps for more information. After you have converted the
EDL, you can import the 24 fps EDL into Final Cut Pro using the process described in
Importing 24 fps EDLs, above.

Using Final Cut Pro as a 24p Offline Editor
Editing 24p HD video generally requires that you first edit it with an offline system. This
allows you to choose the actual footage you want to use while working with
downconverted or compressed versions of the 24p video.

When the online system also uses Final Cut Pro, it is highly recommended that you perform
the offline edit using a 24 fps timebase. This allows you to open the project with the
online system and maintain all special settings, effects, and filters—elements that are not
included in an EDL.

With online systems other than Final Cut Pro systems, you need to provide a 24 fps EDL
from the project.

Cinema Tools provides two tools that make it easier to use Final Cut Pro for 24p offline
editing:

• Reverse Telecine and Conform features: These features are useful when you have captured
downconverted versions of the 24p video and want to convert them back to 24 fps.

• NTSC–to–24 fps EDL conversion: This is useful when you must edit using an NTSC
29.97 fps timebase but need a 23.98 fps or 24 fps EDL.
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For offline editing, it is preferred that the 24p video be compressed and captured directly,
with no frame rate conversions. This removes the possibility of errors during video and
timecode rate conversions and eliminates the need to convert the video’s aspect ratio
(see Understanding Aspect Ratios). However, this requires specialized hardware, so the
following alternatives using standard downconverted versions of the 24p video have
been developed.

Using the Reverse Telecine and Conform Features
24p video is often downconverted to make it easier to use with standard video equipment.
Cinema Tools provides tools to convert NTSC or PAL captured clips back to their original
24 fps video, enabling you to edit using a 24 fps timebase:

• NTSC: Converting 24p video to NTSC video requires using a pull-down method that
adds redundant fields, maintaining the action’s original speed (1 second of 24p video
equals 1 second of NTSC video). The Reverse Telecine feature removes the pull-down
by removing the extra fields and restores the original 24 fps rate. See Reversing the
Telecine Pull-Down for information about using the Reverse Telecine feature. If your
source clips originated from a special type of DV camcorder that shoots 24p, such as
the Panasonic AG-DVX100 camcorder, a simpler form of the Reverse Telecine dialog
appears. See Removing 2:3:3:2 or 2:3:2:3 Pull-Down with Cinema Tools for information
about reversing the pull-down for clips that originated from a 24p-capable digital video
camcorder.

• PAL: There are several methods of converting 24p video to PAL. The most common is
to play the tape 4 percent faster, providing a one-to-one relationship between the 24p
and PAL frames, but speeding up the action by 4 percent. Cinema Tools and Final Cut Pro
provide a Conform feature that you can use to restore the video back to 24 fps in order
to edit it at 24 fps in Final Cut Pro. See Frame Rate Basics for information about frame
rate issues.

Converting NTSC EDLs to 24 fps
You may decide to edit the downconverted NTSC version of the 24p video using a standard
NTSC 29.97 fps timebase; however, most 24p online editing systems require a 23.98 fps
or 24 fps EDL.

Cinema Tools includes a feature that allows you to convert NTSC 29.97 fps EDLs to 23.98 fps
or 24 fps. This makes it possible for you to perform an offline edit of your downconverted
24p video on an NTSC system and export an EDL that can be converted and used by an
online system.

Note: Cinema Tools does not support converting PAL EDLs to 24 fps.

To convert an NTSC EDL to 24 fps, you need the EDL file to be converted in the CMX 3600
or GVG format. You do not need a Cinema Tools database.
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To convert an NTSC EDL to 24 fps
1 In Cinema Tools, choose File > Export > Converted EDL > 24 FPS from 30 FPS.

2 In the dialog that appears, locate and choose the EDL file to convert.

3 In the next dialog, choose the name and location for the new file to be created, then click
Save.

The new EDL file is identical to the original, with the exception of the timecode values
and effects durations, which have been converted to match the new frame rate.

Important: 24p timecode is always non-drop frame, and the NTSC timecode to be
converted must also be non-drop frame. Cinema Tools does not prevent you from
converting an NTSC drop frame–based EDL, but instead treats it as if it were non-drop
frame. The exported 24 fps EDL will contain errors, and Cinema Tools inserts a warning
message into the EDL.

You can now import the 24 fps EDL into Final Cut Pro using the process described in
Importing 24 fps EDLs.

Understanding Aspect Ratios
When capturing NTSC or PAL video from 24p sources, you typically choose how to
handle the differences in their aspect ratios.

SD video (NTSC or PAL) has a 4:3 (1.33) aspect ratio. This means the picture is 75 percent
as tall as it is wide. Many 24p formats use a 16:9 (1.78) aspect ratio that is closer to the
common film aspect ratio of 1.85 and is the same as that of the widescreen broadcast
HD formats.

Many HD VTRs can downconvert 16:9 video to SD 4:3 video. Final Cut Pro systems not
capable of capturing 24p video directly can capture using one of these SD video outputs
for editing.

See the Final Cut Pro documentation for detailed information about the options for
converting 16:9 video to 4:3 video.
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Adding and Removing Pull-Down in 24p Clips
Cinema Tools and Final Cut Pro have pull-down removal and addition features that address
issues specific to working with 24p video. Pull-down is a process that adds redundant
fields to video in order to distribute 24 frames per second into the NTSC standard of
29.97 frames per second. See Frame Rate Basics for more information. Some camcorders,
such as the Panasonic AG-DVX100, are designed to shoot in progressive mode at 24 fps
(literally 23.98 fps) and then record the video to tape as a 60-field interlaced signal by
applying a special kind of pull-down called advanced 2:3:3:2 pull-down. With Final Cut Pro
or Cinema Tools, you can remove the redundant fields created by the camera’s pull-down,
so that you can edit at 23.98 fps or 24 fps.

When you edit 23.98 fps video, you may need to output it to an NTSC monitor, record it
to an NTSC videotape, or send it to another type of NTSC device. Because the NTSC
standard specifies a frame rate of 29.97 fps, Final Cut Pro gives you a way to add pull-down
back in to the video as you output it. To accommodate various circumstances, Final Cut Pro
provides a few different types of pull-down patterns for outputting your 23.98 fps video
as 29.97 fps video: 3:2 pull-down, 2:3:3:2 pull-down, and 2:2:2:4 pull-down. (See Pull-Down
Patterns You Can Apply to 23.98 fps Video for a description of these pull-down patterns.)

The sections that follow describe a number of ways that you can use Final Cut Pro or
Cinema Tools to remove advanced 2:3:3:2 pull-down or 2:3:2:3 pull-down from digital
video clips. You can:

• Use Final Cut Pro to remove 2:3:3:2 pull-down while capturing, or after capturing

• Use Cinema Tools to remove 2:3:3:2 or 2:3:2:3 pull-down on one clip at a time

• Use Cinema Tools to remove 2:3:3:2 or 2:3:2:3 pull-down on several clips at a time

What Is 2:3:2:3 Pull-Down?
A 2:3:2:3 pull-down pattern is exactly the same as a 3:2 pull-down pattern, except that
it is applied by a digital video camcorder (as opposed to any other type of equipment
that could apply the same pattern of pull-down). This manual uses the term 2:3:2:3 when
referring to the pull-down that comes from a 24p digital video camcorder; this type of
pull-down can be removed using the automated form of reverse telecine. See Removing
2:3:3:2 or 2:3:2:3 Pull-Down with Cinema Tools for more information.
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Working with 2:3:3:2 Pull-Down
Some camcorders, such as the Panasonic AG-DVX100, are designed to shoot in progressive
mode at 24 fps (actually 23.98 fps) and then record the video to a tape as a 60-field
interlaced signal by applying 2:3:3:2 pull-down to it. The 2:3:3:2 pull-down is similar in
concept to 3:2 pull-down but has a different pattern of field repetition, as illustrated
below.
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2
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1
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2
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1
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2:3:3:2 Pull-Down

After (29.97 fps)

One second

There are some advantages to shooting with, and then removing, 2:3:3:2 pull-down
instead of working with 3:2 pull-down:

• Final Cut Pro can easily remove the 2:3:3:2 pull-down while you are capturing, so that
you can edit 24 fps (actually 23.98 fps) progressive video.
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• Unlike 3:2 pull-down removal, removing a 2:3:3:2 pull-down does not require the
recompression and re-creation of any frames, so it results in a better picture quality.
Final Cut Pro eliminates the redundant fields by simply pulling out the frames containing
fields with two different images (the frames that were constructed from two different
original frames). Only frames containing one still image are left, resulting in a clean
picture.

A B C D A D A B C D A B C D A B C D A B C DB C

Before (29.97 fps)

After (23.98 fps)

A BA B B CC C D D

One second

2:3:3:2 Pull-Down Removal

A B C D

A A B B C D D
Field

1
Field

2
Field

1
Field

2
Field

1

C
Field

2
Field

2
Field

1

B
Field

1

C
Field

2

A A B B B C C C D D A A B B B C C C D D A A B B C C C D D A A B BB CC C D D A BA B B CC C DB D

You can remove the 2:3:3:2 pull-down with Final Cut Pro while capturing the source
media, or with Final Cut Pro or Cinema Tools after capturing.

Note: See 2:3:3:2 Pull-Down for information about applying 2:3:3:2 pull-down to video
(rather than removing it from video).

Removing 2:3:3:2 Pull-Down with Final Cut Pro
You can remove 2:3:3:2 pull-down with Final Cut Pro either while capturing the video or
after the clips have been captured.

To remove the pull-down while capturing from a digital video source
1 In Final Cut Pro, choose Final Cut Pro > Audio/Video Settings.

2 Click the Capture Presets tab.

3 Select the preset you want to use, then click Edit.

4 Select “Remove Advanced Pulldown and/or Duplicate Frames from FireWire sources.”
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At some point after removing the 2:3:3:2 pull-down, you may want to output the video
with 2:3:3:2 pull-down added back to recapture it with the camera. Or, for NTSC broadcast
or distribution, you may want to apply the more conventionally supported 3:2 pull-down.
You can output 24p video in either of these pull-down patterns. See Pull-Down Patterns
You Can Apply to 23.98 fps Video for more information.

To remove the pull-down in Final Cut Pro after capturing
1 In Final Cut Pro, select the clips or sequence.

2 Choose Tools > Remove Advanced Pulldown.

Removing 2:3:3:2 or 2:3:2:3 Pull-Down with Cinema Tools
Clips captured from digital video camcorders that shoot 24p, such as the Panasonic
AG-DVX100 camcorder, have the pull-down pattern (also called cadence) information
embedded in a way that Cinema Tools can read. If Cinema Tools detects this cadence
information when you use the Reverse Telecine feature, the Automated Reverse Telecine
dialog appears. It’s a simplified version of the regular Reverse Telecine dialog.

Note: The Reverse Telecine feature cannot be used with temporally compressed video
such as MPEG-2-format video.

You can use automated reverse telecine to remove the pull-down either from one clip
at a time or from a group (batch) of clips.

To use automated reverse telecine to remove the pull-down in a single clip
1 Choose File > Open Clip, then select the clip in the dialog.

2 In the Clip window, click Reverse Telecine.

3 Choose a frame rate from the “Conform to” pop-up menu:

• 23.98: This frame rate is useful if you want to later use the Final Cut Pro pull-down
feature that lets you output 23.98 fps video as 29.97 fps video. (See Pull-Down Patterns
You Can Apply to 23.98 fps Video for more information.)

• 24.0: You may want to conform and edit the clips at this rate if you plan to include
them in a project that contains other clips that are exactly 24 fps.

Note: If the audio and video are contained in the same clip, and you choose 24.0 from
this pop-up menu, the Reverse Telecine feature increases the audio speed by a very
small percentage so that it is in sync with 24 fps instead of 23.98 fps.

Choose a frame rate from 
the pop-up menu.
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4 Select “New (smaller)” or “Same (faster)” to specify the kind of file you want to create:

• New (smaller): Creates a new media file that does not contain the extra frames
introduced by the pull-down. The new file is about 20 percent smaller than before, but
this method is slower. Regardless of whether the original file was reference or
self-contained, this method creates a self-contained file. (See The Difference Between
Self-Contained and Reference Media Files for more information.)

• Same (faster): Modifies the current media file so that the extra frames are not visible
to the editing system, but the data is not removed from the file. This process is faster
but does not reduce the size of the file. The resulting file is self-contained if it was
originally self-contained, or reference if it was reference.

When New is selected, 
“Check for cadence 
discontinuities” is on.
For Same, you can 
deselect it to speed
up processing.

If you select New,
the file will be smaller.
If you select Same,
the processing will
be faster.

If you selected “Same (faster),” you can choose whether Cinema Tools checks for cadence
discontinuities.

While removing the pull-down, Cinema Tools looks for breaks in the pull-down cadence.
If any breaks are found, it adjusts the processing to accommodate those discontinuities.
A cadence discontinuity might occur if a recording was stopped and then started again
at another point in the five-frame sequence.

Checking for cadence discontinuities is more time-consuming for the Same file option
than it is for the New file option, so if you select “Same (faster),” you can deselect the
“Check for cadence discontinuities” checkbox for the fastest possible processing.

Note: If this checkbox is deselected and cadence discontinuities exist in the clip, or if the
cadence changes from 2:3:3:2 to 2:3:2:3 (or any other pattern) in the middle of a clip
because the settings were changed during the recording, reverse telecine cannot be
properly performed on the clip.

5 Click OK to start the pull-down removal process.

If you selected the New file option, you are asked to give the new reversed clip a name
and location. If the original clip was connected to a database record, the new reversed
clip replaces its connection to the record (regardless of whether or not the new clip
overwrites the old clip).
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To use automated batch reverse telecine to remove the pull-down from several clips
at once

1 Place all the clips that you want to process in one folder. (Make sure that they are all clips
that were captured from a 24p digital video camcorder.)

2 Choose File > Batch Reverse Telecine.

3 In the dialog that appears, select any source clip file in the folder that contains the clips
you want to process, then click Choose.

4 Choose a frame rate from the “Conform to” pop-up menu:

• 23.98: This frame rate is useful if you want to later use the Final Cut Pro pull-down
feature that lets you output 23.98 fps video as 29.97 fps video. (See Pull-Down Patterns
You Can Apply to 23.98 fps Video for more information.)

• 24.0: You may want to conform and edit the clips at this rate if you plan to include
them in a project that contains other clips that are exactly 24 fps.

Note: If the audio and video are contained in the same clip, and you choose 24.0 from
this pop-up menu, the Reverse Telecine feature increases the audio speed by a very
small percentage so that it is in sync with 24 fps instead of 23.98 fps.

Choose a frame rate from 
the pop-up menu.

5 Select “New (smaller)” or “Same (faster)” to specify the kind of files you want to create:

• New (smaller): Creates new clip files that do not contain the extra frames introduced
by the pull-down. The new files are about 20 percent smaller than before, but this
method is slower. Regardless of whether the original files were reference or
self-contained, this method creates self-contained files. (See The Difference Between
Self-Contained and Reference Media Files for more information.)

If you select “New (smaller),” you can also choose to keep or delete the original clip
files. To save the original clips in a separate folder, select the Keep Originals checkbox.
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• Same (faster): Modifies the current clip files so that the extra frames are not visible to
the editing system, but the data is not removed from the files. This process is faster
but does not reduce the size of the files. The resulting files are self-contained if they
were originally self-contained, or reference if they were reference.

For Same, you can 
deselect “Check for 
cadence discontinuities” 
to speed up processing. 
For New, selecting Keep 
Originals saves the 
original clips in a folder.

If you select New,
the file will be smaller.
If you select Same, the 
processing will be faster.

If you selected “Same (faster),” you can choose whether Cinema Tools checks for cadence
discontinuities.

While removing the pull-down, Cinema Tools looks for breaks in the pull-down cadence.
If any breaks are found, it adjusts the processing to accommodate those discontinuities.
A cadence discontinuity might occur if a recording was stopped and then started again
at another point in the five-frame sequence.

Checking for cadence discontinuities is more time-consuming for the Same file option
than it is for the New file option, so if you select “Same (faster),” you can deselect the
“Check for cadence discontinuities” checkbox for the fastest possible processing.

Note: If this checkbox is deselected and cadence discontinuities exist in the clip, or if the
cadence changes from 2:3:3:2 to 2:3:2:3 (or any other pattern) in the middle of a clip
because the settings were changed during the recording, reverse telecine cannot be
properly performed on the clip.

6 Click OK to start the pull-down removal.

After the process is complete, the following occur:

• If you selected “New (smaller),” for each clip in the folder, a new clip with the same
name is created and placed in a Cinema Tools–created subfolder named Reversed. If
you selected Keep Originals, the original files are placed in a Cinema Tools–created
subfolder named Originals. If you selected “Same (faster),” the new versions of the clips
replace the old versions, in their original folder.
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• If Cinema Tools is unable to complete the reverse telecine process for a clip, that clip
is moved into a Cinema Tools–created subfolder named Skipped. A clip is not processed
if it doesn’t contain a video track, if the frame rate is not supported, if the clip does not
contain cadence information, or if there is no codec found for the video track.

• A text file appears at the top level of the folder you started with, named “reverse.log.”
This log gives the date and time that the process started and ended, as well as a start
time for each clip. If any problems were encountered, such as running out of disk space
or memory, an error message describing the problem also appears in the log.

Pull-Down Patterns You Can Apply to 23.98 fps Video
When editing 23.98 fps video, you may want to output it to an NTSC monitor, record it
to an NTSC videotape, or send it to another type of NTSC device. When you need to do
this, you can use the pull-down addition feature in Final Cut Pro. Pull-down addition is a
software method of converting 23.98 fps video to the NTSC standard of 29.97 fps.

There are three pull-down patterns that Final Cut Pro can apply to 23.98 fps video.
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3:2 Pull-Down
3:2 pull-down is the same type employed by a telecine. See Working with NTSC Video
for more information. Because 3:2 pull-down is the conventionally supported pull-down
pattern for NTSC devices, you need to use this pull-down pattern to record to an NTSC
device, such as an SD television, an MPEG-2 encoding device, or a high-end finishing
system.
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2:3:3:2 Pull-Down
Another type of pull-down you can use is 2:3:3:2 pull-down. As with 3:2 pull-down, the
“3” in the pattern represents three fields, where one redundant field is added to the
original two fields of a frame. See Working with 2:3:3:2 Pull-Down for details about this
pattern and the advantages it provides.

Although 3:2 pull-down is the conventionally supported pattern for NTSC devices, you
may want to use 2:3:3:2 pull-down to output video that you can record to tape and yet
later convert back to 23.98 fps with the advantages of 2:3:3:2 removal (the ability to
remove the pull-down without the recompression and re-creation of any frames).
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2:2:2:4 Pull-Down
The 2:2:2:4 pull-down pattern is not typically supported for recording devices or cameras,
but because it requires the least amount of processing power, it’s a good choice if you
are editing 23.98 fps video and want to preview it with as many real-time effects as
possible on an NTSC monitor. This pattern is also useful if you need to output video for
display from an older, slower computer (or a computer with a heavy processing load)
that drops frames when you try to output 3:2 or 2:3:3:2 pull-down video.
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Adding Pull-Down to 23.98 fps Video
Final Cut Pro lets you add pull-down to 23.98 fps video as you output it via FireWire. As
discussed in the previous section, this is useful when you are editing 23.98 fps video and
want to output it to an NTSC device.

Important: You must have a FireWire device connected and the sequence must have a
23.98 fps timebase for the pull-down options to appear. They do not appear if the
sequence has a 24 fps timebase.

To add pull-down back in while sending 23.98 fps video to an NTSC device via FireWire
1 In Final Cut Pro, select the sequence in the Timeline.

2 Choose the type of pull-down to use from the RT pop-up menu in the Timeline.
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See Pull-Down Patterns You Can Apply to 23.98 fps Video for details about the available
patterns.

3 Output the video using your FireWire connection.

Refer to the Final Cut Pro documentation for details about outputting video.

The pull-down is performed on the video that is sent out of your computer via FireWire.

Using Audio EDLs for Dual System Sound
As with film productions, 24p video productions almost always record the sound separately
from the picture, with a separate sound recorder. This is referred to as using dual system
sound. This audio is often simultaneously recorded onto the videotape of the 24p VTR,
making it easy to later capture both the video and audio, with the audio already synced
to the video for the edit.
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In most cases, once you have finished editing, you will want to recapture the audio from
the original production sound rolls and finish it at an audio post-production facility. The
difficulty is that the EDL from Final Cut Pro does not know the roll numbers and audio
timecode of the original production sound rolls; it only has the videotape information.
Because the production sound recorder is started and stopped independently of the VTR,
its timecode will not match the VTR’s.

Using its database feature, Cinema Tools can match the edits using the videotape audio
with the original production sound rolls and generate an audio EDL that can then be
used to recapture and finish the audio.

You must create a Cinema Tools database before you can use this feature. See Creating
and Configuring a New Database for details about creating a database and Exporting an
Audio EDL for details about exporting an audio EDL from Cinema Tools.
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Before you use Cinema Tools to edit your film, it’s helpful to have a general understanding
of a few film properties and be familiar with the traditional film editing method. This
appendix provides basic background information about film and how it is edited, both
traditionally and digitally.

Most of this information is very general and is not intended to be a complete guide (or
the final word) on the film process. There are a wide variety of resources that can provide
detailed information on the subject.

This appendix covers the following:

• Film Basics (p. 229)

• Editing Film Using Traditional Methods (p. 234)

• Editing Film Using Digital Methods (p. 236)

Film Basics
There are a number of things that differentiate the various film standards. The most
common are:

• Frame size: For more information, see Frame Size.

• Perforation arrangement (how many sprocket holes per frame): For more information,
see Perforations.

• Film edge codes, including key numbers and ink numbers: For more information, see Film
Edge Code.

• Speed (how many frames per second): For more information, see Speed.

The following sections discuss these points as they relate to Cinema Tools.

Frame Size
Cinema Tools supports two common film frame sizes: 16mm and 35mm. The aspect ratio
(height versus width) of each size is different.
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Because of its lower costs, 16mm film is typically used for productions with smaller
budgets. If you intend to shoot 16mm but release your project as 4-perf 35mm, you
should use Super 16mm film. It has perforations along only one edge and a larger frame
that more closely matches the 4-perf 35mm aspect ratio.

16mm format Super 16mm

35mm film is most commonly used for theatrical releases, with 4 perforations per frame
(4-perf ) being the most prevalent version. Another common version uses 3 perforations
per frame (3-perf ). There are other versions of 35mm, such as 8-perf, but they are not
currently supported by Cinema Tools.

35mm format 35mm format
4-perf 3-perf

Perforations
Camera and projection equipment uses the perforations, also known as sprocket holes,
along one or both edges of film to pull it past the shutter.

16mm Film
16mm film has a single perforation for each frame, which comes out to 40 perforations
per foot. 16mm is available as single perforated (perforations along one edge only, allowing
space for an optical track, or in the case of Super 16mm film, for a larger frame) and
double perforated (perforations along both edges). Cinema Tools supports single and
double perforated 16mm film as long as it has a key number every 20 frames. See Key
Numbers for more information.
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35mm Film
35mm film has 64 perforations per foot. Cinema Tools supports the 4-perf 35mm and
3-perf 35mm formats for all types of film lists and change lists. These are by far the most
common 35mm formats.

The 4-perf 35mm film format has 16 frames per foot. The 3-perf 35mm format does not
have a whole number of film frames in a foot (there are 21 and one-third per foot). To
avoid tracking fractions of frames, the 3-perf 35mm format is considered to have a pattern
of two 21-frame feet followed by a 22-frame foot. See 3-Perf 35mm Offsets for more
information.

Film Edge Code
To aid in locating specific film frames, film manufacturers place numbers along the edge
of the film. These key numbers (also known as latent edge code) appear when the film is
developed. For workprints, film labs can add numbers called ink numbers (also known as
Acmade numbers).

Edge code is essential to your Cinema Tools database because it makes it possible for
you to export cut lists or change lists that specify exactly where your negatives or
workprints need to be cut in order to match your digital edits.

Key Numbers
Key numbers provide both an identification number for each roll of film and an incremental
footage count number used to identify specific film frames. They often appear as both
regular text and as a bar code.

Key number
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Each film standard uses key numbers differently:

• 16mm film can have a key number every 20 frames (most common) or 40 frames,
depending on the film stock. Cinema Tools supports the 16mm-20 format.

• 35mm film has a key number every 64 perforations (which works out to every 16 frames
with the 4-perf format, or 21 and one-third frames with the 3-perf format).

Unlike video timecode, which provides a unique number for each video frame, key
numbers do not appear on every frame of film. For this reason, when identifying a specific
frame in a log book or in Cinema Tools, key numbers have a frame count extension added
specifying the actual frame. A “+08” at the end of a key number indicates it is the eighth
frame from that key number’s first frame.

In the previous illustration, the actual key number for the center frame is KJ 29 1234
5678+00. The “•” following the number indicates frame 00 for that key number. (With
4-perf film—the kind shown in the illustration—there are 16 frames per key number, with
the first one starting at “00.”) The frame to the right would be KJ 29 1234 5678+01. The
frame to the left would be the last frame of the previous key number, KJ 29 1234 5677+15.
(16mm film places the “•” at the beginning of the key number.)

35mm film also has mid-foot markers halfway between the zero frame markers. These
help to identify a midpoint (the “+08” frame in the previous example) and reduce the
chance of a miscount. These markers use the same key number with a “+32” appended
(indicating the perforation number, not the frame number) in a smaller font.

3-Perf 35mm Offsets
Because the 3-perf 35mm format does not have a whole number of frames between each
key number, an additional “perforation offset” number is added to the end of the key
number. This number indicates the relationship of the perforation marked with a “•” and
the frame at that position.

Offset 1
Offset 2

Offset 3
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Ink Numbers
Ink numbers, frequently used for workprints, are another method of encoding the edge
of film in order to track feet and frames. Ink numbers are added to workprints and
corresponding magnetic-stripe film soundtracks (called mag tracks) after the workprint
and the mag track have been synchronized. On transferred workprints, ink numbers are
easier to read than key numbers, and they provide a counting mechanism that is
synchronized for both the soundtrack and the workprint. Ink numbers are sometimes
called Acmade numbers because Acmade makes a machine that is used to print ink
numbers. Machines that print ink numbers are commonly rented or owned and run by
film crews.

The typical style of ink numbering is a three-digit prefix followed by a character or space,
followed by four digits representing the footage number, followed by digits representing
the frame offset. For example, in ink number 123 4567+08, “123” is the prefix and
“4567+08” is the frame number, indicating that the frame occurs at 4567 feet and 8 frames.
The ink numbers encoded on the film do not actually include the last part (the frame
offset number). Rather, the frame offset is calculated by the telecine and appears in the
telecine log.

The prefix may contain fewer or more than three digits, and the numbering technique
for the prefix is usually determined by an editing assistant. For example, the numbering
could be associated with the scene number, as in “042” for the footage in scene 42. Or,
the prefixes might represent daily roll numbers.

Window Burn
As part of the telecine transfer process (described in Transferring Film to Video), the key
number is typically burned in to the video (along with the video and audio timecode),
helping to identify specific frames. The burned-in numbers are called window burn.

It is much easier to use Cinema Tools if you can see the key numbers. You can use
Cinema Tools without the window burn, but it requires more effort on your part to ensure
that edits are being tracked properly.
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Note: After you have captured your video but before you start editing, check the burned-in
key numbers and timecode to make sure they match the actual ones on the film and
videotape. There are a variety of reasons why the window burn values might not be
correct, ranging from incorrectly entered values to faulty automatic detection. Any errors
at this point will result in serious problems when the negative is conformed. The most
common way to verify these numbers is to have the lab or transfer facility physically
punch a hole or otherwise mark a film frame, note its key number, and compare it to the
burned-in key number when viewing the transferred video. Make sure you verify this at
least once for each camera roll (preferably for each take). Compare the timecode in the
window burn with the value the videotape deck displays.

Speed
Film normally has a frame rate of 24 frames per second (fps). This means a new image is
exposed or projected 24 times a second. To ease conversion to video frame rates, it is
common to run the film at rates other than 24 fps during the telecine transfer.
Cinema Tools supports film transferred to video with the telecine running at the rates of
23.98 fps, 24 fps, 25 fps, and 29.97 fps (often referred to as 30 fps). See Frame Rate Basics
for more information about frame rates.

Editing Film Using Traditional Methods
The traditional process of editing film has changed little over the years. Although the
equipment has improved dramatically, the steps are basically the same. Following is a
simplified workflow outlining the film editing process.

Note that the original camera negative is almost never used during the creative editing
part of the process. The negative must be handled as little as possible, and then by
professionals in the proper environment, to avoid damaging it.

Create
workprint

Edit
workprint

Edit audio
scratch
tracks

Shoot
film

Develop
film

Create audio
scratch
tracks

Record
audio

Mix audio tracks
Add sound effects

Conform original
camera negative

to workprint Create
release
prints

Original camera negative

Original production audio
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Stage 1: Shooting the Film and Recording the Sound
Audio is always recorded separately from the film, on a separate sound recorder. This is
known as shooting dual system sound. While shooting the film, you need to include a way
to synchronize the sound to the picture. The most common method is to use a clapper
board (also called a slate or sticks) at the beginning of each take. There are a number of
other methods you can use, but the general idea is to have a single cue that is both
audible and visible (you can see what caused the noise).

Stage 2: Developing the Film
The developed film is known as the original camera negative. This negative will eventually
be conformed to create the final movie and must be handled with extreme care to avoid
scratching or contaminating it. Normally, the negative is used to create a workprint (film
positive) and then put aside until the negative is conformed.

Stage 3: Creating the Workprint
The workprint is created from the original camera negative and gives you a copy of the
raw film footage to use for the editing process. Because workprints are film positives,
they can be projected and used as dailies, letting you view what has been shot.

Stage 4: Creating Audio Scratch Tracks
An audio scratch track is similar to the film’s workprint—it’s a copy of the production
audio to use while editing. Depending on the type of mechanical film editor you intend
to use, you will often create an audio scratch track on magnetic film. Magnetic film, known
as single stripe, three stripe, mag stock, and fullcoat, uses perforations like regular film but
is coated with magnetic material. Once the magnetic film is synced with the film on the
editor, both the audio scratch track and the workprint are run in tandem, maintaining
their sync during editing.

Stage 5: Editing the Workprint
This is the point when you make decisions regarding which parts of the film footage you
want to use and how you want it laid out. Editing the workprint involves physically cutting
and splicing at each edit point. Changing your mind about the exact placement of a cut
or trying an alternative edit is time-consuming and tends to be hard on the film. (This is
the part of the process that digital editing greatly facilitates.) When you are satisfied with
the edited workprint, you send it to the negative cutter.

Stage 6: Conforming the Negative
The negative cutter uses the edited workprint as a guide to make edits to the original
camera negative. This process is called conforming. Because there is only one negative,
it is crucial that no mistakes are made at this point. As opposed to the cutting and splicing
methods used when working with the workprint, the cutting and splicing methods used
for conforming the negative destroy frames on each end of the edit. This makes extending
an edit virtually impossible and is one of the reasons you must be absolutely sure of your
edit points before beginning the conform process.
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Stage 7: Editing the Audio
You typically “rough-cut” the audio while editing the workprint. While the negative is
being conformed, the audio is edited (using the original sound rolls) and finished with
sound effects and any required dialogue enhancements.

Stage 8: Creating the Answer and Release Prints
After the original camera negative has been conformed and the audio finalized, you can
have an answer print created. This print is used for the final color timing, where the color
balance and exposure for each shot are adjusted to ensure the shots all work well together.
You may need to create several answer prints before you are happy with the results. Once
you are satisfied with the answer print, the final release print is made.

Editing Film Using Digital Methods
The process of editing film digitally is constantly evolving, but the basic concept remains
the same—you start and end on film, with only the creative part of the editing process
changing. Following is a simplified workflow outlining the basic process. (See Cinema Tools
Workflows for a more detailed explanation of this process.)

Shoot
film

Conform
original camera

negative to
cut list

Create
release
prints

Develop
film

Convert to
video with
a telecine

Telecine
log

Audio for edit

Audio
EDL

Cut
list

Original camera negative

Original production audio

Final Cut Pro

Record
audio

Cinema Tools

Create Cinema Tools database
Export cut lists based on edits

Edit
decisions

Reverse telecine
Conform

Mix
audio tracks

Add
sound effects

Prepare
clips

Edit
video
and

audio
Capture

audio

Capture
video

Although this workflow appears more complicated than the traditional editing method,
many of these steps can be automated. For most filmmakers, the benefits of being able
to edit digitally easily offset any added procedures.

Several parts of this process are the same as for the traditional method—as mentioned
earlier, it is only the middle part of the film editing process that is affected by editing
digitally.
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Stage 1: Shooting the Film and Recording the Sound
Audio is always recorded separately from the film, on a separate sound recorder. This is
known as shooting dual system sound. While shooting the film, you need to include a way
to synchronize the sound to the picture. The most common method is to use a clapper
board (also called a slate or sticks) at the beginning of each take. There are a number of
other methods you can use, but the general idea is to have a single cue that is both
audible and visible (you can see what caused the noise).

Stage 2: Developing the Film
The developed film is known as the original camera negative. This negative will eventually
be used to create the final movie and must be handled with extreme care to avoid
scratching or contaminating it. The negative is used to create a video transfer (and typically
a workprint, as with the traditional method) and then put aside until the negative is
conformed.

Stage 3: Transferring the Film to Video
The first step in converting the film to a format suitable for use by Final Cut Pro is to
transfer it to video, usually using a telecine. Telecines are devices that scan each film
frame onto a charge-coupled device (CCD) to convert the film frames to video frames.
Although the video that the telecine outputs is typically not used for anything besides
determining edit points, it’s a good idea to make the transfer quality as high as possible.
If you decide against making workprints, this may be your only chance to determine if
there are undesirable elements (such as microphone booms and shadows) in each take
before committing to them. The video output should have the film’s key number, the
video timecode, and the production audio timecode burned in to each frame.

The actual videotape format used for the transfer is not all that important, as long as it
uses reliable timecode and you will later be able to capture the video and audio digitally
on the computer prior to editing. An exception is if you intend to use the video transfer
to also create an edited video version of the project, perhaps for a video trailer. This
requires two tapes to be made at the transfer—one that is high quality and without
window burn, and another that has window burn.

It is strongly recommended that the audio be synced to the video and recorded onto the
tape along with the video during the telecine process. There are also methods you can
use to sync the audio after the telecine process is complete—the important thing is to
be able to simultaneously capture both the video and its synchronized audio with
Final Cut Pro.
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Stage 4: Creating a Cinema Tools Database
The key to using Cinema Tools is its database. The database is similar to the traditional
code book used by filmmakers. It contains information about all elements involved in a
project, including film key numbers, video and audio timecode, and the actual clip files
used by Final Cut Pro. Depending on your situation, the database may contain a record
for each take used in the edit or may contain single records for each film roll. The
film-to-video transfer process provides a log file that Cinema Tools can import as the basis
of its database. It is this database that Cinema Tools uses to match your Final Cut Pro edits
back to the film’s key numbers while generating the cut list.

There is no requirement that the database be created before the video and audio are
captured, or even before they are edited. The only real requirement is that it must be
created before a cut list can be exported. The advantage of creating the database before
capturing the video and audio is that you can then use it to create batch capture lists,
allowing Final Cut Pro to capture the clips. The database can also be updated and modified
as you edit.

Stage 5: Capturing the Video and Audio
The video created during the telecine process must be captured as a digital file that can
be edited with Final Cut Pro. The way you do this depends on the tape format used for
the telecine transfer and the capabilities of your computer. You need to use a third-party
capture card to capture files from a Betacam SP or Digital Betacam tape machine. If you
are using a DVCAM source, you can import directly via FireWire. To take advantage of the
batch capture capability of Final Cut Pro, you should use a frame-accurate,
device-controllable source.

As opposed to the captured video, which is never actually used in the final movie, the
edited audio can be used. You may decide to capture the audio at a high quality and
export the edited audio as an Open Media Framework (OMF) file that can be imported
at a Digital Audio Workstation (DAW) for finishing. Another approach is to capture the
audio at a low quality and, when finished editing, export an audio EDL that can be used
by an audio post-production facility, where the production audio can be captured and
processed at a very high quality.

Stage 6: Processing the Video and Audio Clips
Depending on how you are using Cinema Tools, the captured clips can be linked to the
Cinema Tools database. They can also be processed, using the Cinema Tools Reverse
Telecine and Conform features, to ensure compatibility with the Final Cut Pro editing
timebase. For example, the Cinema Tools Reverse Telecine feature allows you to remove
the extra frames added when transferring film to NTSC video using the 3:2 pull-down
process.
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Stage 7: Editing the Video and Audio
You can now edit the project using Final Cut Pro. For the most part, you edit your film
project the same as any video project. If you captured the audio separately from the
video, you can synchronize the video and audio in Final Cut Pro.

Any effects you use, such as dissolves, wipes, speed changes, or titles, are not used directly
by the film. These must be created on film at a facility specializing in film opticals.

It can be helpful for the negative cutter if you output a videotape of the final project edit.
Although the cut list provides all the information required to match the film to the video
edit, it helps to visually see the cuts.

Stage 8: Exporting the Film Lists
After you’ve finished editing, you export a film list that can contain a variety of film-related
lists, including the cut list, which the negative cutter uses to match the original camera
negative to the edited video. Additional lists can also be generated, such as a duplicate
list, which indicates when any source material is used more than once.

Stage 9: Creating a Test Cut on a Workprint
Before the original camera negative is conformed, it is strongly suggested that you conform
a workprint to the cut list to make sure the cut list is accurate (some negative cutters
insist on having a conformed workprint to work from). There are a number of things that
can cause inaccuracies in a cut list:

• Damaged or misread key numbers entered during the telecine transfer process

• Incorrect timecode values

• Timecode errors introduced during the capture process

• With NTSC video, 3:2 pull-down problems

In addition to verifying the cut list, other issues, such as the pacing of a scene, are often
hard to get a feel for until you see the film projected on a large screen. This also gives
you a chance to ensure that the selected shots do not have unexpected problems.

If your production process involves workprint screenings and modifications, you can also
export a change list that describes what needs to be done to a workprint to make it match
a new version of the sequence edited in Final Cut Pro.

Stage 10: Conforming the Negative
The negative cutter uses the cut list, the edited workprint, and the edited video (if
available) as a guide to make edits to the original camera negative. Because there is only
one negative, it is crucial that no mistakes are made at this point. As opposed to the
cutting and splicing methods used when working with the workprint, the cutting and
splicing methods used for conforming the negative destroy frames on each end of the
edit. This makes extending an edit virtually impossible and is one of the reasons you must
be absolutely sure of your edit points before beginning the conform process.
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Stage 11: Finishing the Audio
You usually rough-cut the audio while editing the video (stage 7); the audio is typically
finished while the film is being conformed. As mentioned in stage 5, you can use an
exported OMF version of the Final Cut Pro edited audio or export an audio EDL and
recapture the production audio (using the original sound rolls) at a DAW. Finishing the
audio is where you perform the final sound mix, including cleaning up dialogue issues
and adding sound effects, backgrounds, and music.

Stage 12: Creating the Answer and Release Prints
After the original camera negative has been conformed and the audio finalized, you can
have an answer print created. This print is used for the final color timing, where the color
balance and exposure for each shot are adjusted to ensure the shots all work well together.
You may need to create several answer prints before you are happy with the results. Once
you are satisfied with the answer print, the final release print is made.
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Cinema Tools can produce a film list only if it can match edits made in the editing system
to records in the Cinema Tools database. The database record contains the film roll and
key number information that Cinema Tools needs in order to describe the edit in the film
list.

This appendix covers the following:

• Film List Creation Overview (p. 241)

• About the Clip-Based Method (p. 242)

• About the Timecode-Based Method (p. 243)

Film List Creation Overview
In creating a film list, there are two basic methods Cinema Tools uses to locate a database
record associated with a particular edit:

• Clip-based method: Cinema Tools obtains the clip’s filename from Final Cut Pro and
then looks for the clip in the database. Cinema Tools first tries to locate the clip based
on the clip pathname indicated in the editing system. If it fails to find the clip by looking
for the pathname, it searches for the clip by its name and modification date. When
Cinema Tools finds the clip in the database, it can also locate the associated record,
because each clip must be linked to one record. See About the Clip-Based Method for
more information.

• Timecode-based method: If Cinema Tools can’t find the database record using the clip’s
filename, it finds the database record by looking for the video reel and timecode
information associated with the edit in the sequence in Final Cut Pro. See About the
Timecode-Based Method for more information.
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Cinema Tools always uses the clip-based location method when it can. If it doesn’t find
a matching clip, it uses the timecode-based location method. If Cinema Tools cannot find
a suitable database record with either method, an entry is logged in the missing elements
list (if you chose to include a missing elements list in the film list). This process is outlined
in the flow chart below.

Yes

No

Yes

No

Cinema Tools gets clip name
from Final Cut Pro

Cinema Tools looks for clip
name in database

Cinema Tools gets clip
timecode and reel identifier

from Final Cut Pro

Cinema Tools uses film roll and
key number in database record

to describe edit in cut list

Database
record found?

Database
record found?

A missing element note
is made in the missing

elements list

Cinema Tools looks for
clip timecode and reel
identifier in database

About the Clip-Based Method
For Cinema Tools to locate a database record using the clip-based location method, it
needs to know only the relationship between the source clip and the key numbers or ink
numbers. In contrast, the timecode-based method requires that Cinema Tools know the
relationship between the key numbers or ink numbers and the video reel and timecode.
Because the clip-based method relies on fewer variables, it is more reliable, which is why
Cinema Tools tries to use this method first.
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About the Timecode-Based Method
There are some situations in which the timecode-based method is useful or even essential:

• If you have not logged clips in the Cinema Tools database by connecting them to database
records: Only the timecode-based method can locate the database records. If the
database contains the data that is needed to match the edge code and the timecode,
and if the source clips were captured by Final Cut Pro using frame-accurate device
control, Final Cut Pro should know the video reel and timecode information for each
clip, and a film list can be produced from this information. (In such a case, you do not
have to connect the source clips to the database records, saving you a fair amount of
labor.)

• If you are generating a film list from an external EDL: The timecode-based method is used
(assuming you have not connected the source clips to the database).

• If the clip files are inaccessible (offline) when the film list is generated: Only the
timecode-based method can locate the database records.
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There are a number of resources you can turn to for help when you have issues with
Cinema Tools.

This appendix covers the following:

• Resources for Solving Problems (p. 245)

• Solutions to Common Problems (p. 245)

• Contacting AppleCare Support (p. 247)

Resources for Solving Problems
If you run into problems while working with Cinema Tools, there are several resources
you can use to find a solution.

• This appendix: This appendix includes information about some of the most frequent
issues users encounter.

• AppleCare Knowledge Base: AppleCare Support maintains a database of common support
issues that is updated and expanded to include new issues as they arise. This is an
excellent, free resource for Cinema Tools users. To access the AppleCare Knowledge
Base, go to the AppleCare Support page at http://www.apple.com/support.

• AppleCare Support: There are a variety of support options available to Final Cut Studio
customers. For more information, see the documentation about support options that
was included with your Final Cut Studio package.

Solutions to Common Problems
Following is a list of common problems you might have while using Cinema Tools, with
one or more solutions provided for each problem.
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You see warnings about duplicate usages of source material
• When the number of frames reused is fewer than the number of frames you entered

in the Cut Handles or Transition Handles settings in the film list export dialog, it’s
possible that a duplicate usage warning is a result of the cut handles or transition
handles. To determine whether this is the case, try setting the Transition Handles option
to zero frames and the Cut Handles option to one-half of a frame, then export the film
list again.

• When your edited program contains duplicate usages of source material and you have
only one original camera negative to cut, you have a couple of options. You can reedit
your scene or scenes in order to avoid using the material more than once. Or, you can
export a duplicate list and give it to a lab so the lab can create duplicate negatives of
each shot that is used more than once. You then transfer the duplicate negatives to
video, capture them into Final Cut Pro, log them in the Cinema Tools database, and
use them to replace the duplicate sections in your edited project.

The key numbers in the cut list do not match the key numbers in the digital clips
• First, make sure that it is something to be concerned about. When editing at the NTSC

video rate of 30 fps (actually 29.97 fps), key numbers might be off by +/– one frame.
This is normal and to be expected if you edited at the NTSC video rate. (See Frame Rate
Basics for more information.) Also, the key number may be off by more than one frame
at the end of the cut if it was necessary to add or subtract a frame in order to maintain
sync with the audio. However, under no circumstances should the key number be off
by more than one frame at the beginning of the cut. And, if you are editing PAL video
at 24 fps, the key number you see burned in to the frame should never be different
from the key number you see in the cut list at the In and Out points.

• If the difference is more than one frame, the most likely cause is that the clip is not
properly identified in the Cinema Tools database. To check that the clip is correctly
identified, go to the corresponding database record, then click Open Clip to open the
Clip window. Use the Identify feature to check the key numbers for more than one
location in the clip to see if the frames are properly identified. If the key number was
entered incorrectly, correct it in the Identify pane of the Clip window. See Verifying
and Correcting Edge Code and Timecode Numbers for more information. Then, generate
the cut list again and verify that the correct key numbers are now displayed.

• Make sure that the timecode is accurate in Final Cut Pro. If you used device control to
capture your clips but find that Cinema Tools is reporting the wrong timecode, there
is a good chance that the timecode is incorrect in Final Cut Pro. If the timecode is wrong
in Final Cut Pro, you must recapture the source clips. If you used serial device control,
the timecode mismatch may have happened because you did not set the appropriate
timecode offset in Final Cut Pro for the specific deck you used. You need to make this
setting once per deck, per computer. If the serial device control timecode offset was
not set, set it, then recapture the source clips. For more information, see the section
about calibrating the timecode signal in the Final Cut Pro documentation.
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• Make sure that all the clips in your sequence have the same frame rate as the editing
timebase for the sequence in Final Cut Pro. See the Final Cut Pro documentation for
details about setting the editing timebase in the Sequence Preset Editor.

• There may be dropped frames or discontinuities in the key numbers of the video. Try
recapturing the clips.

When you try to use the Reverse Telecine feature, you see an error about dropped
frames
• Occasionally there are clips that contain frames that are longer than they should be.

This situation can cause the Cinema Tools reverse telecine process to report one or
more dropped frames, when in fact there aren’t any. Try conforming the clip to 29.97 fps
with the Conform feature, then start the reverse telecine process again.

• If frames were actually dropped during the capture process, it’s best to recapture the
source clips without dropped frames because dropped frames can interfere with the
reverse telecine process. See Avoiding Dropped Frames for more information.

You see unexpected .tmp files
• Cinema Tools may create several temporary files in the process of creating the cut list.

These files are normally deleted when the process is complete, so you don’t see them.
If a system failure occurs before the film list is generated, these files might not be
deleted. If you find any Cinema Tools–generated files with a filename extension of .tmp,
.tmp.dat, or .tmp.idx, you can delete them.

In the cut list, you see an error about a temporary file
• If a problem occurs while Cinema Tools is creating a temporary file, you might see error

messages about these files in the cut list. The most likely reason for this problem is that
there is not enough disk space available on the storage volume. Make sure the storage
volume has disk space available.

Contacting AppleCare Support
Included in your Final Cut Studio package is documentation about the support options
available from Apple. Several levels of support are available, depending on your needs.

Whatever your issue, it’s a good idea to have the following information immediately
available when you contact Apple for support. The more of this information you have
ready to give to the support agents, the faster they will be able to address your issue.

• The Support ID number found on the back of the Installing Your Software booklet that
came with Final Cut Studio.

Note: The 11-digit Support ID number is different from the product serial number used
to install Final Cut Studio.

• The version of Mac OS X you have installed. To find the version of Mac OS X, choose
Apple menu > About This Mac.
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• The version of Cinema Tools you have installed, including updates if applicable. To find
the version of Cinema Tools, choose Cinema Tools > About Cinema Tools.

• The model of computer you are using.

• The amount of RAM installed in your computer, and how much is available to
Cinema Tools. To find out how much RAM is installed, choose Apple menu > About
This Mac.

• What other third-party hardware is connected to or installed in the computer, and who
the manufacturers are. Include hard disks, graphics cards, and so on.

• Any third-party plug-ins or other software installed along with Cinema Tools.

In certain support situations, AppleCare may require information about both your
computer and how this particular application is configured. Choosing Help > Create
Support Profile creates a file that contains the necessary information and can be emailed
to AppleCare. You would not normally use this feature unless directed to by an AppleCare
representative.

To access AppleCare Support for Cinema Tools, go to
http://www.apple.com/support/cinematools.
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2:3:2:3 pull-down A pull-down method that is the same as the 3:2 pull-down method,
except that it is applied by a digital video camcorder (as opposed to any other type of
equipment that could apply the same pattern of pull-down). This manual uses the term
2:3:2:3 when referring to the pull-down that comes from a 24p digital video camcorder;
this type of pull-down can be removed using the automated form of reverse telecine.
See also 3:2 pull-down .

2:3:3:2 pull-down A method of distributing film’s 24 fps among NTSC video’s 29.97 fps
when film or 24p video is transferred to NTSC video. In the transfer, the recording alternates
two fields of one frame and then three fields of the next two frames, followed by two
fields of the next frame. In this way, the 24 frames in 1 second of film or 24p video fill up
the 30 frames in 1 second of NTSC video. Although 3:2 is the conventionally supported
pull-down pattern for NTSC devices, some digital cameras and editing systems are
beginning to support 2:3:3:2 pull-down.

3:2 pull-down A method of distributing film’s 24 fps among NTSC video’s 29.97 fps when
film or 24p video is transferred to NTSC video. In the transfer, the recording alternates
two fields of one frame and then three fields of the next, so that the 24 frames in 1 second
of film or 24p video fill up the 30 frames in 1 second of NTSC video. Also known as 2:3
pull-down.

3-perf 35mm A 35mm film format supported by Cinema Tools. Refers to having three
perforations (sprocket holes) for each film frame. It is gaining popularity, especially with
episodic television, because it contains 25 percent more frames per foot of film than the
more common 4-perf 35mm format.

4-perf 35mm A common 35mm film format that is supported by Cinema Tools. Refers
to having four perforations (sprocket holes) for each film frame.

24 & 1 A method of transferring film to PAL video, where two extra fields per second are
added to the video so the 24 frames in 1 second of film are all contained within the
25 frames in 1 second of PAL video. This method maintains the original action speed.
See also 24 @ 25, 24 @ 25 pull-down.
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24 @ 25 The most common method of transferring film to PAL video, where the film is
sped up during the telecine transfer to 25 fps. This creates a one-to-one film-to-video
frame relationship, but speeds up the action by 4 percent. See also 24 & 1, 24 @ 25
pull-down.

24 @ 25 pull-down The Final Cut Pro term for the 24 & 1 method. See also 24 & 1, 24 @
25.

24p A high definition video format using a 24 fps rate and progressively scanned video.
It is finding wide use in film production because of its high quality and identical frame
rate. It also converts easily to most 29.97 fps and 25 fps standard and high definition video
formats.

Acmade number See ink number .

“A” frame The first frame in the repeating five-frame 3:2 pull-down sequence. In two-field
3:2 pull-down video, it is the only frame that fully contains both fields from a single film
frame. B, C, and D frames have their fields split among two video frames. A frames normally
occur on timecode numbers ending with “0” or “5” (when using non-drop frame timecode).
See also 3:2 pull-down , field .

ALE file Abbreviation for Avid Log Exchange. A file format that allows film databases to
be shared between different systems. See also telecine log .

answer print The first film print that includes sound and picture, submitted by the
laboratory for the customer’s approval.

aspect ratio The ratio of an image’s width to its height expressed either as two numbers
(width:height) or as a value equal to the height divided by the width. Standard definition
video uses 4:3 (0.75), and most high definition video uses 16:9 (0.56). Film aspect ratios
depend on the format and lenses used.

change list A list you can export from Final Cut Pro using Cinema Tools, which assumes
a workprint or negative has been cut to the specifications of a cut list (or prior change
list) and specifies further changes to make based on new edits you have made to a
Final Cut Pro sequence.

conform (film) To cut and arrange an original camera negative to match edits made in
a digital editing system. Also, to assemble video or audio according to an Edit Decision
List (EDL). See also cut list , Edit Decision List (EDL) .

conform (video) To change the frame rate of a video clip. For example, you can use the
Cinema Tools Conform feature to change the frame rate of a PAL 25 fps video clip to film’s
24 fps rate. You can also conform a clip to its current frame rate, ensuring there are no
frame rate errors within it.

250 Glossary



contact printing A film printing method in which the emulsion sides of the original
camera negative and the print stock are in contact as the negative is projected onto the
print stock. Creates an image that is reversed in color and light (for example, black becomes
white and white becomes black).

cut list A text file that sequentially lists the edits that make up your program. The negative
cutter uses the cut list to conform the original camera negative. The cut list is a type of
film list you can export from Final Cut Pro using Cinema Tools. Also known as an assemble
list.

device control Technology that allows Final Cut Pro to control an external hardware
device, such as a video deck or camera.

DF See drop frame timecode .

digital intermediate (DI) A film workflow that does not rely on conforming the original
camera negative for the final output. Generally, the film is scanned and processed at a
high enough quality that the final output can be directly sent to a film printer or distributed
as digital video. This term is also used even if the source for the video is a high-quality
digital camera such as the RED ONE and no film is involved at all.

downconverted video Video created by converting high definition video (such as 24p)
to standard definition video (NTSC or PAL).

DPX image sequence Digital Picture Exchange (DPX) image sequences are often referred
to by their resolution. For example, DPX image sequences with 2048 horizontal pixels are
referred to as 2K resolution, and DPX image sequences with 4096 horizontal pixels are
referred to as 4K resolution. The video is actually a set of still images, one per frame, within
a folder. The images are played back in sequence at their specified frame rate. DPX image
sequences are often used as part of a DI workflow. Cinema Tools uses the folder name
as the reel name and extracts the timecode from each image. See also digital intermediate
(DI).

drop frame timecode NTSC timecode that skips ahead in time by two frame numbers
each minute, except for minutes ending in “0,” so that the end timecode total agrees
with the actual elapsed clock time. (Timecode numbers are skipped, but actual video
frames are not skipped.) This skipping corrects for NTSC’s actual frame rate of 29.97 fps,
which results in an inaccuracy of 3 seconds and 18 frames per hour in comparison to
actual elapsed time when non-drop frame timecode is used. To avoid confusion, drop
frame timecode should be avoided in film-based productions. See also non-drop frame
timecode .

dropped frames Frames that are not captured. If computer performance is impeded or
if the scratch disk is not fast enough, frames may be dropped during the capture process.
When a frame is dropped during capture, the frame before it is repeated. Dropped frames
can result in an incorrect cut list and interfere with the reverse telecine process.
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dual system sound Sound for any production using separate devices to record the image
and the sound. Dual system recording is always used in film productions and often used
in 24p productions. Also known as double system production.

duplicate list A film list Cinema Tools users can export, indicating duplicate uses of the
same film source material in an edited program. Also known as a dupe list.

edge code Refers to feet and frame count numbers found on the film edge. May be
latent key numbers on the original camera negative, or ink numbers added to the edge
of workprints. See also ink number , key number .

Edit Decision List (EDL) A text file that sequentially lists all of the edits and individual
clips used in a sequence. EDLs are used to move a project from one editing application
to another, or to coordinate the assembly of a program in a tape-based online editing
facility.

Extensible Stylesheet Language Transformations (XSLT) The language used by the
Cinema Tools style sheets. XSLT-based style sheets are commonly used to extract
information from XML files. When you export a style sheet–based film list, Cinema Tools
first exports an XML-format film list and then processes that XML output with the selected
style sheet, resulting in exactly the output items and layout the style sheet specifies. See
also style sheet.

field Half of an interlaced video frame consisting of the odd or the even scan lines.
Alternating video fields are drawn every 1/60 of a second in NTSC video (1/50 of a second
in PAL) to create the perceived 29.97 fps video (25 fps PAL). There are two fields for every
frame, an upper field and a lower field. It is possible to capture only one field of each
frame. See also interlaced video .

field dominance Refers to the field that occurs first in an interlaced video frame. If only
one field is captured, field 1 dominance means that only field 1 is captured and field 2
dominance means that only field 2 is captured. See also field .

film list A text file you give to the negative cutter to use as a guide in conforming the
original camera negative. The film list may contain one or more of the following: a cut
list, a missing elements list, a duplicate list, an optical list, a pull list, and a scene list. A
film list may also contain additional information for pulling the negative rolls, making
duplicate negatives, making a workprint, or printing effects.

FLEx file A common telecine log file format. See also telecine log .

footage number Part of a key number; refers to the four-digit number indicating the
position on a film roll. See also frame number , key number .

found set The set of database entries shown in the Cinema Tools List View window. This
set is called the found set because you use the Find command to display it.
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fps Abbreviation for frames per second.

frame A single still image. Film and video are made up of a series of these images.
Although a film frame is a photographic image, a video frame contains one or more fields.

frame number The last part of the key number. The frame number consists of the footage
number and the frame counter and indicates how many feet and frames into the film a
particular frame occurs. See also key number .

HD video See high definition video .

high definition video Refers to any of a wide range of video formats, including the 24p
format, providing a higher-quality image than standard definition video. Enhancements
can include increased resolution, a wider aspect ratio, and progressive scanning. See also
progressive video , standard definition video .

identifier In Cinema Tools, a combination of one or more letters, numbers, or both, that
identify a shot, scene, take, video reel, sound roll, lab roll, or camera roll.

ink number A feet and frame count number added to the edge of workprints and
magnetic film soundtracks. Also known as an Acmade number.

interlaced See interlaced video .

interlaced video A video frame format that divides the lines in a frame of video into two
fields, each consisting of alternating odd and even lines, which are scanned at different
times. Used in standard definition video. See also field , field dominance , progressive
video .

interpositive (IP) A low-contrast positive film print made from an original camera
negative. It is not projectable as a full-color image, because it has an orange mask on it
like a negative. IPs are typically used as an intermediate step in creating opticals and
duplicate negatives.

key number Latent feet and frame count numbers found on the film edge. Key numbers
are often superimposed by the telecine onto the edge of the video frames (this is called
window burn). Cinema Tools uses key numbers to help match digital edits back to the
original camera negative. Key numbers consist of a key prefix, which is unchanging
throughout an entire roll of film, and a frame number, which consists of a footage number
and a frame count number. Telecine systems also often add a frame type identifier to the
key number. For example, in the key number KJ 291010 5867+07, the key prefix is “KJ
291010” and the frame number is “5867+07.” Also known as edge code.

latent key number A number added to the film edge during its manufacturing process.
Also known as latent edge code. See also key number .
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match back To match the edits of a video program that originated on film back to the
original camera negative. All the edits to the video are listed in a cut list, which the
negative cutter uses to cut the workprint and original camera negative.

NDF See non-drop frame timecode .

negative cutter A professional who conforms the original camera negative according
to a cut list or a visual reference such as a workprint or a videotape generated by the
digital editing system.

non-drop frame timecode Normal NTSC timecode, where frames are numbered
sequentially and there are 30 frames per second, 60 seconds per minute, and 60 minutes
per hour. Because NTSC’s frame rate is actually 29.97 fps, non-drop frame timecode is off
by 3 seconds and 18 frames per hour in comparison to actual elapsed time. See also drop
frame timecode .

NTSC Abbreviation for National Television Standards Committee, the organization that
defines North American broadcast standards. The term NTSC video refers to the video
standard defined by the committee, which is 29.97 fps, 525 lines per frame, and interlaced.

offline edit The creative edit, where edit decisions are made. When the offline edit is
finished, the material is often recaptured at high quality or an EDL is generated for
re-creating the edit on another system. See also Edit Decision List (EDL) .

OMF Abbreviation for Open Media Format. A media interchange format, supported by
many Digital Audio Workstations (DAWs), that allows all of the audio and edit points in
an audio sequence to be exported as a self-contained file. OMF files are often given to
an audio post-production facility, finished there, and then used as the final audio in a
feature.

online edit The final editing process, where all the decisions made in the offline edit are
applied to the original camera negative or full-resolution video reels.

optical list A film list Cinema Tools users can export for the optical house to use in
printing effects for film. The optical list describes transition and motion effects that you
created in your digital edit.

optical printer Rephotographs one or more film elements onto a new section of film.
An optical printer can add or delete light from an image, create superimposed effects, or
make scene transitions such as wipes, fades, and dissolves.

opticals Effects produced by an optical printer, including transitions and superimposed
titles. See also optical printer .

254 Glossary



original camera negative Also known as OCN. The negatives from the film shoot; the
original source film. The original camera negative is what the negative cutter cuts after
all the edits have been finalized in the digital editing system. There is only one original
camera negative. (Duplicate negatives can be made, but they are expensive.)

PAL Acronym for Phase Alternating Line. A video format used by many European countries
and other countries outside North America. The PAL video standard is 25 fps, 625 lines
per frame, and interlaced.

progressive video A video frame format that progressively scans all lines in a frame.
See also interlaced video .

pull list A film list Cinema Tools users can export, which list shots in the cut list in the
order in which they can be found on the negative rolls. The lab refers to a pull list when
going through your negative rolls to pull shots for a workprint or original camera negative
cut.

release print A positive print of a finished movie; the final product for distribution.

reverse telecine The process that removes the extra frames from 3:2 pull-down video,
returning it to its original 24 fps frame rate. Reverse telecine creates a one-to-one
relationship between the video and film frames so that the cut lists are accurate. Reversing
the 3:2 pull-down can be accomplished with hardware in real time during capture, but
if you do not have the proper equipment, you can use the Cinema Tools Reverse Telecine
feature. See also 3:2 pull-down .

scene In filming, a time and place setting for one or more shots, typically tied together
by a common story line or certain characters.

scene list A film list Cinema Tools users can export, which lists all the shots that are in
the cut list with each shot listed only once. Scene lists are typically used to order prints
of the shots in a program so that a workprint can be conformed prior to cutting the
original camera negative.

SD video See standard definition video .

shot A continuous film recording that does not have any cuts. A shot is a subset of a
scene.

slug Blank (fill leader) or substitute footage used to fill in spaces where footage is
temporarily missing, in order to maintain sync between the picture and the soundtrack.

SMPTE Abbreviation for Society of Motion Picture and Television Engineers. The
standard-setting organization that established the SMPTE timecode standard for video.
SMPTE timecode is the most commonly used timecode format.
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source clips The media files you start with when you begin editing. These are the files
that are captured into your computer and linked to the Cinema Tools database before
editing begins.

standard definition video Refers to the NTSC and PAL video standards. See also high
definition video , NTSC , PAL .

style sheet Style sheets are Extensible Stylesheet Language Transformations (XSLT) files
that Cinema Tools uses to provide customized output lists. This includes controlling the
specific types of information to include and defining the output layout and format (plain
text, HTML, and so on). Several are provided by Cinema Tools, and you can create custom
style sheets as needed. See also Extensible Stylesheet Language Transformations (XSLT).

supers Short for superimposed. Overlays of images or text onto frames. For example,
titles are superimposed onto frames.

sync Short for synchronization. When sound is in unison (synchronized) with the picture,
they are said to be in sync.

synchronizer block A small mechanical bench device with sprocketed wheels mounted
on a revolving shaft. Located between film reels mounted on shafted rewinds, it accepts
one strip of film and perforated magnetic soundtrack per sprocketed wheel. Once the
film and track are locked onto the wheels, they can be placed in exact mechanical sync
and will maintain this sync while they are advanced forward through the synchronizer
block. The synchronizer block also keeps track of elapsed footage via a mechanical feet
and frame counter geared to the sprocket wheels. Also known as a sync block, gang sync,
or synchronizer.

take A take is another version of a particular shot. In shooting a film, there may be multiple
takes of each shot.

telecine A machine that copies the images on the original camera negative to a videotape
format, often including a window burn of the film edge code. See also window burn .

telecine film speed The frame rate at which the film is run in telecine equipment during
the transfer to video.

telecine log A file generated by the telecine technician during the telecine transfer.
Records the key numbers of the original camera negative and the timecode of the video
transfer, tracking the relationship between them. Sometimes called a FLEx file.

timecode A format for assigning each frame of video a unique, sequential unit of time.
The format is hours: minutes: seconds: frames.

TK speed See telecine film speed.
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window burn Visual timecode and keycode information superimposed onto video
frames. It usually appears on a strip at the bottom or top of the frame, providing code
information to the editor without obscuring any of the picture.

workprint A positive copy of the original camera negative, cut to provide a record and
prototype of the creative edit. In traditional filmmaking, the workprint is edited first and
then used by the negative cutter as a guide for cutting the original camera negative. In
digital filmmaking, a workprint is usually used to verify the cut list and to create a prototype
of the film to view on a big screen before conforming the negative. Sometimes called a
work pix or cut pix.

XML Abbreviation for Extensible Markup Language. A general-purpose markup language
that combines human-readable text with additional, specialized information. Because of
the large variety of tools available, XML files are widely used to exchange information
between applications.

XSLT See Extensible Stylesheet Language Transformations (XSLT).
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